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Copyright
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Getting Started
The
Silverstack
Lab
Main
Screen

General
Introduction

Silverstack Lab extends the data management capabilities of Silverstack, with all the necessary functionality for dailies creation, and comes with:

A high performance transcoding engine
An automated audio sync function
A powerful dailies grading engine
The power to create Avid DNx, ProRes, and H.264/HEVC clips in various resolutions at the same time
A clip library extension that simplifies the management of transcodes
Direct integrations with common dailies systems
10bit HD-SDI output
The complete data management feature set of Silverstack XT.

Silverstack Lab is an application running on macOS.

Main
Screen

Main screen (click to enlarge)

1.
Offload
/
Add
Clips: Copy clips or simply add them to the library
2.
Library: The library outline with folders, bins, clips and documents
3.
Jobs
View: Open the jobs view to monitor jobs (like transcoding or copy jobs)
4.
Clips
List
/
Player: Switch between player and clips list view
5.
Transcode: Start a transcoding job
6.
Grade
Controls: Work on the look
7.
Transcoding
Presets: Create transcoding presets with detailed settings

Audio
Sync
Silverstack Lab allows to sync externally recorded audio with corresponding video clips by timecode.

To enable this, Silverstack Lab supports the detection of Broadcast Wave (bwf, .wav) files as audio clips and automates the assignment to video clips
by timecode.

You can also sync audio manually.

Dailies
Grading
Silverstack Lab provides an advanced node based color grading engine.
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Color
Processing:
Set
the
Look
Source

Each clip has a “Look Source” that defines the color processing (see General Info tab, right bar).

Available look source options are:

None: No color processing applied, clip shows no look.
File: Clips from certain cameras contain look metadata (e.g. ARRI Alexa clips) that can be applied directly from file metadata.
Preset: Select a LUT transform from the available LUT presets integrated in Silverstack Lab.
User
defined
LUT: Load a custom LUT to be applied to the clip.
—————————–
Custom
Look: Create a custom look with node based grade controls.

Basic Color Control in Silverstack

Create
a
Custom
Look:
Grading
Modes

Multiple grading modes are available when a the look source is set to custom look. Each grading mode is targeted at a different color pipeline.

There are basically three
different
groups
of
grading
modes:

ASC-CDL
+
3D
LUT
modes (typical color pipelines for a broad range of cameras and projects)
ACES
modes (for use in projects that choose the ACES pipeline),
Freestyle
modes (without any limitations in color pipeline, but reduced compatibility).

 

Grading
Nodes

The grade controls for the currently selected grading mode are grouped in “nodes”. A node can for example contain controls for a ASC-CDL transform,
or for loading a 3D LUT preset.

Nodes are applied to the clip from top to bottom, the top node is applied first, and the following nodes subsequently.

If the grade node is reset or freshly added, it doesn’t affect the image as it is set to neutral by default. Change the controls of a node to give the node
effect to the image. Each control or group of controls in grade nodes has a button with a little arrow that resets the controls.

You can enable and disable single nodes by using the checkbox on the left of each node. Disabled nodes are greyed out.

Nodes can have names. Click on the small pen symbol that appears when you move the mouse over the column on the left of each node. You can use
names to better identify nodes with different roles (e.g., “pre LUT” and “post LUT”). Node names are also used when applying node presets from the
look library for identifying nodes to be updated.

Silverstack Lab supports the use of hardware grading panels to work on looks.

Grading Controls in Silverstack
Using the ACES CDL Grading Mode

 

Work
with
Looks

The current settings for grading modes and nodes form the technical configuration for what is referred to as a look of a clip.

There are different possibilities of working with looks in Silverstack Lab:

 

Matching
Looks
from
LiveGrade

Pomfort LiveGrade allows to export looks that have been created during the shooting of a scene for the use in Silverstack Lab.

Those looks can be matched (added/linked) to their according clips in Silverstack Lab automatically, for example by timecode.

Like this the looks created live can be brought together with the actual camera clips when creating dailies.

Look Matching

 

Look
Library

The look library tab in the right bar allows to manage looks. Looks can be saved, updated, applied, exported and organized in a folder structure.

You can easily copy and paste looks to multiple clips with shortcuts and using the clips list view.

The Silverstack Look Library

 

Video
Scopes

The video scopes panel offers histogram, waveform, and vectorscope inspection tools with individual settings. The video scopes show the analysis of
the current image of a slot with the current grade nodes applied.

The histogram and vectorscope also include a curve overlay that display the result curve of the combined transforms of all active grade nodes of a clip.

You can show and hide the video scopes from the main menu and from the toolbar. You can open the video scopes in a separate window by clicking
on the “Toggle Windowed / Docked View” button in the bar above the video scopes.
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Compare
and
Inspect
Clips

Grid
View
/
Wipe
View

Silverstack Lab provides a grid view and a wipe view for displaying multiple clips at once on the playback view.

The grid view can show up to 12 clips in an optimized way next to each other to for example compare the look of an image across all clips of a scene.

The wipe view helps you to compare two clips side-by-side and wipe a splitter between them. You can select the orientation of the clips for a
horizontal or vertical

Both, grid and wipe view, are also available via HD-SDI output to be displayed on a broadcast monitor.

Player Grid View for Multi Clip Selection

Inspect
Clips

The visual controls help to inspect clips, offering focus and clipping assist, exposure tool, false color, and frame line options.

Visual Control Functionality in the Playback Mode

Transcoding

Silverstack Lab allows to convert
video
clips
to
proxy
clips
in
common
formats (DNx, ProRes, H.265/HEVC) and containers (Quicktime .mov, MXF
.mxf, MP4 .mp4).

Create
multiple
independent
transcoding
presets (“Transcoding Presets” tab right bar). Settings include e.g. options for looks, overlays
(watermarking), metadata burn ins, clip resizing and direct metadata export. You get a live preview of the settings of your preset in the transcoding
preview.

Start a transcoding job and add
one
or
more
multiple
transcoding
destinations
in
the
transcoding
wizard (with toolbar “Transcode” button). You
can transcode
to
individual (one file per clip) or
combined
clips (single file with multiple clips).

Transcoding
jobs
run
in
the
background (monitoring possible in jobs view) and by default are intelligently paused during playback and offload.

Silverstack Lab supports external
GPUs
(eGPUs) for transcoding and allows to select the preferred GPU in the preferences.

Crop Clips
Transcoding in Silverstack Lab

Transcoded
Clips
in
the
Library

By default, all clips transcoded with Silverstack Lab are added to the library outline again in the “Transcoded Clips” Folder.

This allows you to use the general data management functionality of Silverstack for transcoded clips, like for example:

Secure backup of proxy clips to multiple, additional destinations
Playback of proxy clips
Create reports for proxy clips, or reports that include proxy clip information
Edit metadata and export to specific metadata file formats

The source clip and its transcoded clip are associated in the library. This association can be reviewed including jumping to the source/transcoded clip
and copying metadata in the File tab of the right bar.

 

Export
to
Dailies
Systems
Silverstack Lab can prepare metadata in file formats that are optimized in compatibility with common dailies systems.

You can create metadata files automatically by setting up the automatic metadata export in transcoding presets, or manually export it for transcoded
clips from the library.
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Clip Library
User
Interface
Overview

figure 1: User Interface overview

1 Video Preview

2 Playback control

3 Action wizards in Toolbar are Offload, Add Clips, Media, Seal, Export, Import, Report, Transcode:

Offload: Choose a source to offload it in your library.
Add
Clips: Add clips to the library without starting a copy job.
Media:

Sync
Audio: Sync video clips with audio files from an external audio recorder.
Extract
LTC: Extract longitudinal timecode from clips in the library.
Relink: Relink clips in the library to new media resources.
Backup: Backup clips in the library to new locations.
Backup
to
LTFS: Backup clips from the library to an LTO via LTFS.
Verify: Verify clips in the library.
Seal: Seal drives for subsequent workflow steps.

Export: Export metadata files to use in editorial and post production.
Import: Import metadata and match it to the clips from different sources.
Report: Create various report types in the Report wizard.
Transcode: Transcode clips to different available formats (create dailies).

4 Switch between View modes like Summary, Table, Collection, Playback.

Summary: shows  statistics and details for the selected object in your library.
Table
view: useful for sorting and grouping clips by certain criteria. It is also a great way to get an overview of the various metadata of a set of
clips. Some of the fields are editable and you can jump from field to field by pressing the TAB key. Here you can also load and save custom view
presets which are the foundation of your clip reports.
Collection
view: it gives you a visual overview over the clips in your library.

Playback: shows the currently selected clip in the video preview and all clips from the active library object in a timeline.

5 Navigation through your Projects, Jobs, Volumes. Folders and Bins with bread crumbs. This feature is specially useful when you hide your library
view and clip information view.

6 Project Library selection switcher. It displays the name of the current project.

7 Cloud status. The production information stored in ShotHub cloud projects can be accessed through a web application.

8 Timecode of playhead and current playback speed in fps.

9 External video status and video out settings.

10 Different video preview modes: Single, Grid or Split View.

11 Visual Controls for in depth Image Analysis and Full Screen Player.
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12 Work spaces such as Files, Manage, QC, Color and Transcode Config to speed up specific tasks.

13 Miniplayer shows the video preview in a floating window.

14 Video Scopes such as Waveform, Vectorscope, Histogram.

15 Toggle View Controls to hide or show the Library panel, the Grading Controls, Audio Controls panel and the Clip Info panel to have more work
space for example on small laptop screens.

16 Toggle between Clip information, User Information, File Resources, Clip Header, RAW development settings (Silverstack
Lab
only), Look Library and
Transcoding configurations.

17 Clip information for supported advanced camera formats.

18 Search box to filter file metadata.

19 Successful/Failed jobs count.

20 Progress bar for running copy and transcoding jobs. Shows number of jobs in queue, progress and time left.

21 Grading Controls.

22 Switch between the audio and the grading panel in the lower “Audio&Color” section.

23 Jobs panel: Job or Copy Status, like successful or failed copy jobs, duration and file destination. More information in the article Managing Jobs.

24 Different sorting options for the library.

25 Library Panel

26 Info Display: it provides the most important information of the selected clip and cannot be edited. It contains two different view parameters: one for
the Digital Image Technician and another one with relevant information for the Data Wrangler.

 

Collection
View
–
Icon
explanations

figure 3: Collection view: Clip icon

1 Clip Thumbnail (user selectable).
2
Clip name and duration. If the clip has been labeled, this part is colored.
3 Description of the ingest date and time.
4 Icon indicates that clip has audio. Either external, internal or both.
5 Indicates that this clip is marked with a flag and can be searched and filtered for this criterion.
6 Indicates the number of connected storage devices concerning this clip’s storage locations. The number colored in red shows the number of storage
locations that miss the source file.

 

 

The
Clip
Library:
Bins,
Folders,
Smart
Folders
and
Volumes
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figure 1: The library panel part 1

 

figure 2: The Library panel part 2

The basic building blocks of the Silverstack library are projects, bins and folders. Every project you create in Silverstack contains by default different
kinds of “Smart
Folders” and a “Volumes” sub-item. Based on that you can add an unlimited number of folders, bins and smart folders by right-
clicking on any item of the project tree.

 

Project

A “Project” groups all information and data of a single project. In Silverstack all clips, jobs, volumes and destinations are assigned to one project. It
may additionally contain information like the producer, name of the DIT or a production logo, which you can edit in the Statistics overview of the
selected project.

The number behind every element of your project tree indicates the number of versions it contains, whereby duplicates are not counted. The number
behind your “Project” item indicates the number of versions contained by it, with only counting one version of each referred clip.
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Bin

A bin contains clip versions, but no other bins or folders. It is the smallest container unit in Silverstack. Bins are the only element to contain versions
directly, folders and projects only group a set of bins.

There are two different types of Bins:

Video Bins:   

Audio Bins:   

Sorting
of
Bins
&
Folders

You can organize the library by dragging and dropping bins and folders in a custom order or selecting a certain criteria to sort them by:

The bin sorting options in detail:
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Custom
Order: Reflects and stores the custom order the user created with drag & drop.
Name
(A-Z): Sorts bins and folders by Name from top to bottom from 0 to Z.
Name
(Z-A): Sorts bins and folders by Name from top to bottom from Z to 0.
Date
(oldest
–
newest): Sorts bins and folders by creation date, oldest date first, newest date last.
Date
(newest
–
oldest): Sorts bins and folders by creation date, newest date first, oldest date last.

Folders stay on top. Audio bins are automatically sorted separately at the bottom of video bins.

Folder

Folders are used to create logical project structures like shooting days. A folder can contain bins and other folders but not clips directly since clips
always have to be enclosed by a bin.

Folder structure can easily be duplicated by choosing “Duplicate
Folder
Structure” from the context menu:

Fig. 3: Duplicating the folder structure of a folder

 

Smart
Folder

Additionally there is an element called “Smart
Folders”
in the Silverstack library, which describes a folder with integrated filtering function. Using smart
folders you can find clips with a certain attribute in the dedicated project very easily. The default smart folders filter the library for clips without
backups, with a high rating, a flagging or clips that are registered today. For a closer look to the smart folder section go to the Working with smart
folders article.

 

Volumes

By selecting “Volumes”, Silverstack outlines all used storage devices and their according information. You can also reveal the files in the finder by
clicking the reveal button. Additional information about your volumes can be found in the right sided panel. There you have the possibility to:

see status of your free disk space
make comments
give your hard-drive a playback priority
get “Last Seen” information: which user was the last one to have a drive connected and when (only when the clip library is synced with ShotHub)

figure 4: The Silverstack “Volumes” window

The
Information
Panel
(Right
Sidebar)
The Information Panel displays all the information (metadata) embedded in your clips. It consists mostly of editable and some read-only fields (not
editable). You can edit the fields marked with a small «pencil» icon, as well as flags, ratings, labels and cue points.

By editing and adding your own information to the clips you can simplify managing tasks like searching clips, varying the shown clip order or filter the
library for clips with a certain attribute, which you can do by using smart folders.
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Fig. 1: The information panel

The
Tabs

The information panel is subdivided into six tabs: General Info, User, File, Header, Look Library and Transcoding.

 

1
General
Info
tab:
It encloses the clip information extracted from the metadata like the timecode, exposure, production info, camera and format
information. Additionally, there are some tips for a faster metadata editing available in the article Tips & Tricks: Quick metadata editing. You can also
apply Image transformations like anamorphic de-squeezing and image flipping. You can edit the fields marked with a small «pencil» icon.

 

 

2
User
Info

tab:
It is fully editable. There you can set the camera letter, edit scene shot and take metadata, flag, rate and label the selected clip.
Besides, you can add a comment and cue points to it.
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figure 2: User Information panel

3
File
tab:
The “File” tab provides you an overview of all file resources of the selected clip.

 

figure 3: the File tab

4
Header
tab:
The “Header” tab contains read-only detailed technical information metadata —in a raw format— of the selected clip. If needed, this
information can be taken over into custom fields in the library, either automatically during ingest or manually by right clicking on the info field:
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Take over additional metadata from the header info to a custom field.

5
Look
Library
tab:
Silverstack enables you to manage looks within Silverstack in a look library in order to keep a proper overview of all the looks in
your project. The look library allows you to store new looks, edit their metadata, apply looks to one or multiple clips, as well as to import looks from
LiveGrade. For more information, please check the article The Silverstack Look Library.

6
Transcoding
tab:
Silverstack allows to manage transcoding configurations and their transcoding settings in the Transcoding tab. A transcoding
preview of the current image is automatically shown in the player view when the transcoding tab is opened. For more information about the
transcoding tab and transcoding in Silverstack please read the article Transcoding in Silverstack.

 

 

 

 

 

Assets
in
Silverstack
Assets in Silverstack can be video clips (e.g., an Alexa or RED media file), audio clips (WAV), sidecar files accompanying clips (for example, XML or
RMD files), or any other document such as photos or even a PDF. However, not all media files are recognized as clips by Silverstack. In that case, we
are talking about Generic file formats.

Advanced
Camera
Support

Silverstack provides advanced support for a wide range of camera formats, which maximizes the efficiency of relevant on-set tasks such as playback,
metadata management, color grading, quality control, and more.

The supported Advanced Camera Formats are:

ARRIRAW (.ari and .mxf) **:
ARRI Alexa (.ari)
ARRI Alexa LF (.ari)
ARRI Alexa Mini (.mxf)
ARRI Alexa Mini LF (.mxf)
ARRI Alexa 35 (.mxf)
ARRI Amira (.mxf)
ARRI Alexa 65 (.ari)

CODEX HDE (compressed ARRIRAW) (.arx)**
CODEX HDE (compressed Alexa 35 ARRIRAW) (.mxf)**1 [Silverstack XT and Lab only]

1
Ingesting/offloading
Alexa
35
clips
through
the
Codex
VFS
extracts
thumbnails
and

metadata
from
the
original,
uncompressed
clips
rather
than
their
HDE
representation.

Blackmagic RAW (.braw) **
Blackmagic URSA Mini Pro & 4.6K
Blackmagic Pocket Cinema Camera 4k/6k

Canon XF Movies **:
Canon C300 MK I  & II
Canon C500
Canon C700
Canon C200
Canon R5

Canon XF-HEVC **
Canon XF705

Canon MPEG-4 AVC/H.264 (.mts)**
Canon C100
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Canon Cinema RAW Light (.crm):
Canon C200 and C200B
Canon C500 MKII

Canon Uncompressed RAW (.rmf) [Silverstack XT and Lab only]:
Canon C700 and C700 FF
Canon C300 Mk II

CinemaDNG (.dng):
BMCC
DJI Inspire and Zenmuse Series [Silverstack XT and Lab only]
Bolex D16 **
Ikonoskop
IndieCam

Generic Image Sequences:
JPG
TIFF
DPX

H.264 Quicktime Movies:
Canon DSLR **
GoPro Hero **
Nikon DSLR **

KineRAW (.krw):
Kinefinity TERRA 4K / 5K / 6K
Kinefinity KineMINI 4K
Kinefinity KineMAX 6K

Panasonic DNG RAW [Silverstack XT and Lab only]:
Panasonic Varicam LT (with Convergent Design Odyssey7Q+)

Panasonic AVC-Intra **:
Panasonic Varicam

Panasonic V-RAW [Silverstack XT and Lab only]:
Panasonic Varicam

Phantom Cine Vision Research (.cine) [Silverstack XT and Lab only]:
Phantom Flex/Flex4K/Miro/VEO/v2640 Onyx

ProRes Quicktime Movies ** (.mov):
AJA KiPro
ARRI Alexa / Alexa Mini **
ARRI Amira **
ARRI Alexa LF **
RED cameras **
Panasonic Varicam **
Atomos Ninja and Samurai
Codex Action Cam
Convergent Design Odyssey
DJI Inspire and Zenmuse Series

ProRes (.mxf)
ARRI Alexa Mini LF
Sony Venice
Sony Venice 2

REDCODE ** (.red):
Red V-Raptor 8K
Red Weapon Monstro 8K VV ,  Red Weapon Helium 8K S35 , Red Weapon Dragon 6K
Red Raven 4.5K
Red Komodo
Red Scarlet-X , Scarlet Dragon , Scarlet-W 5K
Red Epic-X , Epic Dragon , Epic-W 8K
Red One , Red One MX

SONY RAW** [Silverstack XT and Lab only]:
Sony F5
Sony F55
Sony F65
Sony Venice

X-OCN LT**, X-OCN ST**, X-OCN XT ** [Silverstack XT and Lab only]:
Sony F5 (with AXS-R7 recorder)
Sony F55 (with AXS-R7 recorder)
Sony Venice (with AXS-R7 recorder)
Sony Venice 2

XAVC **:
Sony F5
Sony F55
Sony Venice

XAVC-S **:
Sony a7S
Sony FX-3

Furthermore Silverstack offers extensive support for broadcast wave (BWF) audio wave files (.wav). Learn more in the article Audio Clips in Silverstack.

** with audio support

Working
with
Smart
Folders
In the Silverstack library you find an element called “Smart
Folders”
below the camera rolls section.  Smart folders provide the opportunity to filter all
your clips for certain metadata information. Using smart folders you can find clips with a certain attribute in the dedicated project very easily.
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The default smart folders filter the library for clips without backups, with a high rating, a flagging or clips that are registered today.

 

Create
a
new
Smart
Folder

You can create Smart Folders with an individually set filter in the “Add” wizard menu in the bottom left corner of your Silverstack window. By creating a
new Smart Folder the panel you can see in figure 2 will appear.

Name the folder and set the rules by which the Smart Folder will add video clips. You do this by applying filters which you can add and delete by the
“+” and “-” buttons (figure 1 #1). For each filter you can choose the kind of metadata information (figure 1 #2), a filter mode (figure 1 #3) and enter
specified information (figure 1 #4) for which the video clips will be filtered. Additionally you can decide if any, all or none (figure 1 #5) of this filtering
criteria have to be fulfilled by a clip which then will be added to this Smart Folder .

figure 1: Panel for creating a new smart folder in the Silverstack library

Filter
attributes

For the below mentioned attributes you have to type characters into the text field (figure 1 #4) to get a result. If you leave the text field empty, no video
clips will be filtered out – even if the according attribute field of video clips may be empty.

Clip Name
Version
Comment
Scene
Shot
Take

Camera
Reel Name
File Type
Codec
Look Name
Bin Name

If you want to filter clips for a date, you can select: today, yesterday, one week ago or any specific date.

Registration Date
Shooting Date

For the below listed attributes you have to enter a number in the text field (figure 1 #4) for getting a result. If you leave the text field empty, there will be
no video clips filtered  – even if the according attribute-field of some clips is empty.

Number of Frames
Pixel Width
Pixel Height
Rating
ASA
Number of File Representations
Number of Cue Points
Playable
Missing
Frames per Second
F-Stop
Whitepoint
Sensor Fps
Fps of TC
In/ Out
In Point
Out Point
Flag: You can choose between flagged/ not flagged
Label: You can choose any of the provided labels.
Colorspace: With the colorspace attribute you can filter video clips which are recorded in the Rec.709, LogC (with or without Film Style Matrix),
Dci P3, Cinestyle, SLog
Volume Name: all the clips with a copy/backup in the specified volume or volumes will be shown in the smart folder.

Note:

Besides creating a new smart folder you can edit existing ones by right-clicking on the relevant smart folder and choosing “Edit…” from the
drop-down menu.
A nice feature is furthermore the possibility to create a new bin that contains the video clips which are included in the current smart folder.
Therefore right-click on the relevant smart folder and choose “New
Bin
from
Smart
Folder”.
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Choosing
Custom
Thumbnail
Images
Silverstack offers a flexible way to experience a great asset preview of your projects, bins, folder and camera rolls. We incorporated a feature allowing
you to define your own thumbnails to get a better oversight of your shots – scenes – takes and gives you the opportunity to navigate faster inside your
library and locate clips with one click.

Usual
behavior

By default, Silverstack analyzes the length of a clip and picks the thumbnail image from the middle of the take. You can customize the default behavior
in the preference menu. The thumbnail position can be set  to “Begin”, “Middle” and “End” of a clip. If you want to recreate your thumbnails you can
do so by making an asset selection and then click in the “Edit” menu “Recreate Thumbnails”. All selected assets thumbnails will be recreated.

 

Figure 1 : “Preferences for default thumbnails”

 

While this is suitable for most occasions, it might happen that the preferences of the clip is by coincidence a black frame, a meaningless moment like
blue sky or a frame that is not in focus which won’t help you to identify the right take from the table view, collection view or neither in the reports.

Customize
your
clip
thumbnails

To customize your reports or Table/Clip View with a thumbnail that matches your criteria as a DIT simply mark the clip and switch into the Playback
View to locate the right frame. From there you can scrub to the desired frame and set your thumbnail via the Main Menu entry in “Edit” – “Set
Thumbnail Frame”. You can alternatively use the Shortcut ⌘
+
T
to set the thumbnail.

Figure 2: “Switch to Playback View”

 

Figure 3: “Main Menu entry”

Note: You can only apply the ” Set Thumbnail” feature to Assets that have advanced playback support in Silverstack. You can find more information
about assets in this article.

Warning:
 If you recreate thumbnails with the function in the “Edit” menu all the previous thumbnail images will be erased and replaced with the actual
setting of the preference.
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The
Copy
and
Verification
Process
in
Silverstack:
Verification
Behavior
Silverstack and Silverstack Lab differentiate two basic types of verification behavior:

Included
in
Copy
Job:
Verification executed file per file
(One
Job
that
copies
and
verifies
[copying
file
1,
verifying
file
1,
copying
file
2,
verifying
file
2])

Separate
(per
Job):
Copy all files first in a distinct job and verify them afterwards in another job
(Copy
Job
[copying
file
1,
copying
file
2],
Verify
Job
[verifying
file
1,
verifying
file
2]).

This leads to several improvements for the transparency of the copy and verification process in Silverstack that are outlined in this article.

The
Verification
Behavior
in
Detail

Included
in
Copy
Job

The default verification behavior contains reduced options for the user. It is referred to as “Included
in
Copy
Job” as the verification process happens
file per file.

Fig.1: Verification behavior “Included in Copy Job”

It always verifies all destinations and the source (“Verify All Destinations, Include Source Verification”), therefore reduces options and makes sure the
highest possible security is maintained.

Here are the facts in an overview:

Verification
Behavior: Included in Copy Job
Verification
Coverage: All destinations, with source
Available
Checksum
Methods: xxHash64 (BE), MD 5, SHA 1

Separate
(per
Job)

The advanced verification behavior “Separate (per Job)” allows to complete the copy of all files first and verify them later. It is referred to as “Separate
(per Job)” as it creates a separate copy and verify job.

Using the “Separate
(per
Job)” verification behavior, there are multiple options to choose from for the verification coverage. The verification coverage
refers to the extent of verification that is performed.

Fig.2: The offload wizard options for the verification coverage when verification behavior “Separate (per Job)” is selected

The following options are provided for the verification coverage (refer to fig. 2):

All
destinations,
with
source
(default)
Abstract:
Highest
possible
security.
The verify job verifies all copy destinations …
 … and also the copy source.

All
destinations,
no
source
verification
Abstract:
Still
secure
for
destinations,
but
neglects
the
detection
of
source
problems
possible
with
“Source
Verification”.
The verify job verifies all copy destinations…
but does not verify the copy source.
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No
verification,
file
size
check
only
Abstract:
No
security,
use
with
care!
Only
the
size
of
copied
files
on
destination
is
checked
against
the
original.
No verify job is created. File size check is performed with copy job.
Even if it will not be verified, Silverstack creates a checksum during the copy process that is stored in the library. Checksum Method is
fixed to xxHash to avoid limiting copy speed e.g. using MD 5 as checksum method.

Suspend
Verify
Job

The first two selections for verification coverage have an additional option to suspend the created verify job (see also fig.2). This allows all other offload
and copy jobs to be executed before the verification. The verify job suspends automatically once scheduled, and has to be resumed manually by the
user.

About
Source
Verification

Learn more about “Source Verification” in the article Checksum Verification Methods. “Source Verification” or “verifying the source” refers to the
process of reading the source once more after the copy process end as part of the verification process. This is done additionally to reading the
destinations again to verify their checksums. The intention to do this is to make sure that the checksum still matches the one created during the initial
read of the file for the copy process to detect e.g. broken source cards. The verification of the destination remains untouched by this setting.

Cascading
Copy

When enabling cascading copy the verification coverage as well as the checksum methods can be selected per run:

Fig. 3: Selecting the verification coverage for both runs with cascading copy

More information about cascading copy can be found in the article Cascading Copy.

Additional
Options

Overwrite
existing
files: This option allows to overwrite already existing copies on the destination(s).
Skip
Copy
Step: The option to skip the copy step and only ingest material has been removed in the Offload wizard to clearly separate the copy
from the ingest functionality. To ingest material without copying use the “Add
to
Library…” entry in the “File” menu.
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Fig. 4: Using the “Add to Library” option for ingest only

Job
Scheduling
Control

The Offload wizard allows to schedule jobs in the queue to be executed next, after the running job finishes. The default behavior, to add the job to the
queue, will be restored after each copy job, as this is a hit and run choice before starting the jobs.

Fig.5: The job scheduling options

Learn more about reordering of jobs with drag & drop in the article Reordering and Suspension of Jobs.

Verification
States
(for
File
Resources,
Clips
and
Bins)
Since Silverstack 6.4 file resources (all registered file copies and the source) have a verification state that is displayed in the “File” tab of the right bar.

The verification state helps the user to identify the current verification status of the file resource of a clip. This is especially necessary with the
possibility to copy files first and verify them later in a separate job: With verification states it is explicitly identifiable if the resource has been verified.

3
Verification
States

A file resource can have 3 different verification states:

    Verified (green)

    Defect (red)

    Not
Verified (grey)

Here’s more details about the 3 states and what they mean:

Verified: The hash of the destination file matches the hash created during the initial copy of the file. For source (source file resources) a green
verified state means that they passed “Source Verification” (if enabled), which means a second read and hash check of the source and
comparison to the the initially created hash.
Defect:
The file resource has a different hash than the one created during the initial copy. This can be identified by any type of verification
Silverstack performs (e.g. as part of a copy job or with a separate verify job).
Not
Verified:
The file resource has not been verified. Silverstack did not attempt to do a verification due to settings of the user.  This can be the
case e.g. for the source file resource when “Source Verification” has been disabled, or for copy destinations when choosing to copy without
verification (which we do not recommend).

You can learn more about how the Silverstack copy process works in the following article:

How does the copy process in Silverstack work?
The Copy and Verification Process in Silverstack

Verification
States
in
the
File
Tab

The file resources in the file tab show the verification state per resource and as a summary for the clip:
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Fig. 1: The file tab with verification indicators

We can see that the clip has 3 file resources:

Source: Verified
Backup 1: Verified
Backup 2: Not Verified

The summary about the clip tells us that the verification is incomplete because at least 1 file resource is not verified. We will take a closer look at this
behavior in the next section.

Escalation
of
Verification
States
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Fig. 2: Tracing the indicators from the bin to the file resource in the file tab

To make the user aware of the verification state of all clips resources already on a bin level, the verification state is escalated from the file resource to
the library outline:

As multiple file resources can belong to a clips, a clip is inside a bin, and bins can be grouped in folders that can be ordered in the hierarchy inside the
Library outline the following escalation is performed:

File
Resource verification state
escalates
to…

Clip verification state
escalates
to…

Bin verification state
escalates
to…

Folder verification state
escalates
to…

Library verification state

There’s a clear hierarchy of severity of states that overrule and therefore define the state of the level above:

Defect
overrules…

Not
Verified
overrules…

Verified

Understanding both cascades will help you already identify folders and bins containing problematic clips. Using the verification state column (see fig.
2) you can trace the problem down from the bin to the file resource that might be defect or not verified.

Folders only show the verification state when collapsed to avoid confusion with containing states.

Running
Jobs
for
Bins

Due to their nature, the verification state icons on bin level do not necessarily give meaningful feedback while copy jobs are running for the bin (as
running copy jobs naturally lead to a change of the verification state). This is the case because new file resources are registered and verification
processes are on the run.

To address this a “Running Jobs” indicator has been introduced. Installed in the library on bin level, it shows in form of a little progress bar and tells the
user that this bin currently has jobs running in the background:

Fig. 3: The Running Jobs indicator in the library outline

Furthermore, the “running jobs” indicator for bins also brings other benefits such as e.g. already seeing on bin level if no job is running anymore for a
bin and a report can be created with a steady state of the library.

Migration

Please be aware that library versions of Silverstack prior to the 6.4 update do not include information about verification states. Therefore a migration to
6.4 will place verification states based on the existing job information. You can verify resources based on the existing hash information afterwards at
any time.

24

Silverstack	Lab	
Clip	Library



Also PSLAs (Pomfort Silverstack Library Archives) exported with 6.3 and earlier do not include information about jobs or verification states. Opened
with 6.4 or later all file resources will receive an “unverified” state.

Unregister
a
Project
from
Silverstack

Unregister
an
old
project

If you have several old projects in your library that you want to remove you can simply unregister them. All the clips/assets that are registered in the
library will be removed.

Note: The files that are linked to the assets will stay on the Backup Volumes and will not be removed!

 

Steps
to
remove
a
project:

1. Open up Silverstack

2. Select the Project you want to remove from Project selector within the toolbar.

Figure 1: “Select a project from Toolbar”

 

3. Go to the Main Menu and press “Unregister Current Project”

 

Figure 2: “Unregister Project”

 

Silverstack will switch automatically to the next project. If there are no other projects within your library, Silverstack will automatically create a new one.

 

Library
Metadata
Exchange
Export or import Silverstack Library Archives (psla) from one Silverstack project to another
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Metadata exchange between workstations

Exporting
library
metadata

Whole libraries, folders or bins can be exported using this feature. To start the process, simply select the item from the Library Panel and click on
Export>to Silverstack Library Archive (psla)…:

Export menu

The Library Export wizard will appear, letting you select again which library folder to export. In addition, you can add a comment to describe the
metadata content of the file.

 

figure 4: library export wizard

After selecting «Export», a destination selection dialogue will be shown. Once the file has been saved, it should look like this:

Silverstack library metadata file
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Importing
library
metadata

In order to import metadata from the previous process into another computer, you can just double click the «Day 1.psla» file. Otherwise you can select
Import>Silverstack Library Archive (psla)…:

import menu

Once the file has been selected, the Library Import wizard will appear. Here you can see the name of the foler that is going to be imported, the author,
the export date and the comment describing its content. You are able to choose between importing the metadata as a new project or into the current
project:

metadata import wizard

Please bear in mind that an active license is needed to use this feature. You will need to migrate the license in case only one license key has been
purchased.

 

Color
Controls
and
Grading
Modes
Color correcting clips is possible in the grade control tab of the Audio&Color panel.

Grade controls are separated in grading nodes, a grading node can be understood as one image filter with one or more parameters. A certain set of
grading nodes belong to a grading mode. A grading mode is a predefined set of nodes and also helps to work inside certain boundaries concerning the
type and order of grading nodes by setting limitations (e.g. CDL and LUT).

Grade
Controls
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UI with Grading Controls

The grade control tab in Silverstack consists of all controls for manipulating the image filtering :

Grading
mode
selector: Switch between the different grading modes available on the drop down menu
Grade
controls
with
nodes: Here you find all the nodes for a certain grading mode such as CDL color controls, 3D LUT loading node, saturation
etc. Each node can be individually disabled by un-marking the blue check box.
Look
Source
Name: The name of the currently applied look
Look
actions: The look action menu contains actions …

Clear
buttons: Clear either all grading nodes (“Neutral”) or just the creative color manipulation nodes (e.g. CDL node) and not LUTs or
tone mapping curves (Reset Colors)

Using the «Neutral» button you can reset all settings (color and LUT) to a «neutral» state.
Using the «Reset Colors» button you can reset the color settings to a “neutral” state.

Match
Looks
Clear
buttons: You can clear either the entire look or just the color manipulation (and not LUTs or tone mapping curves)

Using the «Neutral» button you can reset all settings (color and LUT) to a «neutral» state.
Using the «Reset Colors» button you can reset the color settings to a “neutral” state.

The grade
controls consist of the following elements:

Grading
node: Grouping element containing the actual grade controls
Node
enabling: Enable or disable the effect of a grading node
Edit
node
structure: Some grading nodes can have variable grading nodes, you can add and reorder grading nodes in the edit mode.
Control
panels: The control panels button and indicator shows the attached grading panel. You can disable / lock the attached grading panel to
prevent unwanted changes.
Result
curve: The video scopes shows the resulting curves for all enabled grading nodes in the three RGB channels.

 

Grading
Modes

Silverstack supports different grading modes designed for specific camera setups and workflow environments.

The node-based design allows you to disable and reorder individual filter nodes to have greater grading freedom. You can disable a certain node by
unchecking the blue check box. Have in mind that the processing order is from «top to bottom» when reordering the nodes.

Each grading mode allows different levels of grade customization, as the compatibility of the grades down the workflow creates some restrictions on
how the color information has to be processed. For example, the camera compatible grading modes can have the nodes locked in a certain position to
ensure the compatibility of the grade.
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The different grading modes to choose from.

 

The grading modes allowing the greatest level of customization are the Advanced and Freestyle modes.

CDL
and
LUT

The CDL and LUT grading mode

The CDL and LUT grading mode offers ASC-CDL controls for the use in a wide range of workflows. For clips recorded in Log color spaces, Silverstack
allows to import
3D
LUTs or choose from 3D
LUT
Presets.

In order to support workflows that apply CDL in log gamma as well as in video gamma, the order
of
LUT
and
CDL
filters
can
be
changed when using
the CDL Advanced grading mode. The CDL and LUT mode can also be used with Rec.709
clips
without adding a 3D LUT.

The color controls for the CDL and LUT grading mode consist of:

ASC-CDL
controls
node:
RGB Shadows,
Mid-tones
and
Highlights
color wheels

ASC-CDL color wheels

 

Saturation
slider node

Saturation node

 

Import of 3D
LUT
node: The CDL and LUT grading mode can import 3D LUTs and CDL files and can export ASC-CDL files.
3D
LUT
Import
options with averaged curve displays for each channel

3D LUT node

 

CDL
Advanced

Allows you to add and reorder multiple nodes on advanced workflows.
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Alexa
Looks
(Deprecated)

This mode is designed to create .xml ALEXA Looks compatible with ARRI ALEXA cameras. More information in the article Using the ALEXA Looks
grading mode.

Freestyle

This grading mode has been created to allow complete grading freedom. For this reason, there are some limitations on the available export formats for
looks created on this mode.

ACES
CDL

A mode adapted to the ACES standard. More information in the article Using the ACES grading mode.

ACES
CDL
Advanced

A mode adapted to the ACES standard. Allows you to add and reorder multiple nodes on advanced workflows.

ACES
Freestyle

This grading mode has been created to allow complete grading freedom inside an ACES pipeline.

Varicam
Compatible

This mode is designed to create 3D LUTs and looks compatible with Panasonic Varicam 35 cameras.

Amira
Compatible

This mode is designed to create .aml AMIRA Looks compatible with ARRI AMIRA cameras.

ARRI
CAP
Compatible

This mode is designed to create .aml Looks compatible with ARRI CAP (Camera Access Protocol).

FilmLight
BLG
Mode

This mode is designed to apply .blg Looks created with Livegrade Studio.

Note: The FilmLight BLG mode is only available when looks were imported via PFL/PFLA from Livegrade, and limited to CDL or Saturation node
changes.

 

Grading
Nodes

CDL
Node

The CDL node contains a color wheel for Offset, Power and Slope. It can be used to adjust the color on the image.

CDL grading node

ASC-CDL files can be directly loaded and saved to/from the CDL node (supported format: *.cdl).  Click the gear button on the left side of the CDL node
and select if you want to load or save a CDL.

Please be aware that the ASC-CDL specification always includes a saturation value. When one saturation node is present CDLs will be loaded and
saved from/to the present saturation node. When multiple CDL and saturation nodes are present you will be pointed choose the saturation node you
want to load the saturation to (indicators A,B,C etc.).

 

The CDL node has several interaction types with different controls for different interaction styles. The interaction types of one CDL node all work on the
same set of CDL values, so changing controls in one interaction type might change control positions also in the other interaction types.

The available interaction types:

CDL
interaction
type:

CDL node – CDL interaction type

The CDL interaction type allows to manipulate the nine values of the SOP triples (for each color channel R, G, B) of the CDL. The values in the nine text
fields are the same values as in an exported ASC-CDL file.

The color wheels have a global control (in the bottom left of each wheel), an indicator around the ring shows if the global control is modified. Changing
the wheel control doesn’t change the gloabl luma of that control, e.g. the channels are balanced and the global control doesn’t change by changing the
wheel position.
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Lift,
Gamma,
Gain
(LGG)
interaction
type:

CDL node – LGG interaction type

The LGG interaction type allows to manipulate lift, gamma, and gain (LGG) values as known from other grading systems. These control values are
mapped to CDL values in the background. The nine text fields show lift, gamma, and gain values (not ASC-CDL values) – switch back to the CDL
interaction type to see the CDL values of a certain setting of LGG values.

Note: Although ASC-CDL doesn’t specify limits of its values, some 3rd party software products limit values in their ASC-CDL grade controls. An
indicator (“i”) on the very right of the grade UI Silverstack indicates that values are out of the range that is commonly accepted.

The color wheels have a global control (in the bottom left of each wheel), an indicator around the ring shows if the global control is modified. Changing
the wheel control doesn’t change the global luma of that control, e.g. the channels are balanced and the global control doesn’t change by changing the
wheel position.

Simplified
(SPL)
interaction
type:

CDL node – SPL interaction type

The SPL interaction type allows to manipulate the values of the CDL filter with the controls Contrast, Stretch, Warmer and Greener.

Increasing the contrast control makes the resulting curve steeper by clipping black and white. Increasing the stretch control increases contrast in the
highlights, while decreasing stretch increases contrast in the shadows. Increasing the warmer control gives the image a warmer appearance by giving
the shadows a warmer tint while the whites stay unmodified. Increasing the greener control gives the image a greener appearance by giving the
shadows a greener tint while the whites stay unmodified.

Printer
Lights
(PRT)
interaction
type:

CDL node – PRT interaction type

The PRT interaction type allows to simulate a color correction based on printer lights. Printer lights can be approximated by an offset in camera log
encodings. Additional buttons for each color channel allow for changes in fixed steps.

ASC-CDL files can be directly loaded and saved to/from the CDL node (supported format: *.cdl).  Click the gear button on the left side of the CDL node
and select if you want to load or save a CDL.

Please be aware that the ASC-CDL specification always includes a saturation value. When one saturation node is present CDLs will be loaded and
saved from/to the present saturation node. When multiple CDL and saturation nodes are present you will be pointed choose the saturation node you
want to load the saturation to (indicators A,B,C etc.).

The size of the color wheels can be adjusted in the Preferences menu. Just choose a size that fits your display resolution.

The CDL node can be controlled by an external hardware grading panel. To have more information on how to use it, please check the following articles:

Tangent Element setup
Tangent Wave setup

Saturation
Node

Just drag the slider to either side to increase or decrease the saturation on your look.

Saturation node

3D
LUT
Node

The 3D LUT node is designed to load your own 3D LUTs by pressing the «Load…» button. Alternatively, you can also use one of the available preset
3D LUTs to convert the image to a Rec.709 color space.

3D LUT node
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Supported formats for loading into the 3D LUT node are:

Adobe Speedgrade (.cube; size 32,33, 65)

Assimilate Scratch (.3dl; size 32)

Panasonic Varicam (.vlt)

Autodesk Lustre ( .lut) 

Truelight (.cub)

1D
LUT
Node

The 1D LUT lets you load your own 1D LUT file. Click the “Load…” button and select the 1D LUT you want to load to the node.

1D LUT Node

In contrast to the curve node the LUT in the 1D LUT node can not be edited afterwards.

Supported formats are:

*.txt
channels: 3
range: 0.0 … 1023.0 (float)
header: “R G B – HDLINK GAMMA TABLE”
entries: 1024
row example: “221.37 221.37 221.37”

*.data
channels: 4
range: 0 … 16383 (integer)
entries: 16384
row example: 15040,15040,15040,15040

*.lut
channels: 3 (4 columns with leading index (0…65535, R, G, B)
range: 0 … 65535 (integer)
header: “LUT16”
entries: 65536
row example: 45490 58366 58366 58366

RGB
Curves
Node

 

RGB Curves node

The RGB Curves node lets you apply precise curve adjustments to master RGB values or to individual luma, red, green, blue and/or custom color
channels. Click on “Edit” to open the RGB Curves Editor window, which allows you to precisely grade your footage:

There are two modes to choose from:
“RGB-Based” adjusts the selected color channel including its luma and saturation values, while the “Master” curve is a ganged RGB
curve influencing the red, green and blue channel at the same time
“Luma-Based” adjusts the colors red, green, blue and/or the custom set color without influencing their luma and saturation values,
while the “Luma” curve can be adjusted independently

In the “Custom” color curve you can pick a custom target hue, for adjusting a certain color in your image precisely
To add a curve point just click on a curve, and in order to modify it’s value just drag and drop. You can adjust curve points using the left/right
and up/down arrow keys as well.
To remove a point, select the point and press Backspace.
When you move your mouse over the curve editor, the graph shows you the value of the exact point where it is. When the mouse pointer is not
moving or it is outside of the curve editor window the values of the currently selected curve point are being displayed.
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RGB Curves editor window

More information on how to use the editor can be found in the article Using the RGB Curves Editor.

Hue-Sat-Lum
Curves
node

The Hue-Sat-Lum (HSL) Curves node lets you apply precise secondary curve adjustments based on hue vs. hue, hue vs. saturation, hue vs. luma, luma
vs. saturation and saturation vs. saturation values. The associated tabs in the HSL Curves node allow you to precisely grade your footage:

The graphs on the x-axis in the individual mode windows (Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, Lum vs. Sat, Sat vs. Sat) represent the target
values of the associated mode. Added curve points can be dragged to change the values accordingly along x and y-axis.
To add a curve point just click on a curve, and in order to modify its value just drag and drop. You can adjust curve points using the left/right and
up/down arrow keys as well.
To remove a point, select the point and press Backspace.
When you move your mouse over the curve window, the graph shows you the value of the exact point where it is. When the mouse pointer is not
moving or it is outside of the curve editor window the values of the currently selected curve point are being displayed.

HSL Curves nodes

HHS
Node

The HHS node –Hue to Hue and Saturation– is a new kind of node that allows you to map a certain hue on the image and replace it by another color
with different hue and saturation. Here is an example where the red has been desaturated, but the other colors remain the same:

 

 

The HHS editor allows you to drag and drop the hue circles to another location on the color space to replace the original color with another one.
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HHS editor

Knee
Curve
Node

The Knee Curve node lets you create simple technical curve adjustments with three parameters for “Black (toe)” and “White (knee)”:

Limit: Increases/decreases the limit for white or black on the curve’s y-axis
Offset:
Increases/decreases the offset between limit and knee or toe curve point
Threshold: Increases/decreases the x + y coordinates of the knee or toe curve point

figure 14: Knee Curve Node

You can save your curve correction as a 1D LUT (.cube) file (or the inverse 1D LUT) for loading the adjustment in other color grading systems.

Amount
Slider

CDL nodes, RGB curve nodes, HSL curve nodes and HHS nodes have an amount slider which allows to fine-tune the effect of the associated grading
node. There is an intensity level indicator on the right hand side of the node. When clicking on it, you can adjust the intensity in a popover window,
either with a slider or by typing in a value from 0-100%.

Note: The initially set values in CDL nodes remain the same when changing the intensity. When you create a shot, the values of the grade are re-
calculated with the applied intensity amount and saved as new resulting values in the shot table.

CDL node with amount slider

Grading
Panel
Support

Silverstack supports the use of hardware grading panels for the grading functionalities. The following panels are supported:

Tangent Element Tk
Tangent Ripple
Tangent Wave
Tangent Wave2

Connect the hardware panels to Silverstack to precisely and physically manipulate your grades.

Using
the
ACES
CDL
Grading
Mode
Silverstack XT and Lab have the capability of reproducing ACES workflows.

All ACES versions support different IDTs (Input Device Transforms) and ODTs (Output Device Transforms). Please, make sure that the ACES version
used in Silverstack matches the one used during the post production process for maximum color accuracy.
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ACES
Grading
Modes

Silverstack implements this pipeline in the ACES (Academy Color Encoding System) grading modes. You can see the nodes and controls of the “ACES
CDL” grading mode in the screenshot below. On every interaction with the color controls of the ACES grading mode (e.g. change of IDT, modify of
ASC-CDL) all transforms are baked together automatically and are applied to the image.

Grading controls in the “ACES CDL” grading mode.

Silverstack also offers the “ACES CDL Advanced” grading mode. This grading mode lets you add multiple grading nodes between the IDT and ODT
and LMTs for advanced workflows.

The CDL controls behave the same way as in the CDL Grade mode and can also be exported as usual from a saved grade. ACES grades can also be
exported as 3D LUTs, including the CDL values, IDT and ODT.

From ACES version 1.3 you can enable the “Reference Gamut Compress” parameter within the IDT node of ACES grading modes. The ACES
Reference Gamut Compression achieves better accuracy with extreme color ranges and replaces the LMT “Blue Light Artifact Fix” that was widely
used in previous ACES versions.

The metadata fields “ACES Input Transform”, “ACES Input TransformID”, “ACES Output Transform”, “ACES Output TransformID”, “Reference Gamut
Compress” and “LMT Nodes” allow inspecting ACES look metadata in the shot library and communicating relevant info in PDF reports.

Look
Modification
Transforms
(LMTs)

You can add a “LMT” node in Silverstack (in the ACES CDL Advanced grading mode) that supports the official, predefined LMT transforms shipping
with the respective ACES version as well as custom 3D LUTs.

Note: LMTs are specified by the ACES specification as a transform from and to ACES AP-0 (the linear ACES color space). When using 3D LUTs as a
way to exchange “LMTs”, these 3D LUTs are usually intended to be applied in a typical grading working color space such as ACEScct (3D LUTs
cannot properly represent transforms to be applied in linear color encoding as they would not be able to provide the necessary fidelity in all brightness
levels). So in Silverstack, the “LMT” node is applied in the working color space (for instance ACEScct).

Managing
ACES
Versions

Silverstack supports multiple versions of ACES, ranging from 0.7.1, 1.0, to the latest ACES version 1.3. For compatibility with the post production
workflow please choose the right ACES version, as the transforms can be slightly different in different versions, and newer version usually include more
and more recent input (IDT) and output (ODT) transforms, including RRT+ODT transforms for HDR in ACES version 1.1 or higher.

Note: Transforms for ACES version 1.3 can be downloaded from Silverstack v8.2 or higher

In the Silverstack preferences you can manage the available ACES versions and transforms:
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ACES preference panel

The dropdown lets you select the ACES version for new looks. Every new look will be initialized with the ACES version selected in the dropdown in the
preferences.

That means that every look in the library made with an ACES grading mode has an associated ACES version (you can find that version in the “ACES
Mode” column in the Silverstack library). Saving looks with different ACES versions to the library will make it easy to compare the look of different
ACES versions effortlessly.

The icon in the status bar will either signalize an available set of transforms (green checkmark) or a set of transforms that can be downloaded from the
servers (download icon with downwards arrow).

Click the button “Check
for
New
Versions” at the bottom of the preferences window to see if new ACES versions are available to download from the
Pomfort servers.

Available
ACES
Versions

Different versions of the ACES are available from the application preferences (see also section “Managing ACES Versions”) :

v 1.3.0 (Working Color Space: ACEScct and ACEScc)
v 1.2.0 (Working Color Space: ACEScct and ACEScc)
v 1.1.0 (Working Color Space: ACEScct)
v 1.0.3 (Working Color Space: ACEScc and ACEScct)
v 1.0.2
v 1.0.1
v 1.0.0
v 0.7.1
v 0.7.0
v 0.2.0

ACES grades can also be exported as 3D LUTs, including the CDL values, IDT and ODT.

Exporting
ACES-based
Looks
as
AMF

Silverstack can export the current look of a clip using “File > Export > Looks from Clips…” to export looks from all selected clips or stored looks in the
look library as AMF files (“ACES Metadata Files”, .amf). Currently the export of AMF is limited to the ACES CDL grading mode.

For more information about exporting Looks from the Silverstack Look Library see the article Exporting Looks from Silverstack.
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Supported
ACES
IDT
and
ODT
Transforms

Silverstack offers all officially (in the Academy’s repository) available IDT and ODT transforms, as well as a few custom transforms by Pomfort. Please
take a look at the available transforms in Silverstack’s preferences in the “ACES” tab.

ACES
landing
page

See http://pomfort.com/workflow/aces/ for an overview of ACES related topics with Pomfort’s products.

The
Silverstack
Look
Library
Silverstack enables you to manage looks within Silverstack in a look library in order to keep a proper overview of all the looks in your project. The look
library allows to store new looks, edit their metadata, apply looks to one or multiple clips, as well as to import looks from Livegrade.

The
Look
Tab

The look tab in the right bar of Silverstack is marked with a specific icon:

Click the icon to reach the look tab. The tab itself consists of three sections:

 

Look
Library
Looks
Look
Details

Figure 1: The Silverstack look tab containing the Look Library.

 

In detail those sections enable you to:

Look
Library

Create new folders by clicking the “+” button on the top right
Create sub folders by holding “alt” plus clicking the “+” button
Edit the structure by dragging folders out of or into each other
Rename folders by selecting and single clicking them or hitting enter
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Figure 2: Organize folders containing looks

Looks

Create a new look by clicking the “+” button on the top right
Update a look by selecting one and clicking the update button next to the “+” button
Preview a look by selecting it and clicking plus holding the loupe icon
Apply a look to the current clip in the player by double-clicking the intended look
Apply looks to multiple clips by selecting the desired clips and double clicking the intended look
Move one or multiple Looks to other folders by dragging and dropping it to a different Looks folder in the Look Library*

Figure 3: The looks section with highlighted add, update and preview look buttons

The context menu for looks can be reached by right clicking a look. It enables you to:

Figure 4: The context menu can be reached with a right click on a look

Apply a look to the selected clips (one or multiple clips)
Apply a look only to the current clip shown in the player (even if multiple clips are selected)
Update the look with the current grade
Set a new thumbnail from the current clip but leaving the look identical
Delete one or multiple looks.

 

To learn how to use the Silverstack grading controls please refer to the article Grading Controls in Silverstack.

Look
Details

When importing looks from Livegrade, the information fields in the Look Details receive the values from the look edited in Livegrade. In the Look Details
it is possible to:

Edit the look name
Edit metadata of the look including Date, Camera, Episode, Shot,Take and Reel Name
Display Start and End Timecode
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Figure 5: The Look Details section

Importing
and
Exporting
Looks

You can import a look from Livegrade by selecting “File>Import>Pomfort
Looks
(pfl)…” from the main menu. You can learn about the process of
transferring looks from Livegrade to Silverstack in the article Importing Looks (from Livegrade).

 

Read about exporting looks from Silverstack in the article Exporting Looks from Silverstack.

Look
Functions
in
the
Main
Menu

You can find most of the functions concerning the Look Library in the Main Menu. Go to “Main
Menu>Look” and choose from the following actions:

Figure 6: The “Look” section of the Main Menu

Create a new look
Update a selected look
Set the thumbnail from the current clip
Duplicate Look
Create a new look folder
Apply a look to all selected clips
Apply a look only to the current clip
Switch to the previous look node (useful for working with grading panels in more advanced grading modes)
Switch to the next look node (useful for working with grading panels in more advanced grading modes)
Refreshing hardware panels

Please refer to the shortcuts at the end of the entries for faster access of the functions.

 

 

* Please be aware that you have to click and hold the selected look(s) to see the transparent thumbnails pop out to enable the drag & drop function. Trying to move a look while immediately
pulling it will leave you with the multi select function of the collection view.

Look
Matching

While using Silverstack
together
with
Livegrade on set to manage clip data and looks hand in hand, you surely want to combine the created
information afterwards.

Silverstack offers a solution to avoid assigning looks to clips manually. You can connect them based on the metadata you already created while
generating them.

The looks/shots can be transmitted

via an exchange file format (.pfla) or
via Pomfort ShotHub.
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Get
Looks
via
ShotHub

You can retrieve shots from Pomfort ShotHub that have been created and uploaded with Livegrade to match them to clips in Silverstack.

NOTE: If you are not using the same Pomfort account in Livegrade and Silverstack, you need an invitation of the admin to the Shothub project
containing the grading information that you want to access for look matching.

The
steps
to
match
looks
from
Livegrade
to
Clips
in
Silverstack
via
ShotHub
are:

1. Upload shots from Livegrade to ShotHub (more information please see the article Connecting Livegrade to ShotHub)
2. Log in to ShotHub in Silverstack with your Pomfort Account credentials (more information please see the article Connecting Silverstack to

ShotHub)
3. Click the “Match Looks…” button in the color panel toolbar or select “Match Pomfort Looks” from the Import menu in the main toolbar.
4. Click “Fetch Looks from Cloud” and select the bin with shots to be fetched:

5. Match by desired criteria and apply looks (and metadata)

 

Get
Looks
via
File

It is possible to automatically match a package of looks created with Livegrade Pro to the according clips in Silverstack.  A Look Archive (.pfla)
containing several different looks can be exported from Livegrade Pro.

This Look Archive can be imported into Silverstack to then match the looks to the according clips based on different metadata.

The
steps
to
match
looks
from
Livegrade
to
Clips
in
Silverstack
via
a
Pomfort
Look
Archive
File
are:

1. Export a Look Archive from Livegrade Pro
2. Import the Look Archive into Silverstack
3. Match by desired criteria and apply looks (and metadata)

 

1.
Export
a
Look
Archive
from
Livegrade
Pro

A Look Archive can contain one or multiple looks along with all the further metadata acquired in Livegrade Pro.

To export a Look Archive put all the desired looks into one folder in the Livegrade Look Library. Perform a right click on that folder and choose “Export
Look Archive” from the context menu:

 

40

Silverstack	Lab	
Clip	Library

https://kb.pomfort.com/?p=15267


Exporting a Look Archive from LiveGrade Pro

Save the resulting .pfla (Pomfort Look Archive) file to the desired destination.

2.
Import
a
Look
Archive
into
Silverstack

Make sure you ingested all the clips that will get a look into one bin in Silverstack. Learn about offloading media from the article Parallel Offloading.

Bin with clips that should receive matching looks

Make sure to have the according bin selected prior to starting the import.

To import a Look Archive into Silverstack go to the Main Menu. Choose “File
>
Import
>
Match
Pomfort
Look
Archive
(pfla)”:

Importing a Look Archive for Matching

3.
The
Look
Matching
Wizard

After that a wizard window will open. Select “Choose Look Archive…”.
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Navigate to the .pfla file you saved from LiveGrade Pro, select it and click “Open”.

4.
Match
by
Desired
Criteria
and
Apply
Looks

From this step on the process is identical whether the looks come from a file or via the cloud.

You can choose between different matching criteria:

Set the look matching criteria

 

•
Match
by
Timecode

This criterion will match the looks by timecode. The look will match to a clip if its TC
In is before or within the range of the TC of the clip. Additionally
the looks will be applied to all clips that follow until the next look with a subsequent TC
In. If a new look has a TC
In that is inside of the TC
range of a
clip (so the look before ends within the clip) the matching wizard will suggest two looks but preselects the latter by default.

 

•
Match
by
Creation
Time
of
Look

This criterion will match the looks by their creation time. The look will match to a clip if its creation date is before the time range of the clip. It will match
to all following clips until a new creation date of a look is found that is placed inside the time range of a clip. Additionally you can shift the timezone if
the camera setup was wrong at the time of recording:

Adapt the timezone offset if needed
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•
Match
by
Episode,
Scene,
Shot,
Take

This criterion will match the looks by the episode, scene, shot and take metadata values. The look will match to a clip if the metadata for episode,
scene, shot or take is equal.

•
Match
by
Clip
Name

This criterion matches the looks by Clip Name. The Clip Name of the look has to be equal to the Clip Name in Silverstack or you can select to only
match by the first characters of the Clip Name.

Match only the first 8 characters of the clip names

 

 

•
Match
by
Clip
Identifier
(with
Clip
Name)


This criterion matches the looks by Clip Identifier. The Clip Identifier of the look has to be equal to the Clip Name in Silverstack or you can select to
only match by the first characters of the Clip Name.

 

Additionally to the three different matching criteria, for each of them you can:

•
Match
with
Camera

Additionally to the selection of your criterion among the three criteria you can choose if the looks should be matched to the clips by the camera
metadata value.

Example:

If you have Camera A and B and match looks by timecode the looks may apply to both of the cameras if they have the same TC. If you then enable the
checkbox “Match with camera” the camera value will be considered on top of the TC and will then match the correct looks to the camera specific clips.

Taking
Over
Metadata
from
Looks
to
Matched
Clips

The PFLA (Pomfort Look Archive) enables you to take over metadata from the Livegrade Pro looks (from the Shot Library) to the matched clips in
Silverstack

In the lower section, the option to take over metadata from Looks to matched clips is enabled by default via its checkbox. If checked, the “Continue”
button will lead you to the next wizard page, where you have several options for importing of the metadata. Also, you can preview the metadata import.

Insert
/
Update
Behavior: Insert
if
empty
only fills metadata in Silverstack if it is not set and prevents metadata to be overwritten. Overwrite
forces the metadata from the Look in the PFLA to be written in the according Silverstack metadata field.
Import
Content: You can deselect certain metadata categories that you do not want to be imported. The tooltip of the label shows the concrete
metadata fields that are included within each category.

Slate
Info: Camera, Season, Episode, Scene, Shot, Take, Reel Name, Int/Ext, Day/Night
User/QC
Info: Flag, Rating, Comment, Caption, Distance to Object, Custom 1-6
Exposure
Info: ASA, Whitepoint, Tint, ND Filter
Lens
Info: Lens Model, Focal Length, T-Stop, Focus Distance, Filter
Production: Shooting Day, Crew Unit, Location

 

43

Silverstack	Lab	
Clip	Library



To learn how to simply transfer looks from LiveGrade to Silverstack please refer to this article Transferring Looks from LiveGrade Pro to Silverstack.

 

Matched
Look
Details
in
Header
Tab

More details about the matched look can be found in the header tab of the right bar:

 

Audio
Clips
in
Silverstack
Silverstack offers advanced support for separately recorded audio files in the Broadcast Wave format (BWF, .wav).

Ingest
of
Audio
Clips
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Fig 1: Ingest and copy Broadcast Wave audio files

To ingest audio files into Silverstack click the “Offload” button in the upper left corner of the UI and choose the card or folder with the audio files to be
offloaded. Audio files can be backed up within the audio wizard just as any other file type. Learn more about it in the article Parallel Offloading.

After starting the offload process Silverstack will register the audio clips in the library:

Fig. 2: Audio clips in the Silverstack library

Silverstack will automatically detect .wav files that belong to the same clip and merges them together to an audio clip containing several audio tracks.

By opening the audio panel with the
“Audio&Color”
button in the toolbar all the audio tracks including waveform will be visible for the selected audio
clip.

You can play audio clips back by clicking the play button.

The audio panel offers the following controls:
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Master
Volume: Controls the output signal level of the mix.
Audio
meters: Represent the audio signal level during playback. There is a stereo Master meter and additional Channel meters — one for each
audio track. The scale on top of the meters indicates the audio level in dB (dBFS). Peaking is represented by a bar in the according color of the
peaking level that remains at the maximum position. You can reset the peak bar by clicking on the audio meters.
Channel
mixers: The sliders control the signal level for each track. You can mute specific «Left» and «Right» tracks by disabling the check boxes
on the right of the channel mixers.
Mute
button: Mutes the according audio channel or the complete audio clip section
Solo
button: Solos the according audio channel, as long as the button is pressed
Pan
control: Sets the panorama to left, middle or right

The audio tracks panel can be opened from the small play button on the left side of the track name. It enables the playback of a single audio channel*:

Fig. 3: The audio tracks panel with single audio track playback

Audio
Clips
Metadata

Audio clips in Silverstack own a special set of metadata that is shown in the General Info tab of the right bar. The following metadata will be pulled from
the audio file metadata:

Scene – Shot – Take
Wild Track
Recorder Model
Recorder Device ID
Samples since Midnight
FPS of TC
TC Start
TC End
Tape
Recording Date
Audio Track Names

Adding
Audio
Clips
as
External
Audio
to
Video
Clips

Once ingested audio clips can be added to video clips as external audio either manually (Silverstack XT) or automatically (Silverstack Lab):

Manual Audio Sync: How to Manually Sync Audio in Silverstack XT and Silverstack Lab
Automatic Audio Sync: How to Automatically Sync Audio Based on Timecode in Silverstack Lab

 

*only available in Silverstack XT and Silverstack Lab

How
to
Manually
Sync
Audio
in
Silverstack
XT
and
Silverstack
Lab
Silverstack XT and Silverstack Lab offer functionality to manually sync audio clips to video clips.
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Basic
Principles:
Audio
Sync
with
Slate
Markers

The process of manually syncing audio in Silverstack is divided into two basic steps: matching the according audio clip to a video clip, and
subsequently syncing the audio and video clip at the right position.

The basic idea of the sync at the right position bases on the functionality of setting
slate
markers in the video and audio clip. By setting slate markers
the user defines a sync
position
in
both
audio
and
video
to
be
used
to
link
the
audio
and
video
clips. Silverstack will automatically align the video
clip and the according audio clip at the specified positions.

The article will describe in detail how to set the slate markers in the UI of Silverstack to attain a sync at the intended position as well as how to move
the sync position if needed.

The counterpart of the manual sync is the automatic sync based on timecode that is available in Silverstack Lab. You can learn more about automatic
audio sync in Silverstack Lab in the article “How to Automatically Sync Audio Based on Timecode in Silverstack Lab“.

Manual
Audio
Sync:
Step-by-Step

Overview

1. Have all needed assets available in the Silverstack Library (audio and video clips have to be available for playback).
2. Open the video clip you want to manually sync audio in the Silverstack player and go to the frame you want to set the video slate marker (e.g. the

frame where the slate visually closes).
3. Open the “Audio&Color” panel in the lower center of the UI and switch to the audio tab (or hit the “QC” UI Layout button in the toolbar).
4. Add the fitting audio clip to the current video clip by clicking the “+” button in the upper right corner of the audio panel
5. Browse to the position of the audio clip you want to set the audio slate marker and hit the “Slate a+v: Video + Audio” button to set the slate in the

video and the audio at the current position of the playheads.
6. Click “Add Clip” to add the audio clip as external audio to the video clip and sync at the position of the slate markers.

Please note: You can also set audio and video slate markers independently and in any order.

In
Detail

1.
Register
All
Needed
Assets
in
the
Silverstack
Library

Make sure to have the video clips and their according audio clips registered in the Silverstack Library. Learn about audio clips in Silverstack in the
article Audio Clips in Silverstack.

2.
Open
the
Video
Clip
You
Want
to
Manually
Sync
Audio
With

Fig.1: The video clip at the slate position.

Move the video clip to the frame the slate goes down. If no slate is present you can choose any other significant position you want to sync to.

In this example the slate will be set in the next steps together with the audio slate. It is also possible to already set the video slate at this point. Read
more about “Relocating Slate Markers” in the according section below.

3.
Open
The
“Audio&Color”
Panel
in
the
Lower
Center
of
the
UI

The audio panel can be opened by clicking the “Audio&Color” button on the right side of the toolbar. Make sure to show the audio panel (see Fig.1).

The right configuration for adding manual audio clips can also be achieved by clicking the “QC” UI layout button in the toolbar (you can learn more
about UI layouts in the article “UI Layouts: Quick Configurations for the Silverstack User Interface“).
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4.
Hit
The
“+”
Button
in
the
Upper
Right
Corner
of
the
Audio
Panel
to
Add
an
Audio
Clip

The “+” button in the upper right corner of the audio panel opens a popover that lets you select an audio clip that should be added to the video clip:

Fig. 2: Choose an audio clip to be added

 

Fig. 3: The “Add Audio Clip” popover in detail

Select the intended audio clip from the “Audio
Clip” dropdown.

Move the playhead of the audio clips to the position you want to set the audio slate to. Click the button  to set both, the audio and the
video slate at the positions of the according playheads.

The button   will set a slate only in the audio clip.

Please note that a video clip that has an external audio clip assigned to it will in any case contain a slate marker. If the slate marker is not specified it
will be set to the current playhead position of the video clip and will accordingly be used as the sync position.
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6.Click
“Add
Clip”
to
add
the
audio
clip
as
external
audio

Now click “Add
Clip”. The specified audio clip will now be added to the video clip and all tracks will now be available in the audio panel. The video and
audio clip sync at their slate positions.

Fig. 4: External audio in the audio panel

Multiple
Audio
Slate
Markers

When adding one audio clip to more than one video clip, it is possible to set an individual audio slate maker position for each video. This allows you to
sync each video to different positions on the same audio clip, e.g. if there are individual claps for each camera or if two takes are recorded on the same
audio clip.

If you open the “Add Audio Clip” popover for one audio clip that is already synced to another video clip, the first (already set) audio slate marker is
automatically restored in this view for your convenience.

 

Relocating
Slate
Markers

Audio

You can relocate the audio slate marker for an external audio clip by opening the audio tracks playback panel. That can be done by clicking the play
button  that can be found on the left of the track name labels in the audio panel:

Fig 5: The audio tracks panel to listen to a single audio track

Move the detail indicator (red box) to a new position and click the button  to set the audio slate to the position indicated by the
playhead in the detail view at the bottom right of the popover.

Video

You can relocate the video slate marker within the cue points section of the User Info tab of the right bar:
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Fig.5: The video slate marker is a special cue point in the cue points section

Move the playhead of the video clip to a new position and click the “set video slate” button  in the cue points section of the User Info tab.
Alternatively you can use the shortcut Ctrl
+
Cmd
+
Enter
to set the video slate marker at the current position of the playhead.

Please note that the video slate marker is a special kind of cue point. You can remove the video slate marker like removing a cue point. In case of
external audio existing you will not be able to remove it as a video clip will with external audio will always have a slate marker. Learn more about cue
points from the article Metadata Handling: View, Organize, Add and Filter Clips.

Removing
External
Audio
Clips

External audio clips can be removed by clicking on the gear menu in the header bar of the external audio clip:

Fig. 6: Remove an audio clip from from inside the gear menu

Remove: Removes the audio clip attached to the video clip.
Reveal: Reveals the audio clip in its audio bin
Mid/Side: Select the channels that should be used for mid/side stereophony

Audible
Frame
Stepping

When stepping through a video clip with audio frame by frame with the arrow keys you will be able to hear audio for every frame.

UI
Layouts:
Quick
Configurations
for
the
Silverstack
User
Interface
Silverstack comes with 3 to 4 options * to automatically configure the user interface in a steadily defined way. Like this you will be able to switch to a
certain UI configuration that is convenient for a particular task with one click.

Accessing
the
UI
Layouts

The UI Layouts include the following configurations:

Manage
QC (Quality Control)
Color
Config (Transcoding Configurations) *

The UI Layouts can be configured from the shortcut buttons on the right side of the Silverstack toolbar:
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Fig. 1: The UI Layout shortcut buttons in the toolbar

Alternatively the UI Layouts can be accessed from the “Window” menu:

Fig. 2: The UI Layout shortcuts in the “Window” menu


UI
Layouts
with
One
Display

Manage: Configures the UI in a convenient way for all kinds of management tasks.
Left bar: Shown (Library)
Center: Collection View
Right bar: General Info
Audio & Color panel: Hidden
Mini Player: Open

Fig. 3: UI Layout: Manage

QC
(Quality
Control): Configures the UI in a convenient way for all kinds of quality control tasks.
Left bar: Hidden
Center: Player
Right bar: User Info tab
Audio & Color Panel: Audio

Fig. 4: UI Layout: QC
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Color: Configures the UI in a convenient way for color grading.
Left bar: Hidden
Center: Player
Right bar: Look Library
Audio & Color Panel: Color

Fig. 5: UI Layout: Color

Config
(Transcoding
Configurations)*: Configures the UI in a convenient way for adjusting transcoding configurations.
Left bar: Hidden
Center: Transcoding Preview
Right bar: Transcoding configurations
Audio & Color Panel: Hidden

Fig. 6: UI Layout: Config

UI
Layouts
with
Two
Displays

The UI Layouts establish different configurations of the user interface when the second display is activated.

Please refer to the article Second Display: Two Screen Working Environment for more information about using a second display for the Silverstack UI.

*UI Layout “Config” (Transcoding Configurations) only available in Silverstack Lab.

Search Code: ST-UI1

Second
Display:
Two
Screen
Working
Environment
in
Silverstack
Silverstack XT and Silverstack Lab offer the possibility to extend the Silverstack user interface to two screens.
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Accessing
the
Second
Display

When a second display is attached to your machine, you can show an additional user interface by selecting “Second
Display” from the “Window”
menu.

Second
Display
User
Interface
Options

The second display opens automatically on the screen that does not hold the Silverstack main window.

There are 3 content options for the second display:

List
View
of
clips

Fig. 2: The List View on the Second Display

Collection
View
of
clips
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Fig. 3: The Collection View on the Second Display

Player
View

Fig. 4: The Player View on the Second Display

Silverstack automatically adapts the interface to avoid a simultaneous display of the same element (List View, Collection View, Player View) in both the
main window and the second screen. When an element is accessed that is already shown in the other display it is automatically flipped with the
previously shown element on the first screen.

Transfer
of
Project
Settings
Silverstack allows to export and import project settings to transfer them to new projects or different machines. This can e.g. help to move project
settings from established projects to new projects to avoid setting up from scratch. Other use cases involve the transfer of transcoding presets from
Silverstack XT or Lab to new projects or other machines.

Which
Settings
Can
Be
Transferred
?

The settings transfer involves certain project based settings as well as global settings. Find the settings that can be transferred below.

Project settings:

Folder Structure
Smart Folders
Transcoding Presets
Copy Job Templates
Label Names
Titles for Custom Fields

Global settings:

Table View Presets
Format Options
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Export
and
Import
of
Project
Settings

To export or import project settings go to the Silverstack Main Menu and select “File
>
Project
Settings
>
Export…
/
Import…”:

Fig. 1: Export and Import of Project Settings

You can choose the content to be exported after clicking on “Export…”:

Fig. 2: Export project settings options

Here are the details about the different export options:

Project
settings:

Folder
Structure: Transfer the folder structure of your Silverstack library to a new project. All top level folders can be selected for the export.
Smart
Folders: Transfer your custom smart folders to a new project.
Transcoding
Presets: Transfer your custom transcoding presets to a new project*
Copy
Job
Templates: Transfer your custom copy job templates saved in the offload wizard to a new project.
Label
Names: Transfer the custom names for the color labels.
Titles
for
Custom
Fields: Transfer your custom filed titles.

Global
settings:

Table
View
Presets: Transfer your table view presets (of the main table of clips and metadata) to a new project.
Format
Options: Transfer the settings of the “Format Options” in the Silverstack preferences to a new project.
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Fig. 3: Example of the project settings export wizard including folders and transcoding presets

Click “Export” to save the .psconfig (project settings configurations) file containing the project settings information to the selected destination.

The export and import settings windows are symmetrical hence you can choose which content to write to the .psconfig file as well as which content to
import from a .psconfig file.

Fig. 4: Example of the project settings import window

 

Setting
a
Default
Template
for
New
Projects

Additionally to the export and import of project settings you can define a .psconfig file that should be used as a template to create new projects.

First export a project settings file as described above and include all the settings the default template for new projects should contain.

Then go to the Silverstack preferences by choosing “Silverstack/Silverstack
Lab
>
Preferences…” in the Main Menu.

In the
“General” tab of the preferences you can click “Choose…”
 to select the default .psconfig file for new projects:
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Fig. 5: Choose the .psconfig file the default project settings for new projects should be loaded from.

When you now create a new project in the toolbar or from the “File” menu (“File
>
New
Project…”) all contents of the selected .psconfig file will be
loaded as default for the new project.

Additionally to the manual process of loading the default .psconfig file in the preferences you can copy a .psconfig file named “defaults.psconfig”
to the library folder to be taken as the default template:

For Silverstack 8: ~/Library/Application Support/Pomfort/Silverstack8

For Silverstack Lab 8: ~/Library/Application Support/Pomfort/SilverstackLab8

Attention: Please be aware that the .psconfig file in this location will overrule the UI settings.

The .psconfig files are generally compatible throughout the different Silverstack versions Silverstack, Silverstack XT and Silverstack Lab. Please be
aware though, when importing transcoding presets from Silverstack Lab into Silverstack XT that restrictions due to incompatible features such as e.g.
DNx transcoding only available in Silverstack Lab might apply.

 

*Only available for Silverstack XT and Silverstack Lab as the basic version of Silverstack does not support custom transcoding presets.

Extracting
LTC
from
Internal
Audio
in
Silverstack
and
Silverstack
Lab
Linear (or Longitudinal) timecode (LTC) is an encoding of SMPTE timecode data in an audio signal.

The process of feeding LTC into the audio channel of a camera from external sources (such as timecode devices), is often used for cameras that either
cannot handle external TC sync and/or do not provide proper timecode to the recorded clips. It offers the possibility to include such cameras in a
workflow that requires synchronous timecode.

The timecode data existing in internal audio tracks of video clips can be extracted in Silverstack and Silverstack Lab to be applied to the metadata of
the video clip. This enables subsequent processes that leverage timecode, such as e.g. providing detailed clip metadata for editing, transcoding clips
with embedded timecode metadata, creating detailed clip reports or automatic audio sync based on timecode.

How
to
Extract
LTC
and
Apply
it
to
Clips

To extract LTC in Silverstack first make sure to ingest all clips with LTC into the Silverstack library.

Choose the bin or folder containing the LTC clips and from the “Media” button menu in the toolbar choose “Extract
LTC”:
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Fig. 1: Extract LTC in the “Media” menu

A wizard window opens that immediately extracts LTC for all selected clips:

Fig.2: The LTC wizard finished the extraction of LTC for all selected clips

The following information is visible to the user in the wizard:

Selected clip and audio information
Original Clip TC
Extraction status with channel information
Extracted LTC and fps of LTC info

Silverstack attempts to read the LTC at the beginning of a clip. If no LTC is found the application iterates into the clip’s timespan in several steps
searching for an LTC in the whole clip. This also indicates that an LTC only has to exist for the beginning of a clip to be read out properly.

By checking the “Mute
LTC
Channels” checkbox you can make sure that after applying the LTC timecode to the clips the channels with LTC will
become muted in Silverstack.

Click “Apply
TC” to replace the Clip TC with the extracted LTC.

Please be aware that the process of applying the extracted LTC to the clip is not reversible and cannot be undone. Once you have taken over the
extracted LTC to the clip you cannot go back to the original TC from the clip.

After taking over the extracted LTC to the clips each clips will have the regular “TC
Start” and “TC
End” in the General Info metadata on the right and
in the table view:

Fig. 3: The extracted LTC now is handled as the regular Clip TC in the Silverstack library

Now the timecode can be used for all subsequent task that involve the need of timecode for clips like e.g.  transcoding or automatic audio sync based
on timecode.
. Learn more about it in the article How to Automatically Sync Audio based on Timecode in Silverstack Lab.
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Error
Cases
and
Troubleshooting
when
Extracting
LTC

When extracting LTC from video clips there are different possible error cases that are displayed in the LTC extraction wizard:

Fig. 4: The LTC extraction wizard with error messages

The “Extraction
Status”
column gives you insights about the following error cases:

“No
LTC
track
found”:  No LTC track was found for the clip. Check the clips audio in the audio tab of the “Audio&Color” panel.
“Type
mismatch”: The fps of the LTC do not fit the LTC of the clip and the clip TC can therefore not be calculated correctly. This could
especially become a problem with certain DSLR camera types that display 24fps as user selection in the menu but record in 23.976fps. Make
sure clip TC and LTC match for a proper extraction.
“Clip
offline”: Clip is offline. Bring clips online to extract LTC.
“Extraction
error”: An unknown extraction error occurred.
“Clip
has
no
audio”: The clip has no audio.  Check the clips audio in the audio tab of the “Audio&Color” panel.

Please be aware that LTC in the audio track does usually not survive compressed codecs such as e.g. MP3.

As the drop flag only affects the way of counting timecode and not its actual speed it is possible to apply drop-frame LTC on non-drop clips and vice
versa.

As the bounds of an image frame are not necessarily the bounds of an LTC-audio frame, an error of up to a half frame can accumulate when
synchronizing audio to LTC.

 

 

Dynamic
Metadata

Silverstack XT and Silverstack Lab come with a “Dynamic
Metadata” panel that allows to extract dynamic metadata for supported clip formats. 
Dynamic metadata refers to certain metadata information that changes over the time span of a clip (e.g. like TC which can also be considered
dynamic). It is stored differently in diverse formats and therefore needs a special process to be accessed.

 

Fig. 1: The dynamic metadata panel in the upper left corner of the Silverstack UI
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Supported
Clip
Formats

The following clip formats are currently supported for the extraction of dynamic metadata in Silverstack XT and Lab:

ARRIRAW (.ari sequences and in .mxf container)
ARRI Prores
REDRAW
SONY XAVC
SONY X-OCN
SONY RAW

Available
Dynamic
Metadata

The main part of dynamic metadata is dynamic lens metadata:

Focal Length
Aperture (T-Stop)
Focus Distance

For ARRI ProRes and ARRIRAW clips Silverstack XT and Lab also support:

Camera Tilt
Camera Roll

How
to
Extract
Dynamic
Metadata

Select the third icon displaying a horse in the left sidebar above the library (see fig. 1)

To extract dynamic metadata for the selected clip press the “Extract Dynamic Metadata” button in the middle of the dynamic metadata panel.

You can start the extraction of dynamic metadata for multiple clips by selecting an entry from the gear menu in the toolbar:

Fig. 2: Extract dynamic metadata for multiple clips

The extraction process for all clips can be monitored in the popover that reveals the current extraction state for every started clip:

Fig.3: Extracting dynamic metadata from multiple clips

After a successful extraction the dynamic metadata panel reveals the extracted dynamic lens and camera metadata:
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Fig. 4: The dynamic metadata panel with successfully extracted metadata

The metadata can now be inspected during playback or while scrubbing through a clip.

For completeness concerning lens metadata three additional static fields have been added to the lower section of the panel:

Lens
Filter
ND Filter

They mirror data from the library and can also be edited in the General Info of the right sidebar.

Using
Extracted
Dynamic
Metadata
for
Reports

For clips that support the extraction of dynamic metadata Silverstack extracts the dynamic metadata of the first frame already on ingest. That also
allows Silverstack users to benefit from the dynamic metadata functionality and receive lens and other dynamic metadata for the first frame.

The additional lens fields can be exported to clips reports to enhance their information.

Silverstack XT and Silverstack Lab provide an extended functionality to leverage the dynamic metadata for generic clips reporting.

In the “Media” preferences it is possible to make sure that the static representation of the extracted dynamic metadata, that is used for the General info
and table view library, follows the thumbnail frame:

Fig. 5: Using the extracted dynamic metadata of the thumbnail frame for reports

Like this you can make sure that the metadata that is referenced in the reports goes along with the shown thumbnail.

The focus distance unit can also be changed at the same position and allows to choose the display of the focal length in the dynamic metadata panel
and the General Info to be imperial (inches/feet) or metric (millimeters/meters).
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Export
of
Dynamic
Metadata
to
a
CSV
File

After successfully extracting the dynamic metadata from a clip, you can export the per frame metadata to one csv file per clip.

To trigger the export select the entry “Dynamic Metadata (CSV)…” in the Export menu of the toolbar:

Export dynamic metadata to a CSV file

In the subsequent step only the clips are shown that have successfully extracted metadata. You can check in the table view column “Dynamic
Metadata” if a clip has extracted dynamic metadata successfully:

The two clips on top have successfully extracted metadata, the two on the bottom don’t

Here’s an example of a dynamic metadata CSV file where you can also see the available columns:

The unit of the column “Focus Distance” depends on the setting available in the application preferences.
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Dynamic
Metadata
Burn
Ins

Silverstack Lab supports the functionality of adding burn ins of dynamic lens data when transcoding clips.

A “Dynamic
Lens
Info” string that contains focal length, aperture and focus distance can be selected from the burn in options to be transcoded to the
clips.

Sending
Job
Notifications
to
Slack
Silverstack, Silverstack XT and Silverstack Lab allow to transmit all notifications appearing in the macOS notification center also to a connected Slack
channel.

How
to
Connect
Silverstack
to
Slack

You can connect Silverstack to Slack executing all steps directly in Silverstack:

1. In the application preferences select the “Accounts” tab
2. Via the “+” button on the left side select “Add Slack Notifications…”
3. A browser sheet opens where you can log in to your Slack workspace

1. Add your workspace
2. Enter credentials
3. Select Slack channel or private message conversation to send notifications from Silverstack to

4. You successfully connected your Silverstack project to Slack
1. You can see the Slack app “Pomfort Notifier” appear in the Slack workspace in the section “Apps”

2. 

Slack notifications set up in the Silverstack “Accounts” tab of the preferences

Available
Actions

Send
a
Test
Message
Via the button “Send Test Message” you can send a test text to the connected channel to verify the working connection
This action sends the following string: “Test message from Silverstack Lab.”

Enable/disable
sending
permissions
globally
or
per
project
You can choose to

Enable notifications for all projects
Enable notifications for the current project

By default only sending for the current project is enabled

Notifications

After a successful connection, all notifications that are appearing on macOS will also be sent to the connected Slack channel. The notification
messages to Slack include extended information.

Notifications are available for all job types in Silverstack:

Offload Jobs
Copy Jobs
Transcoding Jobs
Verify Jobs
Upload Jobs
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Relink Jobs

Basic Information (also in macOS notification):

Application Name
Job Type
Complete (successful) / Failed
File count and successful/failed files

Extend Information (included in message to Slack):

Source Card name / Folder name
Destination drive name
Start date of job
Machine Name (Host Name)

Here are two examples of messages sent to Slack for an offload and a transcoding job:

 

Library
Backups
Silverstack allows to enable an automatic backup of its library in the “Backups” tab of the application preferences.

Options

Select how many last regular backups should be stored
2
5
20

Available backup types:
regular: Automatic Backup
manual: Manual Backup (created with button “+”)
pre
restore: Created automatically before a restore is triggered

Restore
a
Library
Backup

There are situations where your system is not capable any more of correctly saving the latest changes to the Silverstack library database.
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This is usually related to a more general system problem. When this case occurs the Silverstack library can become corrupted and Silverstack helps
you to restore the latest available backup:

Troubleshooting

If you should have any issues in the process of restoring a library backup please get in touch with support@pomfort.com .

We always recommend to keep a Time Machine backup of your system disk, so you can also always access older backups.
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How
to
Manually
Restore
a
Silverstack
Library
Backup

1. Locate the project
folder of the project you want to restore
Either reveal the project folder of your currently selected project through Silverstack’s main menu bar: Silverstack
[Lab]>Show
Library
in
Finder
Or, in case you need to navigate to the project folder manually:

1. Close
Silverstack
2. Open Finder, select Go>Go
To
Folder…
3. Paste the project folder root path:

Silverstack and Silverstack XT (8.x.x) projects are located in the hidden folder ~/Library/Application
Support/Pomfort/Silverstack8
Silverstack Lab (8.x.x) projects are located in ~/Library/Application	Support/Pomfort/SilverstackLab8

4. Find the project that you want to restore:
Each project has its own folder named  Project-[uniqueIdentifier]
The project folder that was changed most recently has the most recent Date
Modified timestamp in Finder
To make sure you navigated to the correct project folder, check its Project.plist file in a text editor, it contains project
information, including the project’s name

2. Locate the backup
files
In each project folder, there is a sub folder Backup, that contains backup snapshots of your project library

3. Unzip the most recent backup snapshot and rename it to Silverstack.psdb
4. Close
Silverstack
5. Replace your current library database with the backup

1. In the project folder rename the file Silverstack.psdb to _old_Silverstack.psdb (keep the original database file for safety reasons)
2. Copy the unzipped and renamed backup file Silverstack.psdb from the backup folder to the project folder’s top level [where you just

renamed the original file project database to  _old_Silverstack.psdb]
6. Start Silverstack

 

Localization
Silverstack offers to switch the language of the user interface in the “General” tab of the application preferences.

The following languages are available for Silverstack, Silverstack XT and Silverstack Lab:

English
Japanese
Chinese

In addition you can choose the option:

Auto

When set to “Auto”, the language is selected according to the language of the operating system.

In order to change the language of the user interface, the software will need to quit and restart.

Setting
Up
Stream
Deck
in
Silverstack
Silverstack Lab integrates with Elgato Stream Deck so that you can map Silverstack actions using the Stream Deck app and trigger those actions from
your Stream Deck USB controllers.

Once you have installed Elgato’s latest Stream Deck app, install the Stream Deck plugin in Silverstack Lab by choosing “Install Stream Deck Plugin…”
from the “Silverstack Lab” Menu.
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The Silverstack Lab Stream Deck Plugin has pre-defined profiles for Stream Deck devices of different sizes. For the Stream Deck XL, the first page
consists of controls to navigate through the library and trigger frequent actions like offloads, reports, and backups; The second page focuses on
playback controls and QC.

 

Special
Actions

Any action from Silverstack Lab’s main menu is available for mapping in the Stream Deck app. Some additional actions are specifically designed to
control Silverstack Lab with a Stream Deck device even more conveniently:

Quick
Offload
(last
mounted
volume)
The button shows the name of the volume that was last mounted. One keypress opens the offload wizard for the indicated volume, and a second
press on the same button will trigger the offload with default configuration.
Quick
Transcoding,
Report
and
Backup
Like the quick offload button, those actions allow you to open and step through the wizards with the same button. No additional mouse or
keyboard interaction is required to trigger the indicated action with the default configuration.
Navigate
Folders
(customizable)
This action is for navigating through the library tree. Yiz can configured it to

directly jump to the newest
media
bin in the library (the one that was offloaded last)
to the previous
or
next
folder or
to a parent
or
subfolder.
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Navigate
Clips
(customizable)
It can be set to jump to the next or previous clip in the library (e.g., to check different metadata in the General Info panel). For convenient
navigation during
playback, we recommend the (orange) buttons in the Playback section.

Your
Feedback

Let us know how you use your Stream Deck device to control Silverstack Lab and what further actions we should add next for even smoother
workflows. We’re looking forward to receiving your feedback at support@pomfort.com.
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Dailies Creation
How
to
Automatically
Sync
Audio
Based
on
Timecode
in
Silverstack
Lab

Overview

In a scenario where audio is recorded separately of the image it is common to use a collective timecode to later sync the audio clips to the video clips.
Silverstack Lab enables you to perform this automatic sync operation. Therefore the following steps have to be executed:

1. Ingest the video clips and the audio clips separately into Silverstack Lab
2. Open the “Audio Sync” wizard to start the sync process
3. Open the player and audio panel to playback clips with audio that has been connected to the video clips

Getting
Video
Clips
and
Audio
Clips
into
Silverstack

Please refer to the article Parallel Offloading to learn how to offload media in Silverstack. Alternatively you can read Adding Clips to the Library (Ingest
without Copy) if you only want to register footage and audio.

It is important to register the audio Broadcast Wave files separately from the video files into a separate bin. When you ingest a folder containing audio
files Silverstack Lab will automatically detect the format:

Fig. 1: Automatic detection of audio files in the offload wizard

Please refer to the article Audio Clips in Silverstack to learn more about the handling of audio in Silverstack.

After registering your video clips and the according audio files your library should look similar to this:

Fig. 2: A library structure with video and audio bins
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Automatic
Audio
Sync

Select the video bin or folder you want to sync audio clips to.

Access the audio panel that shows in the lower center of the interface either by clicking the “Audio&Color” button in the toolbar or by going to the
“QC” UI Layout:

Fig. 3: Access the Audio&Color panel

 

Now start the audio sync wizard. You can do that by clicking on the “Sync Audio…” button in the header bar of the audio panel:

Fig. 4: The “Sync Audio” button

Alternatively you can access the audio sync wizard from the “Media” button in the toolbar or the context menu of a bin or a selection of bins.

In the upper section of the audio sync wizard you can choose the location of your audio that should be synced with the video:

Fig. 5: Select the right audio bin according to your video bin

The wizard will now show you the video clips on the left side and the according audio clips on the right side:

Fig. 6: The audio sync wizard shows the matching video and audio clips

The wizard shows two checkboxes which grant you the following options:

The enablement of the checkbox “Hide
already
synced
video
clips” will exclude all video clips from the display in the list view that already have
external audio. If the checkbox is disabled the video clips that already have external audio attached will be shown in red letters.
The checkbox “Replace
Slate
Info
of
synced
Video
Clips
with
Slate
Info
from
Audio
Clips” will take over the slate info from the metadata of
the audio clips to the video clips. That includes scene, shot and take information.

In case of an error the audio sync wizard gives you detailed information about the status of all involved media in the “Learn
More…” panel. Click the
“Learn
More…” button at the right end of the information stripe to access the details:
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Fig. 7: Audio sync wizard with non matching items and the “Learn More..” panel opened

The window defines in detail:

All video clips that do not sync to any audio clip
All selected audio clips that do not sync with a video clip
All video and audio clips that have duplicate matches

After completing the process go ahead and click “Sync” to execute the audio sync as displayed in the wizard.

Completed
Sync
and
Review
of
External
Audio
in
the
Audio
Panel

After the sync is executed the external audio clips appear in the audio panel in the lower center of the user interface:

Fig. 8: Player and opened audio panel with external audio
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You will be able to check the sync by playing back the video clip in the player.

Audio
Details
&
Options

After you’re done with the audio sync process the global audio clip options in the audio panel enable you to:

Reveal
Audio
Details: The audio details panel for external track allows to zoom into the waveform for a visual sync check.
Slip
Audio: Slip external audio tracks to adapt for audio/video offsets.
Re-Sync
Audio: Re-sync single audio clips or all audio clips in a bin again.
Transfer
“Audio
TC
offsets”: Transfer Audio TC Offsets to other timecode-synced audio clips. The “Audio
TC
offsets” describe the offset of an
external audio clip to its TC synced position.
Lock
Audio
Tracks: Lock single audio clips to save them from being altered.
Transfer
Mix
Settings: Apply a mix to all audio clips in a bin.
Remove
External
Tracks: remove single external audio clips or all external audio clips in a bin or selection.

Here’s an overview of the audio panel and where to find the most important functionalities:

Fig. 9: Global Audio Clip Options

Here are the details for the different functionalities:

Audio
Details
with
Waveform
Zoom

You can open the audio details with the “Audio Details” button in the toolbar of the audio panel.

It reveals the audio details panel:

It offers the following functionalities and controls (see screenshot above for references):
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1. Slip
buttons: The slip buttons allow to slip audio to the left or right relative to the video to compensate for audio offsets.
2. Frame
selection
for
audio
slip: You can select the amount of frames to slip from the dropdown. It will affect the slip quantity when pressing the

slip buttons.
3. Audio
Details/Close: Reveals and conceals the audio details
4. Audio
Track: Select the audio track to be displayed from the pop up menu
5. Audio
TC
Offset: Specified the offset between the identical audio and video timecode. The offset is displayed in TC and its equivalent in

seconds.
6. Re-Sync: Click the re-sync button to re-sync audio and video by timecode. By its nature this resets the Audio TC Offset.
7. VTC
and
ATC: Shows the current Video TC (VTC) and Audio TC (ATC) at the current frame position.
8. Set
Audio
Slate
Marker: Sets an audio slate marker at the current playhead position to manually sync audio and video based on slate positions.
9. Set
Video
Slate
Marker:
Sets a video slate marker at the current playhead position to manually sync audio and video based on slate positions.

10. Detail
Area
and
Playhead: The white rectangle shows the zoomed waveform below covers.
11. Timeline
Rulers
Video
&
Audio: The video TC ruler shows in pink and the audio TC ruler shows in blue below.
12. Zoom
In
and
Out
Buttons: You can zoom in and out of the waveform with the + and – buttons .
13. Amplify
Slider: With the slider on the right you can amplify the height of the waveform.

You can drag the playhead around with the mouse to change the inspected area.

Slipping
of
External
Audio
Tracks

External audio clips that have been synced via TC can easily be slipped frame-wise to each side to alter their position relatively to the video clip. The
slipping position is stored in timecode format in the “Audio
TC
Offsets” field, viewable in the General Info, and describes the offset of the audio clip
from its sync position (sync position: where the audio timecode equals the video timecode).

Indication I in fig. 9 shows the buttons that can be used to slip the audio one frame to the left or right proportional to the video track. This will basically
alter the “Audio
TC
Offset” (see V in fig. 9) for the external audio clip. The “Audio
TC
Offsets” are also available in the “Edit” section of the General
Info and can be exported to reports and as metadata for source video clips and transcoded clips.

Transfer
Offsets
to
Other
Timecode-Synced
Clips

To apply an Audio TC Offset to other clips go to the gear menu on the right of the audio header bar (see II in fig. 9) and from the menu (see fig. 10)
select “Apply
Offset
to
All
Timecode-Synced
Clips
(Entire
Bin)” to apply the offset to all clips in the bin or select “Apply
Offset
to
All
Timecode-
Synced
Clips
(Selected
Clips)”
to apply it to a selection of clips.

Fig. 10: The audio panel gear menu

Re-Sync
External
Audio

Timecode-synced external audio clips can easily be re-synced again by selecting “Re-Sync
Audio
(Entire
Bin)” or “Re-Sync
Audio
(Selected
Clips)”
from the gear menu opening from the button indicated in II in fig. 9 and shown in fig. 10.

This functionality will basically reset the Audio TC Offset that has been applied with the slipping procedure described above.

Single timecode-synced external audio clips can also be re-synced from the gear menu of the external audio clip:

Fig. 11: The gear menu for a single external audio clip

 

Lock/Unlock
External
Audio
Clips

You can lock and unlock external audio clips of a selection of clips or for all clips in a bin by selecting “Lock/Unlock
All
External
Audio
Clips
(Entire
Bin)” or “Lock/Unlock
All
External
Audio
Clips
(Selected
Clips)” in the gear menu (see fig. 10).

The locking prevents the following actions:

Removal of external audio clips
Slipping of external audio clips
Application of Audio TC Offsets
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Re-Sync of timecode-synced external audio clips
Application of a mix

To lock a single external audio clip you can click the lock icon that also indicates the locking status of the audio clip (see also III in fig. 9):

Fig. 12: A locked external audio clip

Fig. 13: An unlocked external audio clip

Apply
Mix
to
All
Clips
in
Bin

To apply the mix for the current clip to all video clips in the bin select “Apply
Mix
to
All
Clips
in
Bin” from the gear menu (see II in fig.9 and fig. 10).
The mix consists of

Channel volume
Channel mute setting
Channel routing

The transmission of the settings bases on the audio track names. That means that the audio settings will be taken over to channels with the same
name in other audio clips.

Remove
External
Audio
Clips

You can remove external audio clips from an entire bin of video clips or from selected video clips by selecting the entries “Remove
All
External
Audio
Clips
(Entire
Bin)” or “Remove
All
External
Audio
Clips
(Selected
Clips)”
(see fig.10).

Single external audio clips can be removed by clicking on the gear menu in the header bar of the external audio clip (see IV in fig. 9 and fig. 11).

Additional
Functionality

Additional functionality for the external audio clips involves (see fig. 11):

Reveal: Reveals the audio clip in its audio bin.
Mid/Side: Select the channels that should be used for mid/side stereophony.

Timecode-Synced
vs.
Manually
Synced
External
Audio
Clips

Silverstack Lab generally differs between a sync by TC and a manual sync via slate positions. While you can slip both types of external audio with the
slip buttons (see I, fig.9) some functionality is not available for manually synced clips like e.g. applying a Audio TC Offset of a manually synced audio
clip to other audio clips.

When an external audio clip has been synced via timecode you can easily transition to a manual sync via slate markers that can be set in the audio
track popover. To return to an automatic sync just re-sync the audio clip as described above (see fig. 10 or fig. 11).

Learn more about manual audio sync in the article How to Manually Sync Audio in Silverstack XT and Silverstack Lab and more about Audio Clips in
Silverstack here.

Audible
Frame
Stepping

When stepping through a video clip with audio frame by frame with the arrow keys you will be able to hear audio for every frame.
To deactivate audible frame stepping go to the “Playback” menu in the Main Menu and deselect “Audible
Frame
Stepping”

Adding
Audio
Clips
Manually
that
Qualify
for
Timecode
Sync

If you add audio clips manually that have timecode in common with the current video clip you have the option to sync them automatically by timecode:
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Fig. 14: Add an external audio clip manually and sync it by TC

 

You can either choose to sync the audio clip based on TC or leave the checkbox empty to sync based on slate positions in the audio and video clip.

Tags: audio details, waveform zoom, slip audio, adjust audio, zoom audio

Transcoding
in
Silverstack
Lab

Individual
Clip
vs
Combined
Clips
Transcoding

Silverstack Lab offers two different basic transcoding options:

The two main transcoding options in Silverstack Lab

Individual
Clips
(one
file
per
clip):
The Individual Clips “standard” transcoding option creates one transcoded clip per source clip.
Combined
Clip
(single
file
with
multiple
clips):
The Combined Clip transcoding option is able to create one transcoded clip for multiple source
clips.

The Combined
Clip transcoding option has
restrictions compared to the “standard”
Individual
Clips option. Please refer to the article Combined
Clip Transcoding in Silverstack Lab to learn more about this special transcoding option.

Continue with this article below to learn more about the standard case of transcoding to individual
clips.

Transcoding
Configuration
vs
Starting
a
Transcoding
Job

Silverstack Lab separates the configuration of the transcoding settings from the actual starting of a transcoding job:

The section “Transcoding
Configurations” will explain how to adjust the settings for your transcoding job.
The section “Starting
a
Transcoding
Job”
 will explain how to execute a transcoding job.

Transcoding
Configurations

The transcoding settings can be found in the transcoding tab of the right bar. Click the transcoding icon  to access the transcoding tab:
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Configure the transcoding settings in the transcoding tab of the right sidebar

The upper part of the transcoding tab shows the custom transcoding configurations. The lower part shows the detailed settings for the selected
configuration. The settings will be applied and stored to the configurations immediately.

Locking
Transcoding
Configurations

Locking transcoding configurations

Transcoding configurations can be locked to avoid changes to them by clicking the lock icon on the right side of the “Settings” header bar. Locked
configurations will be shown with a white lock icon in the table*.

Transcoding
Settings
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Audio
&
Video

Video

Codec: Select the output codec depending on your requirements. There are different options available (also shown in Fig. 3):
H.264
H.265 / HEVC  (available starting from macOS 10.13)
ProRes 4444
ProRes 422
ProRes 422 (HQ)
ProRes 422 (Proxy)
DNxHD LB 1080p 36 8-bit
DNxHD SQ 1080p 145/120/115 8-bit
DNxHD HQ 1080p 145/120/115 8-bit
DNxHD HQX 1080p 220/185/175  10-bit
DNxHD SQ 720p 145/120/75/60 8-bit
DNxHD HQ 720p 220/185/110/90 8-bit
DNxHD HQX 720p 220/185/110/90 10-bit
DNxHR LB 8-bit
DNxHR SQ 8-bit
DNxHR HQ 8-bit
DNxHR HQX 10-bit

 

Fig. 3: Available transcoding options

Container: Select the container for the file. The following options are available:
Quicktime
(.mov): Available for all codecs  (ProRes, H.264, HEVC and DNx codecs)
MXF
OP-Atom
(.mxf): Available for DNx codecs.
MP4
(.MP4): Available for H.264 and HEVC codecs.

Size
(for
H.264
and
ProRes):
This drop down menu allows you to select the final resolution of the transcoded clips:

Fig. 4: Available frame sizes

H.264
Bitrate
Options:
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Fig. 4b: The H.264 bitrate calculator

The H.264 manual bitrate options allow you to enter a specific
bitrate
in
the
textfield or provide help for a
choice
of
quality
in
the
“H.264
bitrate
calculator” (see fig. 4b).

The bitrate calculator lets you choose the intended quality from “poor”
through
“good”
to
“best” and calculates the resulting bitrate based on the
selected resolution and the intended frame rate.

Duration
(Limit
to
In/Out
points): By enabling this option Silverstack only transcodes the part of the clip between the in and out points set in
the library.

Audio

Tick the checkbox to include audio in your transcoded clips.

Format:
Linear PCM (48000 Hz, 24 bit)
ACC – Good Quality *
ACC – High Quality *

Channel
Layout:
All
Tracks: All available audio tracks (separate tracks, no mute/solo/level taken into account) **
All
Tracks
(Skip
Muted
Tracks):
Transcodes
all available audio tracks but includes neither muted audio tracks nor muted audio clips. **
Stereo
Mixdown: The custom audio mix created in the audio panel

Source

Many source formats allow lower-quality decoding to speed up the decoding process (e.g., ⅛ resolution decoding) or extra high-quality modes for the
best image quality results. You can manually configure your preferred decoding resolution in the transcoding presets’ source section. If the preferred
decoding resolution is not available for the source format that is to be transcoded, the next best available mode will be used (e.g.,
Sony
X-OCN
does
not
support
the
⅛
res.
decoding
mode
→
transcoding
will
automatically
switch
to
¼
res.
decoding).

Selection of the preferred decoding resolution
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Per default, Silverstack is configured to use the “Auto Select” mode, which automatically chooses the preferred decoding resolution for each
transcoding task individually, based on the source resolution and the target resolution (e.g.,
source
resolution
8k,
target
resolution
2k
→
automatically
chooses
“¼
res.
decoding”

–
if
supported
for
source
format). Some non-RAW formats implicitly decrease color bit depth when using lower decoding
resolutions. To prevent this behavior, the “Always use full color depth decoding” option automatically forces full resolution decoding in those
situations.

“Auto Select” mode and full color depth option

It is possible to check the transcoding quality parameters that were actually used for each transcoding task in the “Task Details” section of the job
view.

Compositing

Resizing:
 Fitting
Strategy:

The zoom
to
fit
(Adding
black
bars/Without
black
bars) option will adjust the horizontal resolution of the clip to fit in the selected final
size.
Zoom
to
fill will affect the vertical resolution of the footage to the final size, cropping the sides.
1
to
1 will zoom the footage to 100% in the center of the image to adjust to the final selected size, cropping everything else.

Resizing example results

Grading:

Look
Source: Choose how to manage the color data for the clip:

As
set
in
Library: enable this setting to include the looks applied to the clip in the Library. For more information on how to apply looks,
please check the article The Silverstack Look Library.
None: Disables the color processing and transcodes the clips unmodified (as recorded).
From
file: Reads the clip metadata and applies the color processing described in the embedded looks. In case there is no look
embedded, Silverstack applies the default Log to Rec.709 conversion for the specific format.

 

Frame
lines:
You can enter a custom aspect ratio to apply it as frame lines to the transcoded clips. Additionally, choose from different
appearances in the “Appearance” dropdown.

Enter a custom aspect ratio in the combo box

All entered aspect
ratios
will
be
saved in the dropdown and sorted in alphabetical order:
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The list of custom aspect ratios

Comments to the aspect ratios can be added in brackets after the aspect ratio (see example “2,39:1 (Cinemascope)”).

The list of aspect ratios is shared between all three places in Silverstack Lab where aspect ratios can be set: In the transcoding configurations (as
explained here), in Crop, and in the Visual Controls for framing assistance.

Overlays

Burn
Ins:
Choose from different options to burn in metadata in the transcoded clip:

Burn in options

Note:
The «Custom Text» burn in option (Silverstack Lab only) allows to add metadata wildcards into the custom text field. For instance, it’s possible to
display «Scene: [scene value]-[shot value]» as shown in the following figure by writing «Scene: $scene$-$shot$» in the custom text field.

Find a list of all available keys in the article Custom Burn-In Wildcard Keys.

Custom text wildcards for metadata burn ins

Burn
in
Parameters:
The following parameters can be adjusted for the burn ins:
Margins: A horizontal and vertical margin to position the burn ins in the frame.
Font: Sets the font style for the burn ins.
Font
Size: Sets the font size in pt.
Transparency: Sets the transparency level for the burn ins.
Text
Color: Sets the text color to “White” or “Black”
Background: Sets the background to a “Box” shape or adds an “Outline” to the text.

 

Image
Overlay:
Choose an image overlay (.png, .jpg, .tiff) to be burned into the transcoded clips.
 Overlay parameters:

Size: Sets the size of the image (0 -100 %)
Position X: Sets the position in horizontal direction
Position Y: Sets the position in vertical direction
Transparency: Sets the transparence (0 – 100 %)

Metadata
Export

Choose a target application to automatically export a metadata file to transfer detailed clip information to different 3rd party systems.

Choose from the following export tools and formats:

Adobe Premiere Pro  (.XML)
AVID Media Composer (.ALE)
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Final Cut Pro 7 (.XML)
Final Cut Pro X (.FCPXML)
COPRA Dailies System (.XML)
Pomfort XML Metadata (.XML)

Select the destination tool and click the “Configure…” button to define the detailed settings for the metadata file export. Click the links to the tools
above to learn more about the configuration of the metadata exports.

The
Transcoding
Preview

When the transcoding tab in the right bar is showing Silverstack automatically switches to a transcoding preview to be shown in the playback view:

The transcoding preview

The transcoding preview displays a preview of the transcoding configurations applied to the currently selected clip.

Starting
a
Transcoding
Job

The «Transcode» button

 

In order to start transcoding the clips, first select a folder or bin in the Library panel. Then click on Transcode to open the wizard. There you will be able
to select the clips you want to transcode. Click on continue to select the destination and transcode settings.
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Clip selection wizard

 

Now you are able to select where the transcoded clips will be stored. You can add and remove destinations by using the «+» and «-» buttons.
Alternatively, it’s also possible to modify each destination path and path wildcards. You can select from the configurations previously configured in the
transcoding configurations tab:

The transcoding destination step

Click the current configuration to open the list of all available transcoding configurations:
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The transcoding configurations dropdown

When the checkbox “Add to Library” is checked the transcoded clips will automatically be ingested into the Silverstack Lab Library after the
transcoding job is done. Transcoding statistics will be available for the clips in the statistics view.

Click “Start
Render
Job” to start the render job. It can then be traced in the jobs panel.

Path
Wildcards
for
Transcode
Destinations

Path Wildcards can be used to customize the transcoding path with available metadata. Click the “Path
wildcard” icon in the status bar (see fig. 13) to
access the path wildcards settings for the selected destination:

The path wildcard window

It is also possible to rename the transcoded clips by leaving out the “/” and optionally also adding a file extension. Here’s an example:

Path wildcards for transcoding destinations

Hint:
It is also possible to copy and paste path wildcards like plain text.
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Multi
Destination
Transcoding

Silverstack Lab is able to transcode to multiple destination formats at a time. In certain cases (see below), the transcoding of the configurations has to
be run sequentially. The transcoding wizard will give you a hint if the transcoding will be run in parallel or sequentially:

The info message about parallel or sequential transcoding

In case of sequential transcoding you can open the “Learn More” panel to get details about the transcoding order.

The following settings can influence the parallel execution of the transcoding job:

In/Out Points
Debayer settings
Decoding resolution

Make sure to set the above settings to the same value when transcoding to two different configurations to avoid sequential transcoding.

Management
of
Transcoding
and
Offload
Jobs

Silverstack Lab is generally able to transcode and copy at the same time. Transcoding jobs as well as copy jobs run in the background while the app is
still fully accessible.

Optionally you can choose to pause transcoding jobs when offloading and while playing back clips. To do so go to the “Copy&Jobs” tab
in the
Preferences and select the according checkbox “Automatically
Interrupt
Transcoding
Jobs
during
Playback
and
Offload”:

The “Copy&Jobs” tab in the preferences

GPU
Selection

In the preferences tab “Copy&Jobs”
inside the “Transcoding” section you can select the preferred
GPU
for
transcoding.
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GPU Selection in the preferences

There are two options for the GPU selection:

Auto: This setting is the default setting and uses the system default GPU.
Manual: In this setting you can select the GPUs to be used from the available GPUs in the table (see screenshot above). If no GPU is selected or
found, the usage falls back to the system default (like setting “Auto”)

eGPU
Support

Silverstack Lab also supports eGPUs (external GPUs) that can be attached to the machine the application is running on. Properly attached and
installed eGPUs will show in the table when choosing the “Manual” GPU selection.

To setup the eGPU follow these steps:

Connect the eGPU while Silverstack isn’t active
Select GPU selection “Manual” and the preferred GPUs in the preferences
In case the eGPU isn’t used, please switch to internal GPU and back to eGPU in the preferences.

During an active transcode job you can check usage and workload of CPU and GPU via the OS X activity monitor. This helps to test your setup and
current settings.

eGPUs can provide speed advantages for formats that require a lot of GPU work. Please be aware that while some transcoding tasks could be faster
using an eGPU, other tasks/formats could suffer in speed. This heavily depends on source formats and transcoding configurations.

Transcoding
Functionalities
Overview
for
Silverstack
Lab

Multi Destination Transcoding
Many custom transcoding preset
All available burn in options
Watermarking
Transcoding resolutions higher than Full HD (1920 x 1080)
Transcoding statistics
Separate
audio
channels
in
transcoded
clip
Transcoding
to
DNx
codecs
(MXF,
OP-Atom)
Use
of
multiple
GPUs
for
transcoding
Frame
lines
burn-in
for
transcoded
clips
Automatic
metadata
companion
file
export

 

*Only available for ProRes and H.264

** Not available for AAC audio codecs

 

Keywords: dnx36, transcoding, dnx, AAF
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Search Code: SL-T17

Combined
Clip
Transcoding
in
Silverstack
Lab
With Combined Clip transcoding, Silverstack Lab can transcode multiple source clips to one single combined transcoded clip. This allows to create
combined clips for complete scenes or more.

To learn more about the “standard” Individual Clips transcoding option please refer to the article Transcoding in Silverstack Lab.

Starting
a
Combined
Clip
Transcoding
Job

Start the Combined Clip transcoding by clicking on the “Transcode” button in the toolbar and choose “Combined
Clip
(single
file
with
multiple
clips)”:

Fig. 1: Start the Combined Clip transcoding

Clips
Order
Selection
in
the
Source
Selection
Step

This will open the source selection step:

Fig. 2: The source selection step indicating the order of clips

Please be aware that the
order
of
clips
in
the
source
selection
step
reflects
the
order
of
clips
in
the
combined
transcoded
clip. You can change
the order by resorting the table columns.

Click “Continue”.

Combined
Clip
Transcoding
Settings

Choose your transcoding settings:

Fig.3: Choose the transcode settings for the combined clip
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Choose your transcoding preset from the transcoding configuration presets that you have created.

Select the transcoding destination path. Click “Start
Render
Job” to start the transcoding job.

Restrictions
That
Apply
to
Combined
Clip
Transcoding

Please be aware that the following restrictions apply to Combined Clip transcoding (compared to Individual Clips transcoding):

Only H.264 and ProRes codecs can be used for combined clip transcoding
Stereo mixdown will automatically be chosen for audio encoding
The clips can not automatically be ingested into the library
No automatic metadata export available
Only one destination at a time
No path wildcard options

 

Custom
Burn
In
Wildcard
Keys
for
Silverstack
Lab
The «Custom Text» burn in option (Silverstack Lab only) allows to add metadata wildcards into the custom text field.

For instance, it’s possible to display «Scene: [scene value]-[shot value]» as shown in the following figure by writing «Scene: $scene$-$shot$» in the
custom text field.

Fig.1: Custom text setting in the burn in settings of transcoding configurations

Here are the keys that can be used ($[key]$) and the metadata they produce (“->”):

$shootingDate$      ->      shooting date in format “y-m-d”
$clipName$      ->      clip name of source clip
$projectName$      ->      project name
$rating$      ->      rating (1 to 5 stars)
$flagged$      ->      circled/flagged mark
$caption$      ->      caption metadata field (string)
$resolution$      ->      resolution of source clip
$take$      ->      take value
$comment$      ->      clip comment
$scene$      ->      scene
$camera$      ->      camera letter
$shootingTime$      ->      shooting time in format “h_m_s”
$codecName$      ->     source codec
$reelName$      ->      reel name
$shot$      ->      shot
$reelNameCharacters$      ->      the first characters of the reelname (example ARRI reelname: “A007R2VJ”; reelNameCharacters: “A007”)
$label$      ->      label name set in User Info tab
$asa$    ->    ASA
$whitepointKelvinString$     ->    Whitepoint
$whitepointCCShift$    -> Tint
$custom1$      -> Custom 1
$custom2$      -> Custom 2
$custom3$      -> Custom 3

Grid
and
Wipe
View
in
the
Player

While all Silverstack versions offer the single view playback mode, Silverstack XT and Silverstack Lab include the Grid
View and Silverstack Lab the
Wipe
View modes:

The Grid
View mode allows to display multiple
clips
side-by-side.
The Wipe
View mode lets you share the playback window between 2 clips, activating an adjustable splitting
slider in the image.

Both modes can be active
in
the
Silverstack
Player and on the HD-SDI
output.

The Grid View and Wipe View modes can be accessed from the view controls in the header bar of the Playback UI:
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View selection menu

Alternatively, you choose the different view modes from the ‘Playback’ Main Menu bar:

Playback Menu: Multi Clip Selection

The
Grid
View
Mode

Grid View playback mode

After accessing the Grid View you have to select multiple clips in the timeline to show them in the grid. This can be done with the usual macOS
modifier keys for multiple and continuous selection. Hold shift while clicking to select a range of clips and cmd to select and deselect single clips.

Timeline with three selected clips

The timeline in the previous screenshot shows a selection of three clips. The first clip (A006C009_160208_R2VJ) in bold white font is the primary
current clip. Editing metadata and adjusting the grade will affect the current clip only. It’s also marked in the image with a little white dot in the lower
left corner.

The current clip part of a selection can be changed by clicking
on
another
clip
of
the
selection
or
by
clicking
on
the
image
in
the
player. To
deselect clips from the selection, just hold the cmd key while clicking. Click a non selected clip to dissolve the selection.

The
Wipe
View
Mode
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Wipe View mode in the Player

The Wipe View playback mode enables users to accurately compare 2
clips side-by-side with the help of a slider. You can move the image splitter
(e.g. shown in “Left – Right” mode) by dragging it over the clips in the player.

In order to access the Wipe View, you have to select 2 clips in the timeline. This can be done with the usual macOS modifier keys for multiple and
continuous selection: Hold shift while clicking to select a range of 2 clips and cmd to select and deselect single clips.

Settings

There’s the possibility to switch the layout
of
the
clips, as well as flipping them, through the gear button in the view controls:

Wipe View Layout menu

In the reference options you can choose which compositing mode should be used for displaying the clips. Options are:

Left – Right
Right – Left
Top – Bottom
Bottom – Top
Flip (mirror vertically) the image for improved arrangement

The order of clips depends on the order in the timeline. “A” always refers to the first/left clip in the selection from left to right, “B” always to the
last/right clip in the selection.

Lightweight
Copy
of
Looks

The Grid View and Wipe View playback modes can be useful to reference and compare grades. Therefore it can be handy to easily copy grades. By
using  the Look library in the right bar looks can be easily created and applied to one or multiple clips. All necessary functionality can be found in the
“Look” menu of the Silverstack Main Menu:

Fig. 5: The “Look” menu with functionality to create and apply looks

Learn more about the Silverstack Look Library in the article The Silverstack Look Library.
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Grid
View
Functionality

per
Silverstack
Product
Version

The Grid View functionality differs for different Silverstack versions:

Silverstack: No Grid View available.
Silverstack
XT: Grid View limited to 2 clips.
Silverstack
Lab: Grid View limited to 12 clips (only due to performance reasons).

Wipe
View
Functionality

per
Silverstack
Product
Version

The wipe view is only available in Silverstack Lab.

Prepare
Editing
for
Avid
Media
Composer
working
with
Silverstack
Lab
This article provides an overview of the single steps of preparing proxy clips and metadata for editing in Avid Media Composer. It structures the two
main activities of transferring clips and then transferring metadata and references articles that cover the single topics in more detail.

Overview

1.  Create and Transfer Editing Proxies for Avid Media Composer with Silverstack Lab
1.1 Create Editing Proxies for Avid Media Composer

Create DNx (OP-Atom) MXF clips. Find more information on Transcoding in Silverstack Lab here.
Additionally you can create AAF
files that simplify the transfer workflow to Media Composer

1.2 Transfer: Ingest editing proxies into Avid Media Composer
2.  Transferring Metadata to Avid Media Composer

2.1 Transfer clip metadata to Media Composer
Export an ALE from Silverstack Lab that contains clip metadata to be transferred to Media Composer
Add metadata to the proxy clips in Avid Media Composer via the ALE

2.2 Transfer Color Metadata to Avid Media Composer also via the ALE

Take a look at the linked articles for more details.

Create
and
Transfer
Editing
Proxies
for
Avid
Media
Composer
with
Silverstack
Lab

Create
Editing
Proxies
in
Silverstack
Lab

Silverstack Lab allows to create DNxHD and DNxHR MXF clips (OP-Atom) that are optimized for editing in Avid Media Composer. Take a look at the
article Transcoding in Silverstack Lab to learn more about transcoding in Silverstack Lab.

Creating
AAF
files

By enabling the checkbox in the transcoding configuration settings you can additionally create AAF files that enable an easier ingest workflow for
Media Composer:

Fig. 1: Enable the checkbox “Create AAF” to create AAF files along with the MXF clips

Setting
the
Tape
Name
for
Matching
MXF
and
ALE

In order to make the matching of metadata from the ALE (Avid Log Exchange) file work, it is necessary to embed according metadata into the
transcoded MXF clips.

In Silverstack Lab this is done via the Metadata Export option of a transcoding configuration. Configuring the Avid Media Composer metadata export
as intended, not only makes sure that the ALE has the correct information to match it to the clips, but also influences the created DNx MXF clips to
contain the right information to match the ALE when imported in Media Composer.

To set this up first select the transcoding configuration in the right bar and in the settings section scroll down to the “Metadata Export” section:
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Fig.1: Make sure that “AVID Media Composer” is set as target application

Click the “Configure…” button to control the settings for the ALE export and the MXF:

Fig. 3: Set the intended matching option

In the “Match clips based on…” section you can choose the matching criteria that will influence both, the MXF and the ALE, to fit together.

When you export an ALE afterwards from the re-ingested transcoded bin manually, make sure to choose the same export settings in order to match it
to the created MXF files.
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Transfer
Editing
Proxies
to
Avid
Media
Composer

To transfer editing Proxies to Avid Media Composer you have to move the created MXFs into a certain folder on an external volume to be detected:

/Volumes/[YourVolume]/Avid MediaFiles/MXF/

In this directory you have to create numbered folders the MXF clips have to go into, so e.g.:

/Volumes/[YourVolume]/Avid MediaFiles/MXF/11
or 
/Volumes/[YourVolume]/Avid MediaFiles/MXF/12

Going forward there are multiple ways of ingesting the created proxy clips into Media Composer. You can either:

1. Drag & drop the created AAFs into a Media Composer Bin
2. Have Media Composer create an .mdb file in the MXF structure and drag & drop it into a Media Composer bin:

1. Open Avid Media Composer (AMC) and your project to have Media Composer detect the media
2. Go back to the ../MXF/11 folder in Finder and drag & drop “msmMMOB.mdb” into a bin in AMC

Find more information on how to create an ALE from Silverstack and import it into Media Composer to transfer metadata, in the article Transferring
Metadata to Avid Media Composer.

Transferring
Metadata
to
Avid
Media
Composer
To transfer clips and their corresponding metadata information from Silverstack to Avid Media Composer the following two steps have to be
performed:

Create an Avid Log Exchange (ALE) file containing the metadata of the relevant clips in Silverstack
The information from the ALE file has to be merged with available master clips in the Avid Media Composer.

Creation
of
an
ALE
file
in
Silverstack

1. Generating an ALE file can be done via the “Export” menu in Silverstack. Select the bin which contains the relevant clips, click on the “Export”
button in the toolbar of the Silverstack window and choose “Avid
Media
Composer
(ALE)”.

2. Thereon select the clips you want to transfer in the wizard that opens up.

3. In the following you have to select the ALE export options including: (see screenshot of options below).

Choose Project Format
Select additional detailed information in this section.
Set format of Scene-Take Export and Name
Check if you prefer lower case letters for “Camera”

4. The metadata is transferred to the Avid Media Composer via the ALE file and is only there matched with the clips. The matching can be
performed according to following metadata information:

Source File Name in Source File Column
Reel Name in Tape Column
Source File Name in Tape Column
Source File Name without File Extension in Tape Column
Video Clip Name in Tape Column

5. Click on “Save
ALE…”.
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The ALE export options.

 

Merging
information
from
the
ALE
file
with
master
clips

1. After having created the ALE file go to the Avid Media Composer and import the clips if not done so far. They should thereon be available as
master clips.

2. Select the bin in the Avid Media Composer which contains the relevant clips.
3. Select those clips and choose “Input
>
Import
Media…” from the context menu in the bin.
4. Open the “Options”, then click on “Options…” navigate to the Shot Log tab and select “Merge
events
with
known
master
clips”.
5. Navigate to the ALE file you created before and click “Open”.

Avid Media Composer now matches master clips and metadata information from the ALE file according to their timecode and the criteria you selected
during the transfer process within Silverstack .

The information from the ALE file is attached within additional columns in the bin table as in figure 2. Some of the columns are already known by the
Avid Media Composer, all unknown information will be added as custom columns.

Avid Media Composer: Extended metadata after the ALE import

If you cannot see any custom columns, perform the following steps:

1. Close and re-open the bin
2. Right-click in the free space of the bin window and click on “Choose
columns…” in the context menu.
3. Then select and unselect columns, the custom columns from the imported ALE file you will find at the end of the list.

Crop
Clips
Silverstack allows to crop clips to a custom aspect ratio. Cropping is non-destructive as long a crop setting is not used for transcoding.

Cropping can be set via the “Crop” popover in the General Info tab on the right side of the main window. Learn more about the right sidebar in the
article The Information Panel.

Crop
Clips
to
a
Custom
Aspect
Ratio

Go to the “General
Info” Tab and scroll down to the “Processing” section where you can find the “Crop” entry.

93

Silverstack	Lab	
Dailies	Creation



Fig. 1: Crop in the Processing section

Click the little grey button with the pencil to open the popover:

Fig. 2: The Crop popover in the General Info

Crop
Options

There are 3 tabs and therefore 2 crop options available:

Selecting “None” and clicking “Apply” will make sure to remove all crop settings from the selected clip.
Crop to an Aspect
Ratio
Crop to a Custom
Resolution

Crop
to
an
Aspect
Ratio

Fig.3

Select the second tab “Aspect Ratio” and enter a custom aspect ratio into the combo box or select one from the list of presets.

The by default available aspect ratios are:

4:3
16:9
1.85:1
2.39:1 (Cinemascope)
2:1
5:3 (1.66:1)

Crop
to
a
Custom
Resolution
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Fig.4

Select the third tab “Custom Resolution”.

The following controls are available:

1. Size: You can enter a custom pixel resolution to crop to. The specified pixel resolution will be cropped out by default from the center of the
image.

2. Aspect
Lock: You can lock the resolution to a certain ratio when changing horizontal or vertical size.
3. Recents: The gear menu shows recently used sizes for a quick selection
4. Offset: Specify a horizontal and vertical offset from the center cropped size
5. Quick
Offset
Buttons
&
Re-Center: The quick offset arrow keys enable a one-click shift of the cropped area to the respective image margins. If

an offset is entered the “0” button appears and helps to remove the offset to re-center the cropped area.
6. px/%
Switch: You can switch between specifying an custom crop resolution in pixels or percentage values.

Click “Apply” to crop the current image to the specified crop.

Source
and
Resulting
Resolution

The “Source
Resolution” and “Resulting
Resolution” give you information about the original and the resulting image resolution:

“Source
Resolution”: Native resolution of the clip. Also displayed in the General Info in the right tab under “Format
->
Resolution”
“Resulting
Resolution”: The cropped and/or desqueezed resolution.

The factors relevant for the calculation of the Resulting Resolution are displayed below (e.g. “Desqueeze (2.0) and Crop”).
The resulting percentage of the original image is displayed in brackets. The resulting aspect ratio follows.

Please be aware that the decoding resolutions of the player do not affect the calculations of resolutions in the “Crop” popover.

Highlighting
of
Cropped
Area
in
the
Playback
View

While setting the crop in the popover the area that will be cropped is highlighted in the playback view and updates live while changing crop settings.

Fig 5: The crop area shows in the image

 

Apply
Crop
to
Multiple
Clips

To apply a crop to two or more clips select multiple clips from the table view and open the “Crop” popover:
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Fig. 6: Multi edit for crop

 

The number of altered clips is displayed in the popover (see “Will edit 4 Clips” in Fig. 6) . Click “Apply” to apply the set crop factor to all selected clips.

 

Tags: crop, multi edit, multiedit, aspect ratio, custom resolution

Direct
Dailies
Upload
Silverstack Lab allows to upload clips to supported cloud platforms from its library. The functionality uses the known infrastructure for jobs (like e.g.
offload or transcoding jobs) in Silverstack Lab.

Supported
Cloud
Platforms

The following cloud platforms are supported for uploading clips:

Frame.io (covered in this article)
Webgate.io (covered in this article)
Ci Media Cloud (see the related KB article: Uploading Files to Sony’s Ci Media Cloud)
AWS S3 (see the related KB article: Uploading Files to Amazon AWS/S3)

You can register for trials via the websites of the cloud platform providers to attain the login credentials that are used.

First
Use:
Log
In
to
Your
Account
for
a
Platform

To start an upload for the first time follow these steps:

1. Select the bin or clips you want to upload in the library in the left bar
2. Open the”Media” menu and click the “Upload Clips” entry

“Upload Clips” in the Media menu
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3. Select the platform you want to upload to:

Select to upload to “Frame.Io” or “WebGate”
4. Enter your platform credentials in the browser sheet that opens. The connected accounts can be managed in the Accounts tab of the application

preferences (see also section “Accounts Tab in the Application Preferences” below).

Accounts
Tab
in
the
Application
Preferences

The Accounts tab in the application preferences allows to manage the connected accounts.

“Accounts” tab in the application preferences

You can add and remove a platform account using the “+” and “-” buttons.
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Removing
An
Account
Connection
Manually

The account logins are stored in the Keychain Access application on your Mac. In the unlikely event that an account is broken, you can remove it
manually.

Account can be removed by following these steps

Open the macOS Keychain Access Application
Search for items labeled Silverstack	Connected	[platform]	Account)

SST (with same name) that created it (see keychain item’s Access	Control-Tab) or
other named SSTs, when their name is added to the list in keychain item’s Access	Control-Tab

Open the context menu of the entry (with a right click) and then select “delete”

Start
the
Upload

After the wizard step that gives you the possibility to reselect the clips for the upload.  The clips list is restricted to “suitable” clips which means in
particular:

clips with the following file endings:
.mov
.mp4

clips that have at least one online resource

You can select where you want to upload the clips to the folder structure of the platform. This requires an individual selection that depends on the
platform:

Frame.io

Select:

Account
Team

Project
Folder

to upload clips to.

Webgate.io

98

Silverstack	Lab	
Dailies	Creation



Select:

Project
Folder

Playlist

to upload clips to.

In Webgate you can only upload clips to a playlist. Therefore it is also possible to create a playlist from Silverstack Lab that is then selected
automatically for the upload.

Upload
Job

After starting the upload the upload job can be monitored and managed in the jobs panel:

You can find more general information about managing jobs in the article Managing jobs in the jobs view
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Create
Reports
Including
Uploaded
Clips’
References

After the upload the remote resources are available in the Silverstack library at the following places:

1 – Remote resource card in the files tab of the right bar includes remote location and direct link to remote clip
2 – Column in table view “Remote Resources”

A clips report with the “Remote Resource” column shows a clickable link to the uploaded clip
3 – “With Remote Resource” in the “Workflow” table of the Project Overview

A shooting day report can include the “Workflow” summary that shows an overview of clips with looks, transcoded clips, clips with audio
and clips that have been uploaded

Find more general information about creating reports in Silverstack in the article Creating Reports.

Exporting
Clips
and
Metadata
for
the
COPRA
Dailies
System
Silverstack Lab can provide transcoded clips as well as metadata from its library in a compatible format for the COPRA Dailies System. In Silverstack
Lab you can export an XML file that accompanies the transcoded clips from Silverstack Lab and provides extended metadata. The proxy clips can
then be uploaded together with the XML to the COPRA platform where the additional metadata is then visible.

There are two ways in Silverstack Lab to export a COPRA compatible metadata XML file:

The automatic metadata export as part of the transcoding configuration can be set to automatically export a COPRA xml after the transcoding
job finishes and the transcoded clips are reingested into the library
The manual export can be reached from the “Export” menu in the toolbar and in the context menu of the bin. It allows to manually trigger the
export for the xml for the bin with already transcoded clips in the library

Exporting
a
COPRA
Compatible
XML
with
the
Automatic
Metadata
Export
Option

The metadata export option allows to automatically create a companion metadata file when a selected transcoding configuration is used for
transcoding clips.

You can learn more about Transcoding in Silverstack Lab in the equally titled article.

To set the COPRA Dailies System as target application for the automatic metadata export, first go to the transcoding configurations tab of the right
sidebar. Select the transcoding configuration from the list that you would like the export to happen for.

Fig. 1: Automatic Metadata Export configured for the transcoding configuration
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Scroll down to the “Metadata Export” section. Select “COPRA Dailies System” and press the “Configure…” button to select its content.

Fig.2: Configure the content of the COPRA XML

 

When now transcoding to the adapted configuration you selected the metadata export for, the COPRA XML is automatically exported to the same
folder as the clips after the job finishes and the transcoded clips are automatically ingested into the “Transcoded Clips” folder of the library.

Manual
Export
of
a
COPRA
Compatible
XML

To manually export a COPRA Compatible XML select the intended bin inside the “Transcoded Clips” folder and choose “COPRA Dailies System” from
the “Export” menu:

Fig.3 : Manually exporting a COPRA XML from a transcoded clips bin

The wizard leads you through the source selection (to select the clips that should be part of the XML) and the content selection (which metadata should
be part of the XML).

Click the “Save COPRA XML..” button to export the xml to the intended directory.

Preparing
Clips
and
Metadata
for
Webgate.io
Silverstack Lab can provide transcoded clips as well as metadata from its library in a compatible format for Webgate.io cloud services. In Silverstack
Lab you can export an ALE file that accompanies the transcoded clips and provides extended metadata to be available on the Webgate.io platform.
The proxy clips can be uploaded together with the ALE where the additional metadata is then available.

There are two ways in Silverstack Lab to export an Webgate.io compatible ALE:

Automatic: The automatic metadata export as part of the transcoding configuration can be set to automatically export a Webgate.io ALE after
the transcoding job finishes and the transcoded clips are reingested into the library
Manual: The manual export can be reached from the “Export” menu in the toolbar and in the context menu of the bin. It allows to manually
trigger the export for the ALE for the bin with already transcoded clips in the library
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Creating
an
Webgate.io
compatible
ALE
when
Transcoding

The automatic metadata export option allows to automatically create a companion metadata file when set up in a transcoding configuration that is used
for transcoding clips.

You can learn more about Transcoding in Silverstack Lab in the equally titled article.

To set Webgate.io as target application for the automatic metadata export, first go to the transcoding configurations tab of the right sidebar. Select the
transcoding configuration from the list that you would like the export to happen for.

Fig. 1: Automatic Metadata Export configured for the transcoding configuration

 

Scroll down to the “Metadata Export” section. Select “Webgate.io” and press the “Configure…” button to select its content.
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Fig.2: Configure the content of the Webgate.io ALE

When now transcoding to the adapted configuration you selected the metadata export for, the Webgate.io ALE is automatically exported to the same
folder as the clips after the job finishes and the transcoded clips are automatically ingested into the “Transcoded Clips” folder of the Silverstack library.

Manual
Export
of
an
Webgate.io
Compatible
ALE

To manually export an Webgate.io compatible ALE select the intended bin inside the “Transcoded Clips” folder and choose “Webgate.io” from the
“Export” menu:

Fig.3 : Manually exporting an Webgate.io ALE from a transcoded clips bin

The wizard leads you through the source selection (to select the clips that should be part of the ALE) and the content selection (which metadata should
be part of the ALE).

Click the “Save ALE…” button to export the ALE to the intended directory.

Supported
Structural
Metadata
of
Webgate.io

Some columns of the ALE file need to have a certain syntax to correctly translate the metadata into the structural metadata of Webgate.io. You can
read more about the metadata workflow for Webgate.io in their guide.

The following structural metadata is supported by the Silverstack Lab ALE:

Scene / Scene- Shot
Take
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Episode
Reel
Shoot Date
Circled Take / Good Take
Clip Comments
Start (Start TC)

All other metadata from the ALE will also be displayed in Webgate.io but does not form part of the structural metadata.

Upload
Metadata
to
Webgate.io

Use the “Add metadata (ALE)”  option to add metadata via an ALE to the selected playlist:

Upload the ALE to Webgate.IO

 

Find more details about uploading clips and the metadata workflow for Webgate.io in their guide.

Editing
Keyboard
Shortcuts
in
Silverstack

There are a variety of keyboard shortcuts available for commands in the main menu of Silverstack. Shortcuts can help greatly in boosting your
productivity.

Many shortcuts are already predefined. You can also set shortcuts for selected commands that you perform quite often and that do not hold default
shortcuts in order to memorize the interaction with Silverstack more easily.

To inspect the exact list of available keyboard shortcuts go to
 Silverstack > Keyboard
 Shortcuts…
. This will open the Keyboard Shortcuts
Editor (figure 1).

Figure 1: The Keyboard Shortcut Editor

Listing
and
Searching
Keyboard
Shortcuts

The keyboard shortcut editor shows a table with a list of all actions in the main menu and their currently set keyboard shortcut. You can search the list
by typing into the search bar on top of the table.
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Edit
Keyboard
Shortcuts

To edit a keyboard shortcut:

1. Select “Map
Keys” to allow changes on the key mapping list.

2. Choose the row with the command.

3. To set or modify a shortcut press the key or keys to use as the new keyboard shortcut. You can use modifiers, numbers, letters and characters
individually or in combination.

4. To  remove the associated shortcut permanently press ⌫ (delete / backspace) button.

5. Close the
Edit
Keyboard
Shortcuts window when you are done.

If you choose a shortcut already assigned to a command, a warning dialog box will be displayed that shows which command already used the chosen
shortcut.

Figure 2: Alert showing used keyboard shortcut

Select “Cancel” and choose another key for your current command, or select “Reassign” which removes the shortcut from the  old command and
sets it for the selected command (figure 2).

Restoring
Default
Keyboard
Shortcuts

You can reset all keyboard shortcuts to latest version default by clicking “Restore
Defaults…”.

Note
: Both
of
these
steps
executes
an
automatic
restart.
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Offload & Backup
Offload
Clips
Offloading is the process of adding clips or files to the Silverstack Project Library, while copying them from a camera, field recorder or storage device
to one or several backup drives. In order to make it possible you can follow these directions:

Prepare
for
Offloading

First of all you have to assign clips to a project. By default, clips are offloaded into the project currently selected. You can create a new project by using
the project selection menu on the top center of the main UI window.

Additionally, it’s possible to select a folder from the library tree on the left panel before starting. This way you will be able to set the folder on which the
bin containing the new clips will be placed within the Project Library. That bin will have the same name as the source volume storing the footage. In
case the current selection in the library tree is a bin, a new bin will be created as a sibling of the selected one.

Starting
the
Offload

 

Offload source selection

After mounting the storage device containing the clips that you’d like to offload, you have several options to start the offload process:

Click on the ‘Offload’ icon on the toolbar and select the volume you’d like to offload from.

Choose Library > ‘Offload’ from the Silverstack menu.

Right click on a folder or bin in the Project Library tree (left panel) and choose ‘Offload’ from the context menu.

Drag the folder or card from Finder onto Silverstack’s icon in the Dock window.

When using options #2 and #3, a Finder directory browser will open and you’ll need to select the volume or folder you’d like to offload from.

Offload
Wizard

The ‘Offload Wizard’ is the popup window that appears after choosing the Offload source. At this stage, Silverstack will try to automatically detect the
camera format by scanning the files. After scanning the chosen source drive, all found files will be shown in a table. If, in an exception, Silverstack
should not choose the right camera format, you can set the correct format by clicking on the ‘format selection button’. The import options for the
multiple camera types can be found and edited in the application preferences menu, under the Formats tab.

The Offload Wizard: the ‘Ingest and Create Thumbnails’ section
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Silverstack by default offloads all the clips and files contained in the scanned device. Additionally, if you just need to offload a subset of clips, you can
check the ‘Allow partial offload’ checkbox. Clips can be marked and unmarked either by using the checkboxes or the ‘mark’ and ‘unmark’ buttons by
the ‘search’ field. Therefore either select all clips you’d like to import and then click on ‘Mark Only Selected’ or select those clips of all already marked
that shall not be imported and click on ‘Unmark Selected’.

As you can see in the following image, there is a bunch of keyboard shortcuts for marking and unmarking clips to facilitate this task.

‘Allow partial offload’ mode keyboard shortcuts

Additionally, Silverstack is prospecting for duplicates (clips already existing in the Project Library) when scanning a source drive and prevents them
from being offloaded by default. If you need to include duplicates nonetheless, please enable the ‘Allow import of duplicates’ checkbox.

Sometimes Silverstack will skip some hidden files and empty folders during the copy process, as shown in the image below. If you click on ‘Learn
More’, a popup window will show which files are ignored.

‘Skipped Files’ warning

You are able modify this behavior in the application preferences menu, under the ‘Ingest’ section. In addition to the settings in the Preferences menu,
the following files are always ignored:

– Mac OS X resource fork files (starting with ._)

– MHL, MD 5 and SHA 1 files that have been created by Silverstack on previous copy tasks

When you are done with your offload source choice, you can proceed to add the copy destinations.

Setting
up
the
copy
destinations
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The Offload Wizard: the ‘Copy and Verify’ section

In this section you are able to choose the destination volumes to which Silverstack will copy the clips and files. To edit the import options, click on the
‘Edit’ button. The number of volumes that Silverstack can simultaneously offload to is only limited by your hardware.

Adding a new destination is done by pressing on the ‘+’ button on the lower left of the table. Click the ‘-‘ button next to it to if you’d like to remove the
selected destination drive.

In relation to the additional options under ‘Verification Behavior’ and ‘Checksum Method’, you can find a detailed description of each one of those
settings in the article The Copy and Verification Process in Silverstack: Verification Behavior.

Silverstack offers the possibility of saving offload wizard templates. These templates can be chosen through the drop down menu on the top right of
the Offload Wizard. For more information about the templates, please check the article Offload wizard templates.

For a detailed description of how the copy and verification process works in a cascading copy scenario (Silverstack XT and Lab), as well as other
available settings for this mode, please check the knowledge base article Cascading Copy.

There is also the possibility of using the Path Wildcards feature, which offers users a way to create custom folder structures based on the metadata
contained in clips.

A file renaming pattern can be selected to change the original file and clip names of selected camera devices during the offloading process. Check the
KB article File Renaming on Offload to get a detailed guide on how to use this feature.

Path
Wildcards

In the path wildcards window, the pull down menu button with the gear icon gives you the possibility to choose from recently used wildcards (see
screenshot below). To work efficiently with wildcard paths it is also possible to copy and paste a path from the wildcard window including wildcards
like regular text to and from a text document.
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Recently used wildcards options in the pull down menu.

By default the original folder structure of the source is maintained. However keep in mind that you are able to influence that behavior by using path
wildcards and can like this also dissolve the original folder structure on the destination.

Disk
Full

If the disk is full the copy and verify step of the offload wizard shows if the disk doesn’t have enough free space to copy to it. This is shown as below:

 

Starting
the
Copy
Process

After determining your copy destinations and settings, click on ‘Offload’ to register the clips to the library. Silverstack will ingest all the metadata from
the clips and create thumbnails for them. Once that process is complete, the copy and verification job is going to sart. All the information about the
offload process can be supervised in the Jobs panel.

Note: if you just need to create references to video clips in the Project Library and skip the copy and verification process altogether, please check
the knowledge base article Adding Clips to the Library (Ingest without Copy).

 

 

 

Cascading
Copy

Cascading Copy concept setup

 

The Cascading Copy offloading mode is designed to free up camera media storage as fast as possible. This can become convenient in working
environments with small amounts of camera storage devices or in situations with only one docking station and multiple camera storage devices that
have to be offloaded.
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Silverstack makes it possible in a single job by offloading the camera media first to a very fast destination (called ‘1st run’) and then to the slower
backup drives from the first fast destination (the ‘2nd run’) . Once the first run of the process is finished, the source camera media can be unmounted
and is ready to be used again while the second run copy&verification takes place.

 

Starting
to
offload

 

Offload source selection

After mounting the storage device containing the clips that you’d like to offload, you have several options to start the offload process:

Click on the ‘Offload’ icon on the toolbar and select the volume you’d like to offload from.

Choose Library > ‘Offload’ from the Silverstack menu.

Right click on a folder or bin in the Project Library tree (left panel) and choose ‘Offload’ from the context menu.

Drag the folder or card from Finder onto Silverstack’s icon in the Dock window.

When using options #2 and #3, a Finder directory browser will open and you’ll need to select the volume or folder you’d like to offload from.

Offload
Wizard

The ‘Offload Wizard’ is the popup window that appears after choosing the Offload source. At this stage, Silverstack will try to automatically detect the
camera format by scanning the files. After scanning the chosen source drive, all found files will be shown in a table. If, in an exception, Silverstack
should not choose the right camera format, you can set the correct format by clicking on the ‘format selection button’. The import options for the
multiple camera types can be found and edited in the application preferences menu, under the Formats tab.

The Offload Wizard: the ‘Ingest and Create Thumbnails’ section

 

Silverstack by default offloads all the clips and files contained in the scanned device. Additionally, if you just need to offload a subset of clips, you can
check the ‘Allow partial offload’ checkbox. Clips can be marked and unmarked either by using the checkboxes or the ‘mark’ and ‘unmark’ buttons by
the ‘search’ field. Therefore either select all clips you’d like to import and then click on ‘Mark Only Selected’ or select those clips of all already marked
that shall not be imported and click on ‘Unmark Selected’.

As you can see in the following image, there is a bunch of keyboard shortcuts for marking (#1) and unmarking (#2) clips to facilitate this task.
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‘Allow partial offload’ mode keyboard shortcuts

Additionally, Silverstack is prospecting for duplicates (clips already existing in the Project Library) when scanning a source drive and prevents them
from being offloaded by default. If you need to include duplicates nonetheless, please enable the ‘Allow import of duplicates’ checkbox.

Sometimes Silverstack will skip some hidden files and empty folders during the copy process, as shown in the image below. If you click on ‘Learn
More’, a popup window will show which files are ignored.

‘Skipped Files’ warning

You are able modify this behavior in the application preferences menu, under the ‘Ingest’ section. In addition to the settings in the Preferences menu,
the following files are always ignored:

– Mac OS X resource fork files (starting with ._)

– MHL, MD 5 and SHA 1 files that have been created by Silverstack on previous copy tasks

When you are done with your offload source choice, you can proceed to add the copy destinations.

Setting
up
the
copy
destinations

The Offload Wizard: the ‘Copy and Verify’ section

In this section you are able to choose the destination volumes to which Silverstack will copy the clips and files. To edit the import options, click on the
‘Edit’ button. The number of volumes that Silverstack can simultaneously offload to is only limited by your hardware.

Adding a new destination is done by pressing on the ‘+’ button on the lower left of the table. Click the ‘-‘ button next to it to if you’d like to remove the
selected destination drive.

Once all the drives have been added, you can select the order to which you’d like Silverstack to copy the clips to each drive. If ‘1st Run’ is selected,
the files will be copied to that drive first. If ‘2nd Run’ is selected, the files will be copied from the 1st Run source drive to the 2nd Run destination drive,
while the original source camera media can be unmounted and reused. For a detailed description of how the copy and verification process works in a
cascading copy scenario, as well as other available settings for this mode, please check the knowledge base article Cascading Copy Preferences.

In relation to the additional options under ‘Verification Behavior’ and ‘Checksum Method’, you can find a detailed description of each one of those
settings in the article The Copy and Verification Process in Silverstack: Verification Behavior.

There is also the possibility of using the Path Wildcards feature, which offers users a way to create custom folder structures based on the metadata
contained in clips.
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Additionally, Silverstack offers the possibility of saving offload wizard templates. These templates can be chosen through the drop down menu on the
top right of the Offload Wizard. For more information about the templates, please check the article Offload wizard templates.

Starting
the
copy
process

After determining your copy destinations and settings, click on ‘Offload’ to register the clips to the library. Silverstack will ingest all the metadata from
the clips and create thumbnails for them. Once that process is complete, the copy and verification job is going to sart. All the information about the
offload process can be supervised in the Jobs panel.

Note: if you just need to create references to video clips in the Project Library and skip the copy and verification process altogether, please check
the knowledge base article Adding Clips to the Library (Ingest without Copy).

 

 

Related articles:

Parallel offloading

Backup Clips

Analyzing and improving data-transfer performance

Checksum verification process

Cascading Copy Preferences

Offload
wizard
templates

The offload wizard templates feature is designed to speed up the offloading process by short-cutting the steps needed to select different
copy
destinations
and
settings. It allows you to save a series of presets that can be recalled for every offload, either automatically triggered by an
associated input device or
manually by selecting it from the list of templates. Templates can contain multiple copy destinations with different path
wildcards for each. Also, they can store further offload settings like checksum and verification methods and file renaming patterns.

Manage offload wizard templates in the gear menu on the top right of the wizard
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Creating
a
template

To start the creation of a template, open the offload wizard as usual. Once the wizard appears, you can select the copy destinations and optionally
also adjust the checksum and verifications settings, path wildcards, and file renaming patterns. After you have finished setting up the offload, click the
‘gear‘ button on the top right corner and select “Save as new Template…“. At this point, a dialogue opens to name the template and optionally
also
associate
it
with
an
input
device.

Name a new template and optionally associate it with an input device

Finally, click on “Create“ and the template will be saved.

Please Note: You can associate a template to only one input device. If you want more input devices to trigger the same offload settings, you need to
save the same settings in multiple templates and associate each with a desired input device.

Applying
templates

Once you have created a set of offload wizard templates, you can switch between them manually by clicking on the template name. An associated
template is automatically
applied once the offload wizard detects the linked input device or if you select the linked device from the input devices list.
Templates show their association with an input device through an arrow symbol (←) in the templates list.

Click on the template name to apply it, associated templates are marked with an arrow

 

Updating
a
template

If you need to modify an existing template, you can do so by selecting the new settings. Once a template has been edited, it is marked with an asterisk
(like “Template*“). If you want to save these changes, click the ‘gear‘ button on the top right corner and select “Update current Template“. Next, a
dialogue appears that also allows you to (optionally) rename the template or change the device association. Click “Update“, and the changes are
saved.

 

 

Backup
Clips
Silverstack offers the possibility to backup assets that already exist in your Project Library to additional backup drives. In order to start a backup job,
just choose the Folder or Bin you’d like to backup from the Project Library panel and then select the ‘Backup’ command in the ‘Media’ menu:
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Media Menu

 

Once the ‘Backup’ command is selected, the Backup Wizard launches:

Backup Wizard: Clip Selection

It’s possible to choose the copy source volume in case the files have multiple backups registered in the Project Library. Selecting the fastest source
volume generally increases the copy performance, depending on your hardware.

Silverstack by default copies all the clips and files contained in the Folder or Bin you previously selected to backup. If you just need to offload a subset
of clips, you can check the ‘Allow partial offload’ checkbox. Clips can be marked and unmarked either by using the checkboxes or the ‘mark’ and
‘unmark’ buttons by the ‘search’ field. Therefore either select all clips you’d like to import and then click on ‘Mark Only Selected’ or select those clips
of all already marked that shall not be imported and click on ‘Unmark Selected’.

As you can see in the following image, there is a bunch of keyboard shortcuts for marking (#1) and unmarking (#2) clips to facilitate this task.

‘Mark’ and ‘Unmark’ keyboard shortcuts

Once the source volume and the clips have been selected, you can press on ‘continue’, which leads to the Copy Destination Selection step:
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Backup Wizard: Copy Destination Volumes selection

 

In this section you are able to choose the destination volumes to which Silverstack will copy the clips and files. To edit the import options, click on the
‘Edit’ button. The number of volumes that Silverstack can simultaneously offload to is only limited by your hardware.

Adding a new destination is done by pressing on the ‘+’ button on the lower left of the table. Click on the ‘-‘ button next to it to if you’d like to remove
the selected destination drive.

In relation to the additional options under ‘Verification Behavior’ and ‘Checksum Method’, you can find a detailed description of each one of those
settings in the article The Copy and Verification Process in Silverstack: Verification Behavior.

There is also the possibility of using the Path Wildcards feature, which offers users a way to create custom folder structures based on the metadata
contained in clips.

After determining your copy destinations and settings, click on ‘Backup Files’ to start the copy process. All the information about the backup process
can be supervised in the Jobs panel.

Managing
Jobs
in
the
Jobs
View
The jobs view in Silverstack can be reached by clicking on “Jobs” in the lower left corner of the main window. The jobs view shows an overview and
extended details about every job that can be run in Silverstack.

In a Silverstack context the word “job” refers to copy and transcoding processes that Silverstack controls.

Overview

This article references all aspects of jobs in Silverstack including

Types
Queues
States
Actions

for and of jobs.

Job
Types

The following job types are shown in the jobs view (see column “Job”):

Offload
(copy
and
verify): Runs copy and verification file per file; verification behavior “Included in Copy Job”
Offload
(copy
only): Runs an unverified offload; verification behavior “Separate (per Job)”
Copy: Backup copy job started from an asset in the library.
Verify: Runs checksum verification for the included tasks.
Transcoding:
Clips can be transcoded to other formats via transcoding job.
Relink:
Files can be relinked to new locations via a relink job.

Job
Queues

There are three job queues that are visualized in the “Queue” column with different colors:

Primary
copy
queue (magenta)
Secondary
copy
queue  (green)
Transcoding
queue (blue)

The “Queue” column indicates the order of the completion of jobs. Jobs in a queue will be completed from top to bottom. Running jobs are always on
top.
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Primary (magenta), secondary (green) copy queue and transcoding queue (blue), with the queue column indicating the order of completion.

Primary
Copy
Queue

Copy jobs are generally scheduled into the main primary copy queue where they will be executed from top to bottom.

You can set the number of parallel jobs for the primary copy queue in the preferences. Please see the article Multiple Simultaneous Copy Jobs in
Silverstack for more information about the general copy preferences.

Secondary
Copy
Queue

The secondary copy queue holds “Second
Run” jobs from Cascading copy jobs. Learn more about Cascading copy jobs in the article Cascading
Copy.

Enabling a separate queue for “Second Run” copy jobs will automatically schedule them into the secondary copy queue. Learn more about the
independent execution of “Second Run” copy jobs in the article Cascading Copy Preferences.

Transcoding
Queue

The transcoding queue holds all transcoding jobs and will also be executed from top to bottom. Please see the articles Transcoding in Silverstack and
Silverstack XT or Transcoding in Silverstack Lab for more information about transcoding.

Tasks
of
a
Job

Each job can be expanded to reveal its tasks (single files to be processed) with the white triangle on the left. Details for each task can be revealed in
the right bar by selecting the task in the table.

Job
States

Active
Jobs

The most important active job states are

Running: A job is currently executed. “Progress” column shows progress as progress bar.
Waiting: Job waits to be executed.
Suspended: Job has been manually interrupted by user. See more details below in suspend jobs section.

Additionally the following job states exist:

Has
Failed
Tasks
(but
running): One or more files of a job failed, but the job is still running

Job with failed tasks, indicated by yellow progress bar.

 

Automatically
Interrupted
(Transcoding
jobs
only): Transcoding jobs can be configured to automatically pause while a copy job is running.
See “Transcoding” section in “Copy&Jobs” preferences tab.
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Finished
Jobs

The active
jobs are shown in the table in the upper half of the jobs view while the lower half shows the finished
jobs.

Finished
jobs can have the following states (see “State” column):

Complete
Failed
Cancelled

Job
Actions

The user can execute certain actions for job. The available actions depend on the job state.

For
Active
Jobs

Cancel

Cancelling
a
job will immediately stop the job and move it to the finished jobs at the lower half of the jobs window.
The copy progress of the current task/file will be lost, the copy progress of completed tasks/files is preserved.
Cancelled jobs can be re-queued and will continue the copy process after the last successful task/file.

Suspend

Suspending a job will stop the job after the next task (often being the next file) is finished.  This enables the prioritization of an incoming job and avoids
loss of copy or transcoding progress.

To suspend a running job select it and click the “Suspend” button in the right tab:

The suspend and resume buttons in the right bar of the jobs window

To resume the job again click the “Resume” button.

When suspending
a
job the following state transfers will be made:

Running -> Will Suspend -> Suspended
Waiting -> Suspended

When resuming
a
job
it will again be queued with its former priority.

Suspended
jobs are still visualized at the bottom of the queue but will
not
be
executed.

Reorder

Waiting jobs in a job queue can be reordered with drag and drop. Select a waiting job and pull it over or under any other waiting jobs in the same
queue:
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Reordering a copy job inside the queue by dragging it to the intended queue position

Please be aware that:

Jobs cannot be moved between queues
Suspended jobs cannot be reordered above waiting jobs. They stay at the bottom of the queue and will not be executed until they are resumed.
Waiting jobs cannot be reordered above running jobs. Suspend running jobs for the next job in the queue to start.

For
Finished
Jobs

Retry
(Failed
Jobs)

Failed jobs can be tried one more time by hitting “Retry” in the right bar. Only the failed tasks of a job will be attempted again.

Re-Queue
(Cancelled
Jobs)

Cancelled jobs can be added to the copy queue of active jobs again (re-queued) to wait for execution.

Create
Incomplete
MHL
file

In the context menu it is possible to create an incomplete MHL (.mhl) file for

Cancelled jobs
Failed jobs

An MHL file is written to all copy destinations of the respective job.

Mark
as
Read
/
Unread
(Hide
/
Show
in
Jobs
Summary)

In the context menu of a job. Mark jobs as read or unread which shows or hides them in the Jobs Summary. All jobs marked as unread show in the
Jobs Summary.

Ingest
Clips

In the context menu of a failed transcoding job. Helps to re-ingest successfully completed proxy clips as transcoded clips even if a job failed.

Jobs
Summary
The jobs summary in Silverstack can be opened by clicking on the element located bottom right in the lower toolbar.

It provides an overview of all types of finished jobs in Silverstack directly in the main window, without the need to go to the full jobs view (accessible
bottom left through “Jobs”).

It is intended to help the user to keep a condensed overview of all jobs he is taking care of.

The view is grouped by the state of finished jobs and each job state has its delimited element showing the number of such jobs:

Failed Jobs (red)
Cancelled Jobs (grey)
Complete Jobs (green)
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The jobs summary accessible in the Silverstack main window.

Mark
as
Read/Unread

Jobs in the jobs summary can be marked
as
read,
which will hide them from the jobs summary. This is intended to have a simple and clear overview
for the user about the general status of the jobs he is taking care of and for which jobs he still might have to take action.

All details about the jobs are still accessible in the jobs view. Jobs can be marked as unread again in the context menu (right click) of a job in the jobs
view, which will show them again in the jobs summary.

More actions include:

Mark
as
Read:
Completed: Marks all successfully completed (ok) jobs as read and hides them from the summary
All: Marks all jobs (independent of their state) as read and hides them from the summary

Reveal: The icon besides the job name (>) allows to reveal the job in the jobs summary

Additionally, you can execute actions for the jobs directly from the jobs summary. Please see the article Managing Jobs in the Jobs View for more
general information about actions for jobs.
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Job
Summary
per
Volume

With many jobs running from and to various volumes, it is helpful to have a condensed overview of the job status per
volume, for example, to identify
which volumes are “ready” and can be ejected and passed on. You can activate an enhancement of the offload menu that displays the count of related
jobs per volume:

running/queued: blue
failed: red
canceled: grey
completed successfully: green

To avoid distraction from irrelevant information, Jobs marked
as
read
are
not
shown in this overview.

Offload menu with job summary

You can activate the enhancement of the offload menu in the “General” tab of the application preferences (see the following screenshot).

Unread
Failed
Jobs
Warnings
and
Reminders

Silverstack by default reminds you of unread failed jobs (jobs with errors that didn’t complete successfully and show in the jobs summary) on every
new offload, not to miss taking care of jobs that failed successful completion. This behavior can be turned off in the “General” tab of the preferences
by unchecking:

“Warn me about unread failed jobs on every new offload”

Unread failed jobs warnings and reminders in the “General” preferences.

Additionally, you can set a reminder notification that reappears within a certain time interval to remind you about unread failed jobs:
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“Remind me about unread failed jobs every:”
10 min
20 min
30 min
1 h
2 h

Use
of
path
wildcards
Silverstack offers you a very flexible folder renaming feature, which allows you to create a custom folder structure on your offload and backup
destinations.

For every copy destination you can define individual folder structure options. If you start a copy process to different destinations, you can have
different folder structures on every destination. Or you just can create a clone of your source material.

There are a variety of software tools in the postproduction process which require a specific folder structure. To simplify the organization of the clips
related to the different folder structure requirements, Silverstack offers this useful feature that automatically helps you to structure the files.

To determine the names of folders you can add a various set of metadata placeholders – called wildcards – that will be replaced by the actual values of
each clip during copy.

This means that Silverstack is able to automatically save your clips in a specific, individually determined folder structure. So for example your files can
be stored in folders according to their submission date and carry the project name and submission time in their file names.

Wildcards can be added in the destination selection step (figure 1) of the “Offload” and “Backup” wizard. Therefore you first need to choose a drive and
a folder (figure 1 #1).

 

figure 1: the Backup wizard. Choosing the destination path.

 

 

Document
Wildcard
Handling

You are able to decide if you want to preserve the original folder structure for the non-clip files or create your custom structure inheriting the metadata
from the clips, having this way all the sidecar documents with their parent clips. By default, Silverstack will inherit metadata from clips. To choose
between this two options, go to Preferences > Copy and choose your Document Wildcard Handling as “Inherit
metadata
from
clips” or “Always
preserve
folder
structure”:
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Document wildcard handling

It is important to have in mind that when selecting the “Always
preserve
folder
structure” option, all files not considered as clips by Silverstack (such
as: non fully supported camera formats, image file sequences, sidecar documents, PDFs…) will be copied in the same path of the clips. All documents
will preserve the same folder structure of the original medium – that means all clips are in the folders you have created.

Now, to make use of the helpful feature of wildcards, click on “Path wildcards” (figure 1 #2) and the wildcards wizard opens…

 

Important
–
Need
to
know

Make sure that the path you have determined by choosing a drive and folder (figure 1 #1-3) is not changed or deleted unintentionally in the
editable path field of the wildcard wizard (figure 2 #1). Just add wildcards to the already existing path components.

In the path field you have to separate the single wildcard tokens by a slash (“/”) if they are supposed to mark a folder structure. Separate them
with a dash (“-”) to combine different wildcards for one folder level.

Filenames should contain some wildcards in order to make them unique. Silverstack checks the uniqueness of all created file paths and warns
you if necessary.

figure 2: wildcard wizard
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Path
textfield
and
example
label

The wildcard wizard (figure 2) at the top shows the full destination path (figure 2 #1) which is editable. You can either type path components in the text
field directly or drag and drop wildcards there from the list below. Beneath the text field you can see an example of the pathname including wildcards
using one of the clips you are going to copy.

Wildcard
table

All available metadata fields are shown in the wildcard list. So you can name your files and folders according to information as submission date and
time, project name, various clip information and others.

The tokens (figure 2 #2) can be drag&dropped into the path field (figure 2 #1). The next column (figure 2 #3) contains an example of every token as it
will be seen in the final path- or filename. The third column (figure 2 #4) tells you how many of the previously selected files contain this metadata
information.

 

Multi-optional
wildcards

Some wildcards like the submission time (figure 3) offer several options. You can choose between those by clicking on the small triangle.

For submission and shooting time you can choose between the formats: HH_MM_SS and HH_MM
For submission and shooting date you can choose between the formats: yyyy-mm-dd, yy-mm-dd, yymmdd, yyyymmdd
For the path
components wildcard you can choose the amount of path components of the source folder structure of the clip – this information
will be include in the path of the newly generated folder structure. So if you choose “3”, the last three levels of the folder structure of the original
clip are included in the new clip’s path.
For reel characters it is possible to choose parts of the reel name as wildcards. You either can select the first or if applicable the last characters
of the reel name.

figure 3: Wildcard wizard: wildcard with several options

 

 

Configure folder structures for Netflix production assets

Uploading
Files
to
Amazon
AWS/S3
With Silverstack XT and Lab you can upload clips to an AWS S3 Bucket, or other service that implements the S3 API.

Starting
the
Upload
Process
and
Entering
Account
Information

In Silverstack’s library choose the bin or folder that contains the clips for upload.

Open the Media menu in the toolbar and choose “Upload Clips to AWS S3 Bucket…”

If no AWS account is configured in Silverstack yet, enter your

“Access Key ID” and
“Secret Key” of your AWS account.
You can also enter an additional (human-readable) name to better identify that account.

Add an AWS account to Silverstack

You can configure additional AWS accounts and manage accounts in the “Accounts” panel of the application’s Preferences.

Choosing
File
Locations

In the first step of the upload wizard you can choose which clips will be uploaded and from which volumes the files shall be read.
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Configuring
the
AWS
S3
Destination

In the second step of the upload wizard you configure the bucket or endpoint location.

If more than one AWS S3 account is configured in Silverstack you can choose the account to be used.

You can either specify the location by bucket or with an endpoint URL.

Configure the upload

For the bucket you choose

the bucket name (either from a list or entered manually),
the region (from a list or entered manually), and
if S3 upload acceleration should be used for the bucket.

For an endpoint URL you choose

the endpoint URL (entered manually), and
the region (from a list or entered manually).

You can set a key prefix for each uploaded file. This prefix will be prepended before the folder information and filename of each file. The key prefix can
thus be used to define a custom “root folder” of the uploaded files within the bucket.

Testing
the
Configuration

By clicking on the “Check Configuration” button the connection is tested as configured. A result panel will be presented that displays the result status
of the checks.

Starting
the
Upload
Job

Click “Start Upload” to start the upload job.

You can review the status of upload jobs in the bottom bar, and in Silverstack’s jobs panel.

Track the upload
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S3
Metadata

For retrieving Silverstack’s clip metadata, the upload process adds a ShotID and a ShotID link as S3 metadata to each file. See the article ShotID as
Clip Identifier for more information about ShotIDs.

Reporting

A reference to the upload location is stored as remote resource in the resources panel. The information can also be added to reports.

S3 Remote Resources

 

Uploading
Files
to
Sony’s
Ci
Media
Cloud
With Silverstack Lab, you can upload clips to Sony’s Ci Media Cloud via a file request URL. Learn more about file requests and how to create them in
the Sony’s Ci Media Cloud user guide.

Starting
the
Upload
wizard

In Silverstack’s library, choose the bin or folder that contains the clips for upload.

Open the Media menu in the toolbar and select “Upload Clips to Ci Media Cloud…”.

Open the upload wizard from the Media menu

Choosing
File
Locations

In the first step of the upload wizard, you can choose which clips will be uploaded and from which volumes the files shall be read.

Enter
and
Validate
the
Ci
Media
Cloud
File
Request
URL

Enter the Ci Media Cloud file request URL in the text field. The URL is checked, and – if valid – additional information is retrieved and displayed.
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File Request Information

Starting
the
Upload
Job

Click “Start Upload” to start the upload job.

You can review the status of upload jobs in the bottom bar and Silverstack’s jobs panel. In addition, pausing and resuming upload jobs is possible in
the context menu.

Ci Media Cloud Upload Status

Reporting

The file panel stores a reference to the upload location as a remote resource. The information can also be added to reports.

Ci Media Cloud Remote Resources in the Silverstack Library and Reports
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LTFS
backup

LTFS backup concept

Silverstack offers a feature to specifically backup to LTO tapes. Due to the nature of their hardware, LTO tapes need a different copy and verification
process than other kinds of drives. The process used by Silverstack is to first copy all the files, then rewind the tape and perform the verification step
afterwards. This way only one tape rewinding step is needed for each backup job.

Additionally, Silverstack supports any kind of LTO drive that creates an LTFS file system on macOS. Generally if the LTO drive can be accessed in
Finder, it can be used by Silverstack. Have in mind that tape formatting has to be previously performed in the LTO drive utility before starting the
backup process.

No data capacity information is offered for LTO tapes. For this reason, it is recommended to manually check that the backup size does not exceed the
tape capacity to prevent failed backup jobs. Only copy jobs to a single LTO tape are currently supported.

 

Starting
the
backup
process

In order to start a backup job to an LTFS drive, just select the ‘Backup to LTFS’ command in the ‘Media’ menu:

Media Menu

 

Once the ‘Backup to LTFS’ command is selected, the Backup Wizard launches:
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Backup Wizard: Clip Selection

It’s possible to choose the copy source volume in case the files have multiple backups registered in the Project Library. Selecting the fastest source
volume generally increases the copy performance, depending on your hardware.

Silverstack by default copies all the clips and files contained in the Folder or Bin you previously selected to backup. If you just need to offload a subset
of clips, you can check the ‘Allow partial offload’ checkbox. Clips can be marked and unmarked either by using the checkboxes or the ‘mark’ and
‘unmark’ buttons by the ‘search’ field. Therefore either select all clips you’d like to import and then click on ‘Mark Only Selected’ or select those clips
of all already marked that shall not be imported and click on ‘Unmark Selected’.

As you can see in the following image, there is a bunch of keyboard shortcuts for marking (#1) and unmarking (#2) clips to facilitate this task.

‘Mark’ and ‘Unmark’ keyboard shortcuts

Once the source volume and the clips have been selected, you can press on ‘continue’, which leads to the Copy Destination Selection step.Add the
LTFS drive to the destinations by pressing the + button:

LTFS Backup Wizard: destination selection
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In relation to the additional options under ‘Verification Behavior’ and ‘Checksum Method’, you can find a detailed description of each one of those
settings in the article The Copy and Verification Process in Silverstack: Verification Behavior.

There is also the possibility of using the Path Wildcards feature, which offers users a way to create custom folder structures based on the metadata
contained in clips.

After determining your copy destinations and settings, click on ‘Backup Files’ to start the copy process. All the information about the backup process
can be supervised in the Jobs panel.

In order to keep track of the clips copied to a certain tape, it’s possible to generate a Volumes Report. For more information on how to generate these
reports in multiple formats, please check the article Creating Reports.

Backup
Data
to
SONY
Optical
Disk
Archive
Silverstack offers the functionality of backing up data to SONY’s Optical Disk Archive technology. You can use the backup function of Silverstack to
write assets to the SONY ODA (Optical Disk Archive). Take a look at the article Backup Clips to learn more about the backup function.

It is also possible to use the Silverstack Offload functionality to directly copy data to an ODA.

Silverstack will automatically detect if the backup will be made to a SONY ODA and will therefore adapt its settings to optimize the copy process.

Important
Aspects
While
Backing
Up
to
SONY
ODA

You have to avoid certain letters in file and folder names that will cause problems while backing up to the ODA. The next table represents the list of
invalid characters:

Fig.2: List of invalid characters for backing up to Sony ODA.

 

Do not use the “Backup to LTFS” function to backup to a SONY ODA. There are certain constraints based on that particular backup function that e.g.
will make it impossible to read clips quickly from the ODA again after backing them up. Stick with the regular Backup functionality in Silverstack when
working with ODAs.

Analyzing
and
improving
data-transfer
performance
Data
transfer
performance
can
be
a
very
important
issue
in
time-pressing
environments
such
as
scenarios
of
on-set
data
wrangling.

For a general list of factors that influence the speed of data-transfers such as

storage
technology,
RAID
technology, and
interfaces

please refer to the document “Factors for data-transfer performance”.

How
to
analyze
your
setup
for
bottle
necks

Every system is only as fast as the slowest component. So for example attaching a brand new, ultra-fast SSD to a computer via USB2 is no
improvement in performance over a 5 year old HDD – the USB2 interface is the limiting factor. The following list helps you to find the bottleneck and to
tune your setup for higher performance. Sometimes just using different connections (lots of devices have multiple, different connection ports) or
replacing one component already can heavily improve the performance of an entire data-transfer system.

When for example copying data from e.g. a SxS card to an external RAID and a USB3 drive with Silverstack, a lot of components are involved – and the
slowest one is slowing down the overall performance and thus all the other components.

In this example we can identify three data storage devices that are each consist of several components:

SxS card
the SxS card itself
the card reader for the SxS card
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RAID system
the interface to the RAID system
the RAID system and its configuration
the drives in the RAID system

External drive
the interface to the external drive
the drive itself

1.
Measure
the
maximum
performance
of
each
device

You can determine the speed of a device by measuring the read and write speed to that device individually and independently. On the Mac you can
either use tools like Blackmagic Disk Speed Test or use command line tools such as “dd”.

Note:

Please
note
that
the
operating
system
caches
disk
access
in
RAM.
So
if
you
write
a
small
file
to
disk
it
is
still
in
the
cache
and
a
directly
following
read
test
will
retrieve
that
file
directly
from
RAM,
so
that
the
disk
is
not
used
at
all
in
your
test!
So
make
sure
that
your
test
files
are
large
enough
(e.g.
larger
than
RAM).
As
a
good
measure
you
can
always
use
“Activity
Monitor”
that
comes
with
OSX
to
monitor
drive
usage
and
performance
(use
the
“Disk
Activity”
tab).
For
example
when
accidentally
retrieving
data
from
cache
during
a
test
you
will
detect
that
as
zero
activity
on
the
drives
in
Activity
Monitor.

Comparing the performance values of the different devices, you now know the slowest device. This device will slow down the entire data transfer, so
maybe you can improve that first.

2.
Observe
the
overall
performance
during
the
copy
process

Now find out if the expected performance can be observed during a real life test. Start a copy process to multiple destinations in Silverstack and use
Activity Monitor as your instrument for measuring performance.

In Activity Monitor you will see the current overall performance. So if you let Silverstack copy the contents of a SxS card to two drives simultaneously,
you should see a write performance that is twice as high as the read performance during copy. After copying a verify-phase follows that reads the files
from the two destinations and the source again. So you should see a very high, combined overall read performance.

In our example take the read- or half of the write-performance value during copy and use this value as your current reference copy performance.
Compare it to the measured performance value of each device. It should be around the speed of the slowest device. If the reference performance value
is much lower than the speed of your slowest device, there might be problems with daisy chaining.

3.
Analyze
the
slowest
device

If the speed of your slowest device (and thus the observed reference copy performance) is much slower than the speed of the other devices it might be
worth improving that.

Determine the speed of the drive by estimating the theoretical performance of the used  drives by technology (HDD, SSD, RAID).
Determine the theoretical speed of the interface.

You can now relate these values to your measured values for the entire device. If you experience completely odd values, maybe something is
configured wrong (attaching a USB3 drive to a USB2-only port) or a component is faulty.

If the interface is the limiting factor, maybe you can change that by switching the enclosure with a better interface. Maybe there is a card reader with a
faster interface available. If the drive is the limiting factor, find out if the drive is exchangeable with a similar or newer drive with better performance.

 

Modifying
the
read
buffer
size
settings

The read buffer size settings use «2MB, recommended» as default. However, increasing the read buffer size might help when copying to software raids
on OS X. Decreasing below the 2MB recommended value is usually not advised. The 2MB size recommendation is only illustrative. The optimal size
depends on your specific setup and format combination.
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Preferences Menu: read buffer size

 

 

Adding
Clips
to
the
Library
(Ingest
without
Copy)
There is a fast solution to create references to video clips in the Project Library in Silverstack. Instead of copying clips to another storage device, you
can select to just ingest them. This process allows a faster way to have the clips in the Project Library for subsequent tasks such as backup, LTFS
backup, quality check or metadata editing.

In order to add the clips, simply select “File
>
Add
to
Library…” or use the keyboard shortcut ⌥⌘O:

Fig. 1: File menu

After selecting the folder containing the clips, the ingest wizard opens:
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Fig 2: Ingest wizard

The ingest wizard allows you to check which clips are being ingested before proceeding. Once you click on «Add», Silverstack starts creating the
references for the clips in the Project Library by reading the metadata and creating the thumbnails. After the thumbnail creation is finished, the clips will
be available in the library to start working with them:

fig. 3: Project Library

 

 

Drag
&
Drop
Clips

Alternatively, you can also ingest clips by drag and dropping the containing folder into the Silverstack dock icon or the Silverstack Library Folder. When
using this functionality for the first time an alert will ask you what you want to do:
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Fig. 5: Ingest warning message

If your intention is to only register the clips, please select the option «Open Add to Library Wizard». The process is the same as previously described.
Otherwise, select «Open Offload Wizard» if you decide to copy the media to backup drives in addition to registering the clips in the Project Library.

In case you enable the checkbox «Don’t show this message again», Silverstack will always use the selected option in the future.

File
renaming
on
offload
Some camera types come with file naming mechanisms that can result in same filenames on different cards. It can be hard to manage these clips with
identical filenames.

Silverstack has an option to rename
files
of selected camera devices by applying a renaming pattern
during the offloading process. Using this feature
leads to consistent
naming of files on your offload
destinations and
consistent
clip
and
reel
names in Silverstack’s library and reports
throughout
the project.

File Renaming: Related settings in the Offload Wizard

How
to
use
file
renaming
on
offload

1. Set a name for the card that you are offloading. This name will be used:
as bin name in Silverstack’s library
as reel name in the clips’ metadata
as part of the new filenames
Optional:
as
part
of
your
offload
destination
path
(see
KB:
Offload
Clips
→
Setting
up
the
copy
destinations)

2. Select a pattern to create new filenames. The new filenames will be used:
as clip names in Silverstack’s library and in reports
as filenames in all offload destinations

3. Optional:
Save
your
offload
settings
in
a
template
4. Start Offload

Note:
If
necessary,
the
original
filename
of
a
clip
can
still
be
found
in
the
right
side
bar
(File
tab
→
Source).
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Predefined
Patterns

You can choose one of the following patterns to apply new filenames to your offload:

Original Filename (no
changes
to
original
filenames,
feature
deactivated)
[BinName]_[0000]_[BaseName]
[BinName]_C[000]_[BaseName]
[BinName]_[BaseName]_[ShootingDate]
[BinName]_[0000]_[BaseName]_[ShootingDate]
[BinName]_C[000]_[BaseName]_[ShootingDate]

These placeholders will be translated into the new filenames:

[0000]: File index counter with 4 digits (guarantees
unique
filenames
if
source
holds
files
with
same
name
in
multiple
folders)
C[000]: File index counter with 3 digits and “C”-prefix
[BaseName]: Original filename without extension
[BinName]: Card name as specified in wizard
[ShootingDate]: From clip metadata in format yyyy-mm-dd

When selecting a pattern that includes a file
index
counter, you have the option to sort clips by name, timecode or creation
date to make sure the
counter reflects the shooting order of your clips.

Supported
Cameras
and
File
Formats

Silverstack automatically tries to identify the camera format of the files before offloading. To protect you from unintentionally renaming files from
camera systems that provide proper naming out of the box, the feature is only
enabled for these camera formats:

GoPro Hero
Nikon DSLR
Sony A7s
Canon DSLR
“Generic Clips”

If another camera format is detected (e.g. ARRI
Alexa), the renaming pattern is reset to Original
Filename and the selection button is disabled.

At the moment, only files with extension .mp4 and .mov are supported for renaming. If the offload source does not contain any supported file format
for renaming, the renaming pattern is reset to Original
Filename and the selection button is disabled.

Workflow
Considerations

If you use different
camera
devices in your production, where one device enables the renaming feature while the other one disables it (e.g. GoPro
Hero and ARRI
Alexa) the
selected
renaming
pattern
can
be
lost between offloads of these devices.

When starting the Offload Wizard, the previous offload settings are restored (including the renaming pattern). However, if the camera format of the
current offload does
not enable the renaming feature, the pattern is automatically
reset to Original Filename, thus the selected renaming pattern of
the previous offload
is
lost. Changes to previous settings are visualised with an asterisk (*), that is appended to the template name on the top right.

For using the renaming feature in productions with differing
camera
models, we recommend
to
create
templates for
each
device (e.g.
MyGoProOffloadSettings and MyAlexaOffloadSettings) and load the appropriate template before the offload is started.

 

Use
Silverstack’s
clip
library
for
EDL
conform
EDL files usually represent a timeline from editing systems such as Avid Media Composer and thus contain an ordered list of clips represented by
timecode data and optional reel and clip information.

You can use an EDL in the CMX 3600 standard to consolidate clips from Silverstack’s Library in a new Bin. From there you can for example copy all
required clips from the EDL to a separate hard drive.

Use
Case

As an example we assume that the editor used five clips which we now need to transfer to a VFX facility. Instead of shipping several hard drives with all
the source footage, or manually searching them in huge folder structures, you can automatically collect them by using the EDL import feature in
Silverstack.

Silverstack matches the timecode from the EDL with the source timecode of clips in the Library and creates a new Bin with the matched clips. From
there it is easy to backup the clips to a single destination via the backup function.

Step
By
Step

We will describe briefly  a typical workflow with Avid Media Composer 6.5.

1. Choose your timeline in AVID Media Composer
2. Then in the MainMenu press Output > EDL . The Avid EDL Manager will open as seen in figure 1
3. Press the “Get Sequence” Button to load the timeline
4. Make sure that the EDL settings are CMX3600 like in figure 2
5. Click in the MainMenu File > Save As… and export the file to your Desktop

Silverstack
Part

6. Open up Silverstack and choose the corresponding project.
7. Press the “Import” Button in the Main Bar and choose the “Edit Decision List” option
8. Choose the EDL file from the Desktop
9. If not set automatically, make sure that you choose the same frame rate like in the metadata of your clips like in figure 3

10. Silverstack will match the clips and add them to a new Bin.
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Figure 1: Avid EDL Manager

Figure 2: EDL Setting in the EDL Manager
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Figure 3: Import wizard for EDLs in Silverstack

This feature is available in Silverstack 3.1 and newer.

 

 

 

 

MHL
Checksum
Verification

Classic
MHL

During offloads and Backups, Silverstack compares byte by byte the source file with all of its backup copies to ensure that no file has been corrupted
during the copy process. If the verification process result is positive, Silverstack is configured per default to create a hash manifest file in the main
folder of each backup destination. A hash manifest contains (among other information) the path and checksum of each copied file and serves as a seal
of file integrity of all copied files and folders. It allows to to ensure completeness and consistency of a backup at a later point manually or with third
party applications. You can find more information about hash manifests in our blog article “Completeness of Data with Manifest Files“.

The default hash manifest in Silverstack is the Media
Hash
List (Classic MHL). For more information about the MHL project, you can visit its website
at http://mediahashlist.org.

The MHL file is created in the root folder of each backup path

ASC
MHL

Silverstack 8.4 introduced support for the new ASC MHL standard. Among other useful additions, this standard allows to create and continue histories
of hash manifests for many generations of file backups. For more information, please check the ASC MHL One-Sheet page. A command line tool is
available via the ASC MHL GitHub repository. You can choose your preferred manifest type in the “Copy&Job” preferences.
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Choose a hash manifest in the Copy&Job preferences

Offloading
media

During offload of files without existing ASC MHL history on the source volume (i.e., when offloading camera cards), a new history is created on the
destination volume.

If an ASC MHL history is already on the source volume, the history is continued on the destination volume. There are some cases where an existing
history cannot be continued (for example, if the hash formats of the existing history and the offload settings don’t match). In this case the fallback
behavior is to start a new history on the destination.

Backing
up
media

During backup of already ingested material, Silverstack generally continues any existing history. Again there are some cases (for example, if clips from
different cards / histories are backed up) when existing histories cannot be continued. In this case the fallback behavior is to start a new history on the
destination.

Additional
Features

Silverstack indicates in the offload wizards if the source volume contains an existing ASC MHL history, checks if any files are missing and if a
compatible checksum method is selected for offloading
Cascading copy creates a first generation on the first run’s destionation and an additional second generation on the second run’s destination.
There is always an option to create a new ASC MHL history on offload and backup.
You can choose in Silverstack’s preferences if ASC MHL histories or the classic MHL manifests shall be created.
The job detail view shows which manifest format (“ASC MHL” or the previous Classic “MHL”) has been created, and allows to reveal the manifest
file in Finder.

Current
limitations

If during offload an existing history has a different hash format than the selected hash format in the wizard, a new history will be created without
warning.
Silverstack is currently not creating directory hashes.
Currently there is no option to create ASC MHL collections and packing lists (“flattened” manifests).

Sealing
Volumes

This
feature
was
introduced
before
the
new
ASC
MHL
standard
was
developed.
ASC
MHL
covers
many
of
the
use
cases
that
Sealing
was
initially
intended
for.


Since version 5.2 Silverstack is able to “seal” volumes to ensure consistency and completeness even after multiple following copy generations. Learn
more about the sealing functionality in Silverstack and the verification of seals and checksums with Pomfort SealVerify from the articles Sealing Drives
in Silverstack and Verifying Sealed Drives in Pomfort SealVerify.

 

Sealing
Drives
in
Silverstack
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The sealing functionality allows Silverstack to make a full inventory list of a drive. This is important, not only to assure that the content of a drive is
identical to the source material but also to make sure that the content on a drive is complete and reflects the intention of the sender. By sealing drives
as well as directories the whole content becomes registered to notice any change inside the folder in the future. The sealing process enables you to
use the free tool Pomfort SealVerify to verify the consistency and completeness of a drive at any generation later without having access to the original
media.

Silverstack allows you to seal volumes as well as folders. For simplicity reasons we may only refer to “sealed volumes” or “sealed drives” below but
want to make clear that the same procedure will work for sealed folders.

Please
note:
This
feature
was
introduced
before
the
new
ASC
MHL
standard
was
developed.
ASC
MHL
covers
many
of
the
use
cases
that
Sealing
was
intended
for.

What
Does
the
Sealing
Do
?

The sealing procedure bases upon the existing and widely used MHL technology and extends its functionalities. During the sealing process Silverstack
writes a .pfsl file on the drive which we refer to as the “Seal”. This seal keeps all content information together and ensures that every change to the seal
itself or any referenced information can be detected at any time. The free application Pomfort SealVerify can be used to easily verify the integrity of a
sealed drive.

Fig. 1: Finder screenshot showing the contents of a sealed drive

To learn more about the Pomfort Seal please visit the article Understanding the Pomfort Seal.

How
to
Seal
a
Drive
or
Folder

Please
note:
Sealing
is
not
compatible
with
the
latest
hash
algorithms
introduced
with
Silverstack
8.4.
Please
do
not
use
XXH3,
C4ID,
or
XXH128
if
you
intend
to
use
Sealing.

To seal
a
drive click on the “Seal” button in the Silverstack task bar and choose the drive you want to seal:

Fig. 2: The Silverstack header bar with the “Seal” button

The sealing wizard opens up and will guide you through the sealing process

To seal
a
folder
go to the main menu and choose “File
>
Seal
>
Folder…”.

[fig. 3 Main Menu File Seal Folder]

After choosing the intended folder the sealing wizard will guide you through the process.

The list shows all attached volumes that have been used as a destination in the current project. The button may be disabled if no such volume is
attached.

Providing
the
Seal
Info

In the first step of the sealing wizard you can enter the information that will afterwards be present in the Seal Info:
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Fig. 3: The first step of the sealing process.

With the two checkboxes you can choose to:

Put a Sealed Library Archive on the sealed drive. Learn more about Sealed Library Archives from the article Importing Sealed Library Archives in
Silverstack XT.
Put a “How To Verify This Drive”-PDF on the drive. It contains information for the receiver of the sealed volume and explains how they will be able
to verify the drive.

Additionally you can can enter information that will be transmitted along with the Seal Info and will e.g. be readable by Pomfort SealVerify or when
Importing a Sealed Library Archive in Silverstack XT.

The Seal Info contains the following information:

Name of the person who sealed the drive or folder
Contact info like e.g. phone number or email address etc.
Time
UUID
Comment
Silverstack Version
Host
Username
Operation System

Enter the information accurately to make sure the receiver of a sealed drive will be able to receive extensive information and can contact you in case of
a problem.

The
Sealing
Procedure

The sealing procedure consists of several individual tasks. While some of them are self-explanatory others need detailed attention:

Lost
and
Found
Items

Silverstack scans the drive for files that have not been copied with Silverstack and therefore are not referenced in any MHL file. Those files are
collected and ingested into an automatically generated folder called “Lost and Found” inside the Silverstack library. Like this, the files will also be
registered within an MHL file that will be placed on the drive.

Please note that the “Lost and Found” items will be referenced by file size only. It is recommended to copy all content with Silverstack to obtain
maximum security with checksum verification.

Library
Export

After as successful sealing process the Silverstack library will contain the complete content of the sealed drive or directory. The library export option
will place a Silverstack library file (.psla) on the drive. By using the library import option in Silverstack XT, an identical Silverstack library containing the
complete and verified content of a drive can be guaranteed. The verification of the content can be handled by the free application Pomfort
SealVerify.

Verifying
a
Seal

Seals can be verified and checked for integrity with the free application Pomfort
SealVerify. Please visit the KnowledgeBase section about Pomfort
SealVerify for more information or download here.

If you are looking for a way to import sealed drives in Silverstack XT please refer to the article Importing Sealed Library Archives in Silverstack XT.

The
Seal
Info
Panel
for
Sealed
Volumes

You can open the seal info for a sealed volume from the Volumes panel. In the left bar of the Silverstack main window scroll the library down until you
arrive at the “Volumes” entry. In the right bar you will then be able to open the Seal Info by clicking on the button “Seal Info” on the side of the volume
showing the seal:
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Fig. 4: The Silverstack volumes panel with the Seal Info.

 

From there several
actions can be taken:

Verify
Seal:
When you have Pomfort Seal Verify installed you will be able to verify the integrity of the seal. Click the button to open the drive in
Pomfort
SealVerify.
Remove
Seal: You can delete the Pomfort Seal file and the Seal Library Archive.
Re-Seal: Delete the seal and recreate a new one with your own seal information.
Import
Library: Import the associated Sealed Library Archive (.psla) that populates a Silverstack Library containing the complete content of the
sealed drive or folder.

Or click “Close” to leave the seal information again.

Importing
Sealed
Library
Archives
in
Silverstack
XT
The import of sealed Library Archives enables you to populate a content complete Silverstack Library into a new Silverstack XT project that includes all
assets of the sealed drive or folder. You can benefit from that process by including a Library Archive export when sealing a drive in Silverstack.
Additionally the free tool Pomfort
SealVerify
enables you to perform a completeness and consistency check of the present content. Learn about the
process of sealing drives with Silverstack from the article Sealing Drives in Silverstack.

Importing
a
Sealed
Library
Archive

Open Silverstack. In the Main Menu go to “File
>
Import
>
Sealed
Library
Archive…”:

Fig. 1: Choose Import > Sealed Library Archive to import a Sealed Library Archive

In the open dialog that appears select the sealed folder that contains the Sealed Library Archive along with the Pomfort Seal you want to import .

After clicking “Open” the Seal Information panel opens up:
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Fig. 2: The Seal Info for the opened volume

The seal information comes from the person who sealed the drive in Silverstack.

Several Actions can be taken from here:

Verify
Seal:
When you have Pomfort SealVerify installed you will be able to verify the integrity of the seal. Click the button to open the drive in
Pomfort
SealVerify.
Remove
Seal: You can delete the Pomfort Seal file and the Sealed Library Archive.
Re-Seal: Delete the seal and recreate a new one with your own seal information.
Import
Library: Import the associated Sealed Library Archive (.psla) that populates a Silverstack Library containing the complete content of the
sealed drive or folder.

Click the button “Import
Library” to start importing the Sealed Library Archive.

The standard library import wizard will guide you through the process of importing the library:

Learn more about this process from the article Library
Metadata
Exchange.

Sealed
Library
Archive
vs.
Library
Archive

The Sealed Library Archive basically is a Silverstack Library Archive with additional benefits. As it can only be created in the process of sealing a drive
or folder with Silverstack the library will always contain the complete content of the sealed volume. Additionally Pomfort
SealVerify can verify the
content of the library to assure consistency with the original data.

 

Understanding
the
Pomfort
Seal
This article will help you understand the intention and background of the Pomfort Seal.

The
Pomfort
Seal

The Pomfort Seal complements the widely used and production-proven MHL standard for checksums and can only be produced by Silverstack.
During the sealing process, Silverstack creates a seal file (.pfsl) that references all MHL files on the drive. An additional MHL file will be created for all
data that was detected on the drive but was not copied onto it with Silverstack. The Pomfort Seal holds all this information together and is even
secured against altering the seal itself. Any kind of change of the data on the drive will break the seal and will therefore be detected by Pomfort
SealVerify.

Please note that the term of “sealing” has nothing to do with encryption of the data on a drive. The Pomfort Seal does not limit the access to your data.
The sealing process aims for integrity, consistency and completeness of data. The term “sealing” is not used in a way that implies a “blocking” or
“locking” of data.
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Sealed
vs
Unsealed

The following table will show you the advantages of a drive sealed with Silverstack:


 consistency consistency
+
completeness

MHL
only
(misc.
copy
tools) YES NO

MHL
+
Pomfort
Seal
(Pomfort
Silverstack) YES YES

MHL files (or other hash files such as .md5 files) basically carry hash values and filenames. With this information, you can verify the consistency of
files without access to the original source files. The appropriate tools can determine if the contents of the files mentioned in the MHL file still have the
same content as at the time when the hash values have been created. The MHL files are usually created during a copy process.

For a drive with multiple folders copied with multiple copy processes (for examples on a film set, where multiple camera cards are copied to the same
travel drive), you cannot verify if one entire folder together with its MHL file is missing. This means with MHL files alone you can verify consistency of
single files, but not the completeness of an entire drive.

To solve this problem , the Pomfort Seal contains a list of all MHL files on a drive. With this information, a missing MHL file can detected very
easily. This  means that the Pomfort Seal together with the MHL files allows to verify consistency as well as completeness of a travel drive.

The sealing process in Pomfort Silverstack also searches for files on the drive that haven’t been listed in MHL files yet. This ensures, that the Pomfort
Seal together with the MHL files cover the entire content of the sealed drive.

Pomfort SealVerify is the free one-button process to verify the Pomfort Seal and the listed MHL files. This way a reliable copy chain can be built where
both, consistency and completeness of media data can be verified at any time.
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Quality Check
Playback
The Silverstack playback view allows to play movie clips back. Please refer to the “Playback” menu in Silverstack for a list of available functionality and
shortcuts.

Playback
Modes

Silverstack has two playback modes that can be permanently set in the “Playback” menu:

Absolute
Time
Playback: Real
time
playback
->
Audio
enabled
Description: This playback mode attempts to play the clip in real time (1s in the clip will be displayed in 1s realtime). This might lead to
frame drops if performance of the machine or I/O might not allow real time playback. Playing back in real time is necessary to enable audio
playback.

Every
Frame
Playback: Play
every
frame
->
Audio
disabled
Description: This playback mode makes sure that every frame of the clip will be displayed. This might lead to a non real time display and
therefore audio playback is not possible in this playback mode.

When using JKL playback controls Silverstack automatically enables Every Frame Playback and therefore disables audio.

Playback
Controls

Playback
HUD

The playback HUD (Head Up Display)

The playback HUD enables the following functionality:

Zoom: Select a zoom setting for the current clip
Loop: Enable loop playback for the selected clips in a timeline
Display
with
Look: Allows to toggle between display of the clip with look or with original color
Display
Options: Select decoding resolution for playback (and debayer options for certain formats)
In/Out: Makes playback respect in and out points
Set
In-Point: Set in point at current playhead position
Frame
backward: Step one frame backward
Frame
forward: Step one frame forward
Play: Play the clip back
Jump
to
Clip
Start
and
Previous
Clip: Moves playhead to the first frame of the clip and if playhead is on the first frame to the previous clip
Jump
to
Middle
of
Clip: Sets playhead to the middle of the clip
Jump
to
Clip
End: Sets playhead to the last frame of the clip
Export
Still
Image: Exports a still image, see also in main menu “Clip > Export Still Image”
File
Playback
Info: Shows the current location of the clip used for playback

JKL
Controls

Playback can be controlled with J, K and L keys in a manner typical to many for example editing applications. It allows for faster playback, slower
playback, reverse playback and frame stepping also known as Playback, Shuttle and Jog:

Playback
: Press L to play forward, K to stop and J to play reverse (“Play Reverse (Faster)”; “Play Forward (Faster)”; “Stop”)
Shuttle
Play: Pressing the keys L or J two or multiple times increases the playback speed by factors 2x up to 64x
Jog: Holding K and pressing L or J allows users to frame-step through a clip forwards (L) and backwards (J) (“Next frame”, “Previous frame”)

The following more specific functionality is available in conjunction with JKL:

Fast
Reverse: Plays in reverse with same speed as currently playing forward
Fast
Forward: Plays forward with same speed as currently playing backward
Play
Slower: Slows down playback below 1x speed

Frame
Stepping

Additionally to JKL, frame stepping is also available with the arrow keys. There are additional option keys to enable larger steps:

Step
5
frames:
Shift + ->/<-
Step
2
seconds:
Shift + Ctrl + ->/<-

Playback
Indicators

Player
Toolbar

The player toolbar contains different elements to inform about the current status of the clip.
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Player Toolbar

The following indicators are displayed in the toolbar (from left to right, top to bottom):

AT/EF: Playback Mode, Absolute Time (AT) or Every Frame (EF) playback
Audio
Enabled/Disabled: Speaker symbol indicates if audio playback is currently enabled or disabled
Playback
direction
and
speed: The play symbol indicated the playback direction, the number (1x / 2x / …/64x) indicates the playback speed
Full
/
½
/
etc.
: Indicates current decoding resolution
Camera
Original
/
Look: Indicates if camera original color is displayed or look is applied
FPS: Show the current playback speed in frames per second
Timecode:
Current timecode of clip

The following controls are available in the popover:

Display
Look: Allows to toggle between display of the clip with look or with original color (see also playback HUD)
Decoding
Resolution: Select decoding resolution for playback (and debayer options for certain formats; see also playback HUD)
Playback
Mode: Switch between Absolute Time and Every Frame Playback Mode; more details see above please

HD-SDI
Output
in
Silverstack

This
article
is
outdated

Silverstack XT and Lab already also support 4k SDI output with:

Blackmagic 4k cards and
AJA Kona 5 cards (requires
8k firmware installed)

 

Silverstack XT and Silverstack Lab come with HD-SDI output to play out ingested clips in best quality for QC on an HD-SDI broadcast monitor. The
current clip in the player gets mirrored to the HD-SDI output showing the image in full-screen and 10 bit color depth.

Supported
Devices

To enable the HD-SDI output you need one of the following devices:

AJA T-TAP
AJA KONA series
AJA Io series
Blackmagic Design Ultrastudio Products
Blackmagic Design Mini Monitor
Blackmagic Design Decklink Cards

Attach the according interface to your Mac (Thunderbolt or PCIe) and connect the HD-SDI output of the device to the selected destination.
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Figure 1: Schematic presentation of a Silverstack XT HD-SDI setup

Drivers

In order to use the supported devices you have to install all drivers and necessary software provided by the the manufacturer.

For Blackmagic Design devices that is the “Desktop
Video” software you can download in their support area.

For AJA Devices that are the “AJA
hardware
drivers” included in the latest “AJA
software
installers” also available in their support area.

External
Video
Preferences

As soon as the HD-SDI device is connected, Silverstack XT  requests permission to use it for playback. In case you decide to activate the SDI playback
later, you can enable it through “Preferences>External
Video”. You can disable the use of the device from the same menu in case another application
demands its use (i.e. parallel use of the hardware with other software). If you have multiple output devices attached, you can select which one to use
by choosing it in the drop down menu:

Figure 2: External Video settings

For the “Video
Format” you will be able to choose from two settings:

Try
to
Match
Clip: This setting will try to match the output format of the SDI to the settings of the clips. Silverstack will try to keep the frame rate
and fall back to HD if the resolution is not supported. If the frame rate is not supported it will fall back to 1080p25.  In detail this means:

Frame
rate
supported
/
resolution
not
supported:
Silverstack will keep the frame rate. The resolution will fall back to a 1920 x 1080 (HD).
Frame
rate
not
supported
/
resolution
supported:  Silverstack will fall back to 1080p25.

Fixed
: This setting will let you choose the output format manually.

Additionally you can choose to release the device when Silverstack XT is in background by enabling the checkbox “Release
device
when
Silverstack
is
in
background”. By default it will be kept even if Silverstack XT is in background.

Please be aware that the support of SDI formats depends on the compatibility of the attached hardware device that the implementation in Silverstack
bases on.
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The
HD-SDI
Indicator

As soon as you enable the external video output in the preferences a little indicator in the toolbar of the Silverstack XT media player will give you hints
on the status of the HD-SDI output:

Figure 3: The HD-SDI indicator will show up in the toolbar of the media player and the Miniplayer.

There
are
3
statuses
possible:

1. HD-SDI output enabled and working:

Figure 4: HD-SDI Indicator showing a working HD-SDI output.

Click on the indicator to reach the External video out settings with the settings for the HD-SDI output.

2. HD-SDI output enabled but no device attached:

Figure 5: HD-SDI indicator showing that no device is attached

Click on the indicator to reach the External video preferences to set up your attached device.

3. HD-SDI output has problems
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Figure 6: HD-SDI indicator notifying about problems with the attached device

Click on the indicator to see details about the problem.

A usual case causing this status of the indicator would be another application that tries to use the same HD-SDI device as Silverstack XT. Deactivate
the background use in the preferences of the application trying to use the same devices as Silverstack XT to avoid the problem.

Playback
Modes

You can choose between two playback modes:

Absolute
Time
Playback:
Tries to play back footage in sync with audio. Silverstack XT will skip frames to stay in sync with audio when video
processing or I/O is too slow.
Every
Frame
Playback:
Aims to play back frame exact which leads to loosing audio. Silverstack XT will play back frame exact even if that leads
to non-realtime playback.

To select the desired mode go to “Playback” in the main menu of LiveGrade and select the according entry right at the top:

figure 7: Select playback mode from the main menu

Image
processing

There are different options when it comes to display the clips through the SDI device. You can modify these settings on the External Video Out window.

figure 8: External Video Out settings window

These are the available settings:

Visual Controls: enable/disable the «Image Analyses» like False Color and Exposure Range, as well as Framelines. Learn more about frame lines
from the article Frame Lines in the Playback View.

147

Silverstack	Lab	
Quality	Check



Scaling and Position:
Scale to fit: fills the output display with the image to compensate for a difference in the resolution.
1:1 Pixels: displays the image in full resolution, which can crop the image id the output display has less resolution than the source.

 

Supported
Frame
Rates
and
Resolutions

Supported frame rates and resolutions are:

720p50
720p59.98
1080p23.98
1080p24
1080p25
1080p29.97
1080p30

Silverstack XT has a fallback resolution (1920 x 1080 HD) and frame rate (25p) that is executed when the desired resolution and frame rate is not
supported by your hardware device. That means if either frame rate or resolution is not a native SDI format the SDI output will fall back to 1080p25.

Interlaced formats are currently not supported.

HD-SDI
Features
and
Quality
Characteristics

Color
Reproduction HD video matrix and gamma (ITU-R BT.709; ITU-R BT.1886)

Timing Sync to next available video frame rates (see Supported Frame Rates and Resolutions
and Playback Modes)

Code
Values 10-bit legal range YCbCr output (internal 16-bit RGB processing)

Embedded
Audio Not supported

Metadata
Output Not supported

The
Miniplayer

Additionally, you can enable the Miniplayer from the same menu, which enables to monitor the same image sent through the SDI output on the
computer display, at the same time as you navigate across the Project Library.

When the HD-SDI Output is enabled it will automatically open the Miniplayer to keep the HD-SDI output though you switched to the list or table view
etc. As soon as you close the Miniplayer the HD-SDI output will be disabled.

You can reopen the Miniplayer manually from the Main Menu. Go to “Playback
>
Show
Miniplayer”
to open it up again. You can also open it from the
Miniplayer symbol in the header bar on the right.

figure 9: the Miniplayer

 

Multichannel
Audio
in
Silverstack
Silverstack offers audio playback of audio data embedded in video clips for preview and quality check. Audio can also be transcoded in dailies and for
the editorial department including a stereo mixdown or with the original audio tracks. The clips with embedded audio can be played back with sound
and can be transcoded for the editorial department including all the audio tracks.
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Silverstack supports audio features for these camera formats:

Alexa ProRes
Alexa SXT ARRIRAW (.ari)
Amira ProRes
Canon C300
H264 from DSLRs (like e.g. Canon EOS 5D Mark II)
Sony F55 XAVC
Sony X-OCN
Digital Bolex Cinema DNG
Various Red Camera models (.r3d movies)

The audio settings per clip are grouped in the “Audio” tab. There you can modify the sound settings for each clip while in Playback mode:

Fig. 1: Audio panel with audio tracks from ARRI Alexa SXT ARRIRAW (.ari)

The audio panel offers the following controls:

Master
Volume: controls the output signal level of the mix.
Audio
meters: represent the audio signal level during playback. There is a stereo Master meter and additional Channel meters — one for each
audio track. The scale on top of the meters indicates the audio level in dB (dBFS). Peaking is represented by a bar in the according color of the
peaking level that remains at the maximum position. You can reset the peak bar by clicking on the audio meters.
Channel
mixers: the sliders control the signal level for each track. You can mute specific «Left» and «Right» tracks by disabling the check boxes
on the right of the channel mixers.
Mute
button: Mutes the according audio channel
Solo
button: Solos the according audio channel
Pan
control: Sets the panorama to left, middle or right

Basic
Color
Control
in
Silverstack
Each clip has a “Look Source” that defines its color processing (see General Info tab, right bar).

Available look source options are:

None: No color processing applied, clip shows no look.
From
File: Clips from certain cameras contain look metadata (e.g. ARRI Alexa clips) that can be applied directly from file metadata. In case there
is no look embedded, Silverstack applies the default Log to Rec.709 conversion for the specific format.
Preset: Select a LUT transform from the available LUT presets integrated in Silverstack Lab.
User-defined
LUT: Load a custom LUT to be applied to the clip.
—————————–
Custom
Look: Create a custom look with node based grade controls.

This feature allows users to display “Log” clips in a different color space by applying preset LUTs, user predefined custom 3D LUTs or color metadata
(looks) embedded in clips (for selected formats1).

The color processing enables you to create thumbnails, playback and transcode the clips with a look applied.

The default look source on ingest for certain clip types can be set in the format preferences (see section “Setting the Look Source for the Ingest of
Clips”)

Editing
the
Look
Source
in
the
General
Information
Tab

It’s possible to modify the color processing of a certain clip or group of clips by setting a different Look Source in the General Information metadata
tab, in the “Look” section.

In order to edit the Look Source of multiple clips, just select them from the library, click on the «edit» button and select an option from the list. Once
you click on «Apply» all the selected clips will have the same Look Source.

 

149

Silverstack	Lab	
Quality	Check



Setting
a
Custom
Look
for
Multiple
Clips

From the Look Source selection you can choose the processing “Custom
Look” to enable a custom look for a clip. Select multiple clips and select the
processing to enable it for all of them.

In the Silverstack player view you will then see the grade controls being opened up. You can learn more about the grading controls and the look library
from the articles Grading Controls in Silverstack and The Silverstack Look Library.

Decoding
Color
Space
(only
available
in
Silverstack
XT)

Some RAW formats allow selecting the decoding color space and gamma. This specifies the result of the manufacturers’ SDK RAW development and
is the working color space for Silverstack Lab’s grading module. The decoding color space and gamma can only be specified when switching to
Silverstack Lab’s “Custom Look”, “Preset”, or “User selected LUT” modes. Currently, these options are available:

ARRIRAW (Mini LF): LogC3/AWG3 or
LogC4/AWG4

Sony X-OCN: S-Log3/SGamut3 or S-Log3/SGamut3.Cine
Canon RAW:
Log
2/Cinema
Gamut,
Log
3/Cinema
Gamut,
Log
2/Rec.
709
or
Log
3/Rec.
709
DJI CinemaDNG: Rec. 709/Rec. 709, sRGB/sRGB, DJI D-Log/Rec. 709, DJI D-Log/DJI D-Gamut

Please
note
that
changing
the
decoding
color
space
requires
manually
selecting
an
appropriate
transformation
LUT
in
the
grading
module.
(E.g.,
changing
the
decoding
color
space
of
an
Alexa
Mini
LF
clip
from
LogC3
to
LogC4
requires
manually
changing
the
LUT
node
to
“LogC4
→
Rec.709”)

The “Apply to Other Clips” button allows transferring of this configuration to all clips of the same format in the current selection.

Select the decoding color space in the general info

How
to
Apply
and
Manage
Custom
LUTs

One of the features related with the look control in Silverstack is the ability to apply custom LUTs to one or multiple clips. Users can load custom 3D
LUTs generated by other software applications – such as LiveGrade Pro. When a custom LUT is used, Silverstack displays the thumbnails and
playback with that look applied. Transcoding of the clips with that LUT is also possible.

Custom LUTs loading

The supported 3D LUT formats are:

.cube (32x32x32, 33x33x33 and 65x65x65)

.3dl (32x32x32)

In order to load them, just select the Look Source to be «User-defined LUT…» and click on the «Load LUT File…». Then navigate through Finder to the
LUT file, select it and choose «Open». Finally, click on «Apply» in the Edit Source pop up to apply the LUT to the clip.
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Look
Source
“Matched
Look”

When looks from Livegrade have been matched to clips via Look Matching a new look source is available named “Matched Look”.

You can start and customize the matched look by pressing “Edit Look…” in the color panel. You can always return to the matched look by setting the
look source back to Matched Look.

 

Setting
the
Look
Source
for
the
Ingest
of
Clips

The color processing can take place automatically when ingesting the clips by reading their metadata or using a preset LUT. In addition, the look
applied can be modified or disabled for each clip individually.

In order to automatically apply a look to the clips while being ingested, you have to go to the «Format Options» section on the «Preferences» menu:

 

Format preferences

 

Each format allows you to define a different color processing. You can choose the format using the «Format Selector».  Once the desired format is
selected you can set the Look Source as:

None: Disables the color processing and displays the clips and thumbnails unmodified (as recorded).
File: Reads the clip’s metadata and applies the color processing described in the embedded looks. In case there is no look embedded,
Silverstack applies the default Log to Rec.709 conversion for the specific format.
Preset: with this option you can choose the color processing used from a list of preset LUTs:

 

Setting
the
Look
for
Transcoding

While transcoding clips you can choose the look the clips will be transcoded with. You can change the settings for the Look source in the transcoding
tab in the right bar (see figure 5):

As
set
in
Library
(“As
in
Library”): Applies the look that is currently selected for the specific clip in the Library. In case you need to transcode the
clips with a custom look applied, this is the right option.
No
Look
(“None”): Transcodes the clips with no look applied (as they were recorded, with no color processing in the camera acquisition color
space).
Look
from
File
(“From
File”): Reads the clip’s metadata and applies the color processing described in the embedded looks. In case there is no
look embedded, Silverstack applies the default Log to Rec.709 conversion for the specific format.
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Choose the look settings for transcoding

 

1 The selected formats with Look Metadata reading are Alexa ProRes, ARRIRAW, Amira ProRes, RED Raw and Panasonic Varicam 35. If no look
metadata is embedded in the file, a default log-to-video conversion is chosen for the specific format (e.g. XAVC with S-Log).

 

Custom
RAW
Development
Silverstack Lab allows you to set custom development parameters for processing selected RAW formats:

ARRIRAW
REDCODE RAW
Sony X-OCN
Canon CRM
DJI CinemaDNG

Formats
and
Manufacturer
SDKs

With the new RAW tab in the right sidebar, Silverstack Lab provides a customizable interface to the camera manufacturers’ RAW SDKs, which are in
charge of transforming the proprietary RAW data into a processable image. The application of the development parameters in the manufacturers’ RAW
SDKs guarantees that the result is of the best quality and in line with the manufacturers’ reference tools.

Each of the mentioned RAW formats allows customizing standard settings like ISO, color temperature, or tint. Depending on the different SDKs or
clips, special parameters like sharpness or noise reduction might also be available.

RAW settings for Sony X-OCN footage
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Custom
Settings
and
Clip
Defaults

Per default, each clip is processed with the “clip default” parameters. These are extracted from the clip metadata and usually reflect the settings
selected in the camera at the time of the recording.

Activating the “Custom Settings” checkbox allows you to manipulate the RAW processing parameters of the currently selected clip. It is possible to
drag the sliders or click on the parameter value and type in directly. Changing a parameter instantly updates the clip’s playback view; the
corresponding clip thumbnail is updated after a short delay. A click on the arrow symbol on the right side of a control resets it to the clip default (as
shot) parameter. The “Reset to Clip Defaults” button on the bottom resets all controls to the clip defaults.

Deactivating the “Custom Settings” checkbox takes you back to the clip default processing but remembers the changed parameters in the
background. Toggling the checkbox allows you to compare the custom against the default processing.

Apply
to
Other
Clips

Custom settings are stored for each clip individually; changing the parameters modifies the active clip only. It is possible to take over a custom
configuration to other clips in the selection with the “Apply to Other Clips” button.

Apply custom raw settings to other clips

The button reveals a panel that allows one to granularly specify which parameters to take over. It is only possible to apply the settings to clips of the
same format (a set of ARRIRAW parameters can only be applied to other ARRIRAW clips).

Main
Table,
General
Info,
and
Reports

Custom RAW parameters, as well as the clip default (as shot) parameters, are available as columns or fields in in the main table and general info tab.
The fields “EI/ISO”, “WB”, and “Tint” with suffix “(clip)” refer to the clip default parameters, while the fields with suffix “(current)” show the value that is
currently used for processing in Silverstack Lab. If the “Custom Settings” checkbox is checked, these fields show the custom settings.

Including both set of parameters in your reports makes the changes transparent.

Clip default versus custom RAW development parameters in a clip report

Decoding
Color
Space

Some RAW formats allow selecting the decoding color space and gamma. This specifies the result of the manufacturers’ SDK RAW development and
is the working color space for Silverstack Lab’s grading module. The decoding color space and gamma can only be specified when switching to
Silverstack Lab’s “Custom Look”, “Preset”, or “User selected LUT” modes. Currently, these options are available:

ARRIRAW (Mini LF): LogC3/AWG3 or
LogC4/AWG4

Sony X-OCN: S-Log3/SGamut3 or S-Log3/SGamut3.Cine
Canon RAW:
Log
2/Cinema
Gamut,
Log
3/Cinema
Gamut,
Log
2/Rec.
709
or
Log
3/Rec.
709
DJI CinemaDNG: Rec. 709/Rec. 709, sRGB/sRGB, DJI D-Log/Rec. 709, DJI D-Log/DJI D-Gamut

Please
note
that
changing
the
decoding
color
space
requires
manually
selecting
an
appropriate
transformation
LUT
in
the
grading
module.
(E.g.,
changing
the
decoding
color
space
of
an
Alexa
Mini
LF
clip
from
LogC3
to
LogC4
requires
manually
changing
the
LUT
node
to
“LogC4
→
Rec.709”)

The “Apply to Other Clips” button allows transferring of this configuration to all clips of the same format in the current selection.
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Options for decoding color space of Sony RAW clips

Visual
Control
Functionalities
in
the
Playback
Mode

figure 1: visual controls in Silverstack

 

With the functionalities provided within the “Visual Controls” panel you can check the colors and quality of your video clip:

1. Channels: By selecting one of the three RGB-channels Silverstack shows the distribution of this color in the image of the video clip.
2. Focus
Assist:
The focus assist  helps you to detect if your image is in focus by detecting the edges of the image. You can set the sensitivity.
3. Clipping:
With the clipping functionality you can check which areas of your image clip are either in the whites or blacks.
4. Exposure
Range:
This option allows you to detect different ranged areas of luminance in your image.
5. False
Color:
You can use this option and active false color. The represented values can be found in figure 2
6. Framelines:  add frame lines to visualize the clips with a different aspect ratio. More information in the article Frame Lines in the Playback View.

 

Figure 2 “Values for clipping”

Note: You can change the unit for clipping and range in the application preferences.

 

Video
Preview
playback
control

The Silverstack playback controls allow you to control the video preview with standard video controls (figure 3 #1) and the possibility to set IN- and
OUT-points (#2) as well as to loop the video and zoom into it (#3). To show the original Log gamma instead to the Rec.709 conversion, select the #4
check box.

 

154

Silverstack	Lab	
Quality	Check

https://kb.pomfort.com/silverstack-5-beta-version/frame-lines/


figure 3: standard playback controls

For video files in the Red format and ARRIRAW sequences you have additional functionality to change the playback resolution (figure 4 #1): You can
select various resolutions, choosing between full, 1/2, 1/4 and 1/8.

figure 4: playback controls for any video with multiple resolutions available

100%
Zoom
for
Retina
Displays

Silverstack is optimized to work with the “Default” settings for Apple retina displays which you can find under “System
Preferences
>
Displays”.
Choosing this setting, Silverstack will map
1
media
pixel
to
1
physical
pixel of the display.

This setting is best suited for visual image analysis such as focus or sharpness.

Professional
Video
Scopes
for
Silverstack
with
ScopeBox
You can use ScopeBox by Divergent Media for software-based waveform and video scopes for Silverstack’s player. ScopeBox offers a variety of
waveform monitors and video scopes that enable image analysis and color control of the clip assets of your Silverstack library.

You can receive information about how to download, setup and license ScopeBox software on Divergent Media’s Website. To use the integration of
Silverstack in ScopeBox you have to run version 3.5 or later of the ScopeBox application.

Connecting
Silverstack
and
ScopeBox
via
ScopeLink

Silverstack sends the current image of the player directly to the ScopeBox application by DivergentMedia’s ScopeLink technology. To enable
ScopeLink open the ScopeBox application.

Click in the upper left area of the ScopeBox main window to set a new source. Choose “Add
ScopeLink
Source
>
Pomfort
Silverstack” from the
context menu:

Figure 1: Add Pomfort’s Silverstack as a source.

After that the source should show a pending image:
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Figure 2: ScopeBox waiting for the Silverstack connection.

Now open Silverstack. Open a clip in the media player.

Make sure that in the preferences of Silverstack under “External
Video” the checkbox “Connect
to
ScopeBox” is enabled. You reach the preferences
from the Main Menu by choosing “Silverstack
>
Preferences…”:

Figure 4: ScopeBox Preference in the External Video tab

There you can also choose if you want to update the frames in ScopeBox during playback in Silverstack. Checking this box may increase performance,
but Silverstack only updates Scopebox when being paused.

When you switch to ScopeBox you should then see the default view including an image preview of the image showing in Silverstack:

Figure 3: The ScopeBox UI with a preview of the Silverstack clip and scopes.

Because of Silverstack’s internal RGB processing, signals from of YCbCr based clips sent to ScopeBox via ScopeLink don’t contain code values
outside the legal range (even if they might be present in the source files).

Tags: waveform, vectorscope, histogram, rgb parade

Frame
Lines
in
the
Playback
View
It is usual to record footage with an aspect ratio different to the one used in the final product, which makes the quality checking of the clips a bit more
challenging. For this reason, Silverstack offers the possibility to overlay frame lines over the clips in the playback window, as well as for the SDI output.
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The frame lines can be activated through the «Visual Controls» menu. You can open the visual controls from the Main
Menu. Choose
“Playback>Show
Visual
Controls”:

figure 1: frame lines settings

 

Once in the Visual Controls window you can activate the frame lines with the checkbox. You can then select the aspect ratio and appearance of the
frame lines:

 

figure 2: aspect ration an appearance settings

You can enter a custom aspect ratio to apply it as frame lines. All entered aspect
ratios
will
be
saved in the dropdown and sorted in alphabetical
order:

figure 3: The list of custom aspect ratios

Comments to the aspect ratios can be added in brackets after the aspect ratio (see example “2,39:1 (Cinemascope)”).

The list of aspect ratios is shared between all three places in Silverstack Lab where aspect ratios can be set: In the Visual Controls for framing
assistance , in Crop, and in the transcoding configurations.

Frames lines are available for normal playback and SDI output. For more information about how to setup the SDI output in Silverstack, please refer to
the article HD-SDI output in Silverstack.
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Image
transformation
The ability to de-squeeze footage recorded with anamorphic lenses and image flipping is available in Silverstack. This features are helpful to check the
quality of the clips without distortions. Image transformations will be also applied if you decide to transcode the clips.

 

Anamorphic
de-squeezing

figure 1: Anamorphic transformation

The de-squeezing option can be applied to a single or multiple clips in the Clip Info tab (⌘1) from the right panel. Scroll down to Processing info and
an Anamorphic option will be shown. Click on the edit button and a panel will pop up as in figure 2. The available settings are 1.3x and 2.0x distortion,
select the one that suites your needs and click on apply. The image will appear without distortions now.

figure 2: de-squeeze settings

 

 

Image
flipping

Some production workflows demand the use of mirrors, such as 3D productions. When the moment of quality check arrives, Silverstack offers the
ability to flip the image vertically, horizontally or both at the same time as shown in figure 3. This feature can also be applied to multiple clips at a time.

 

 

figure 3: image flipping settings

 

 

Tags: desqueeze, anamorph, anamorphic

Still
Image
Export
In order to export a still from a clip, simply move the playhead to the desired frame within the clip and select “Clip > Create Still Image” from the main
menu as shown in here:
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Clip menu: Still Image Export

Batch
Export
of
Still
Images
for
Multiple
Clips

Additionally, Silverstack can export multiple still images at once. That’s possible by either selecting multiple clips in the timeline from the Playback
View or within the Table or Collection Views.

Depending on the context in the software, the still frame position used is different:

Playback
and
Timeline
View: Silverstack exports the
Current
frame in the playhead of each selected clip (indicated by the timeline ruler).
Table
&
Collection
View: Silverstack exports the same
Thumbnail
image displayed in the Table and Collection View.

Note: Have in mind that it’s possible to set the position for the creation of thumbnail images through the Preferences menu. That is going to allow
the export of still images based on the same position while the Table
&
Collection
View is active. Learn more about setting the position for the
creation of thumbnail images in the article Choosing Custom Thumbnail Images.

Still
Image
Export
Settings

Global
Preferences
vs.
Still
Image
Export
Preset

Silverstack offers two methods for exporting still images:

1. Using the still image settings from the Global
Preferences
(default)
2. Using the still image settings from the Still
Image
Export
Transcoding
Preset
(Silverstack XT only)

1.
Using
the
Settings
from
the
Global
Preferences

There are multiple settings and formats available for the still image export feature in the Preferences menu, under the Media tab:
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The following options and actions are available:

Store
Exported
Still
Images
To: Choose the directory to store your still grabs on your system by clicking the “Choose…” button.
Naming
Scheme:
With the naming scheme you can define the naming for the exported still image files.

There are multiple preset options available:
In addition, the “Custom:” option allows users to build a file name based on the metadata of the clip the still is exported from. By clicking
“Customize…” you can open the metadata wildcards panel and choose from the available wildcards to build a custom file name scheme: 
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Image
Format: The available image formats for exporting frames are:
JPEG – 8-Bit, 90% Quality
TIFF – 8-Bit, Uncompressed
TIFF – 16-Bit, Uncompressed

Color
Mode: The different color modes are:
As currently shown in player
Original color
Both: Exports two images with both of the above settings – one as shown in player and the other with the original color.

 

2.
Using
the
Settings
from
the
Still
Image
Export
Transcoding
Preset

In order to activate that mode, users have to select the option ‘Use the still image settings from: Still
Image
Export
Transcoding
Preset‘:

Media Menu: Still image export settings

Once that setting is enabled, the ‘Still
Image
Export‘ preset is going to appear in the Presets panel of the Transcoding Configuration menu:

Transcoding Configuration Menu: Still Image Export Transcoding Preset
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Volume
playback
priority
High data rate video playback is very hardware demanding. As Silverstack offers a multiple destination backup option, your valuable clips will be
stored in different volumes. Different types of volumes may have variant interface connections. To increase playback performance in Silverstack it is
possible to select the playback priority.

To accomplish that you will have to go to the Volumes tab, select the volume you want to set its playback priority and adjust it on the right panel (figure
1 #1).

figure 1: playback priority

 

If your main playback volume is offline, Silverstack will automatically select another volume in the order of your playback priority . If
no
priority
is
selected,
Silverstack
will
randomly
select
the
playback
source
volume.

 

Quick
Look
Features
In Silverstack you are able to preview all of your Assets that are natively supported by the Quick Look feature of MacOSX and offloaded/registered to
your library. This is especially useful if you would like to review those Assets which don’t have advanced camera support. Assets like any PDF
document or image (i.e. a screenplay, storyboard, etc.)

There are also some situations where it can be handy to preview advanced camera support Assets. We will briefly review some different scenarios that
might be useful on the film set.

General

Quick Look lets you browse files — photos, Pages documents, Keynote presentations, QuickTime movies, Microsoft Word and Excel files — without
having to launch an application or leave Silverstack.

Assets that are fully supported in Silverstack are playable via the regular playback function in the Playback view, in addition to the Quick Look feature.

You can access the Quick Look feature from by going to the Main Menu: “Playback
>
Preview
in
QuickLook”. To improve your workflow you can
also use the keyboard shortcut command
“Alt
+
Cmd
+
L”.

Case
1:
Review
supported
Assets

The Quick Look feature helps you to review an Asset without changing into the Playback view. This could be especially useful when you are reviewing
shots in a camera roll with the director but still want to give him a glimpse overview (via thumbnails in the collection view) of the camera roll of the
entire shooting today.

Or if you would like to review the take with recorded scratch sound from the camera.  If the recorded scene includes audio it will automatically
playback with the Quick Look feature.
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Figure 3: “Collection View with Quick Look”

 

 

Case
2:
Review
Assets
without
extended
camera
support

With the use of 3rd party software it is possible to preview footage and Assets that are not natively supported by Silverstack neither with MacOSX.
These can be for example formats like XDCAM HD with help of tool mxf4Mac Import plugin and Final Cut Pro.

Also some other 3rd plugins are out there. Please review this article to have a list of possible 3rd plugins.

 

Case
3:
Review
Storyboards,
Images,
Sounds
and
PDFs

You can also give the director or the camera man the ability to review storyboards (like in figure 4.) or listen to some audio files that you offloaded from
the sound department.

Figure 3 : “Quick Look Storyboard”

 

 

Case
4:
Review
multiple
Assets
(non
consecutive)

With the Quick Look option you can also quickly watch a selection of takes from your camera roll. This is useful when you have many takes in one roll.
You are still able to stay within your current view like in figure 3 but you are able to watch multiple clips and discuss those with the script continuity, the
director or camera man and simple change clips with back and forward arrow within the Quick Look window.

To make a non consecutively selection in the Collection-View (like in figure 3)you simple need to press the command key. If you like to make
consecutive selection you simple press the Shift key. These simple command also applies for the Table-View.

 

163

Silverstack	Lab	
Quality	Check

http://hamburgpromedia.com/products/mxf4mac/mxf-for-mac.php
https://kb.pomfort.com/?p=2965


Creating Reports
Creating
Reports

A crucial feature in Silverstack is the report
creation
functionality. For this reason, Silverstack offers a flexible and powerful reporting center, offering
users the opportunity to share clip information and thumbnails in a well-arranged and accessible PDF document. Reports can include all the metadata
needed to document camera media traveling to different professionals involved in many stages across the production workflow.

Therefore, in order to export a report, choose a project, folder or bin from the Silverstack library and open the Report
Wizard from the button in the
toolbar:

 

The
Report
Wizard

 

Different
Report
Types

Silverstack offers you the possibility to export different types of reports. Each one of them is designed for a different professional involved in the
production process. Additionally, it’s possible to customize what kind of information is shown in the reports (more information on that within the each
report type article).

The different types of reports are:

Shooting Day Report
Clips Report
Thumbnails Report
Contact Print Report
Volume Report

 

Report
Destination

Location

Adjust the location the reports are exported to.

File
Format

By default all reports are created in PDF format. You can change the report file format to HTML in the “File Format:” pop-up menu.

Since Silverstack version 7 the CSV report has moved to the “Export” menu you can also open from the toolbar.

Naming
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Adjust the naming for the reports and set it to custom to use metadata path wildcards for customized naming. See the section “Report Naming
Scheme” at the end of this article for more information.

Open
After
Creation

By default the created report will open after they have been exported automatically in the Preview macOS application. You can prevent that by
disabling the checkbox in the lower left corner of the wizard.

Production
Logo

The production logo that has been added in the Project Overview will automatically be included at the top right of all reports.

We recommend using logos that have a width of 130px. The containers carrying the logo in the reports are limited to that width but are not limited in
height.

Report
Naming
Scheme

When saving reports the naming scheme option help to select a meaningful naming based on your project context.

There are preset options available for the naming of the reports:

Report naming scheme preset options

In addition to the presets the “Custom:” option allows to build a file name based on available metadata. By clicking “Customize…” you can open the
metadata wildcards panel and choose from the available wildcards to build a custom file naming scheme:

Available wildcards for naming the report

 

Export
Multiple
Report
Types
Simultaneously

It is possible to export multiple report types simultaneously by enabling the checkboxes on the left besides the entries per report report type. To
customize a report type select it from the table and adjust the according settings that are revealed on the right. By default a Shooting Day and a Clips
Report are created.

The quick export icon on the right of each report type table element lets you quickly export a single report for preview.

 

Include
Report
Note

Each report type allows to include a general report note. Enable the “Include Report Note” checkbox and add your custom report note. Report notes
support Markdown language.
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Related
articles:

Customizing Clip Reports

Choosing custom thumbnail images

Customising
Clip
Reports
The
Clips
Report is the most customizable type of report. Silverstack offers a flexible and powerful reporting center, allowing users to customize Clips
Reports made for production and post-production workflows. These reports include thumbnails and metadata in a well-arranged and accessible PDF
document. Reports include all the metadata needed to document camera media traveling to different professionals involved in many stages across the
production workflow.

 

Reporting Center – Customizing Clips Reports

 

Basic
Options

Clip Table Layout
Table content: Clips only or clips and other files. Sidecar documents can be included in the report

Ignore Audio Clips
Number of Thumbnails: 1 or 3 (see section “Three Thumbnails per Clip”)

 

Advanced
Options
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Reporting Center – Clips Reports: Advanced menu

Thumbnail Quality in %: setting to adjust the compression ratio of the images with its resulting data reduction.
You can include the following summaries:

Project
Production Info
Clips Overview
Workflow

 

Clip
Table
Layout
Customization:
Metadata
Columns

Users can apply their own Table View column layouts to customize the information needed in Clips Reports.

In order to create a Custom Layout for the Table View, users can select the small gear button and check/uncheck the metadata columns according to
their workflow needs:

Clips Reports – Customizing the table view for a Clips Report

 

Once the layout contains the required columns and those are sorted correctly, it can be saved thorugh the ‘Save…’ menu:

Table View layout – Clips Reports customization

 

Finally, proceed to the report center to create a Clips Report and choose the ‘Custom Layout’ as the Clip Table Layout. The resulting Clips Report will
contain that exact layout:
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Reporting Center – Clips Reports: Basic

 

Thumbnails
in
Clips
Reports

Users can customize the thumbnails shown in their reports to get a better preview of the footage. Silverstack by default creates one thumbnail for each
ingested clip that is saved in the library. This thumbnail is used for referencing clips in the Clips, Thumbnails and Contact Print Reports. As shown in the
previous screenshots, it’s possible to choose between 1 and 3 thumbnails for each clip in the report.

 

How
To

When selecting the Clips or Thumbnails Report in the report wizard you can choose as “Number
of
Thumbnails:”:

1
3 (requires online media)

During the export process Silverstack creates two thumbnails for the first and the last frame of the clip in addition to the custom thumbnail. In contrast
to a single thumbnail Clips Report that accesses the custom thumbnail, the three
thumbnails
Clips
Report
requires
online
media for the ad hoc
creation of the additional thumbnails.

 

Position
of
Thumbnails

The position for the creation of the additional thumbnails can be influenced by setting in and out points for a clip. The position of the custom thumbnail
can be set in the Preferences menu. Additionally, thumbnail creation on ingest can be deactivated in the Preferences. For more information on how to
select thumbnails, please refer to the article Choosing custom thumbnail images.

 

‘Additional
Thumbnails
Failed
to
Create’
Warning

If the thumbnail creation process fails it can have different reasons. One common, simple reason is offline media. If the report fails the following alert
will be shown:

The alert when something went wrong with the creation of additional thumbnails.

Please be aware that if no custom thumbnails have been created the custom thumbnail will show a placeholder icon in the reports. Always
take
a
look
at
your
report
to
ensure
its
content.

 

Hiding
Thumbnails
in
Clips
Reports

Alternatively, it’s possible to completely hide or skip thumbnails in Clips Reports. In order to accomplish that, just remove the ‘Preview’ column from
the Table View custom layout:
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Table View – Removing the ‘Preview’ column

 

Example
of
a
Clips
Report

 

Example of a Clips Report – click to get a closer look

 

Example of a Clips report with three thumbnails

For more information about this topic, please check the article Creating Reports.
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Metadata Handling
Metadata
Handling:
View,
Organize,
Add,
and
Filter
Clips
The clip library is the core of Silverstack. It easily enables you to inspect all the metadata of your clips and let you organize all your clips by these
metadata. During offload and backup all clips and files plus their file copies are registered in the Silverstack’s clip library. Over time using Silverstack in
your production you always have access to these clip metadata which refer to your project based media files. During all organizing and editing tasks
Silverstack never modifies the data of the original and their backups but saves all changes separately.

We will give you a short overview about how to modify and add metadata in the clip library:

Enter
Metadata

Metadata (metacontent) is defined as data providing information about one or more aspects of your clips, for example such as:

Timecode
Resolution
Sensor
Frame Rate
Take, Shot, Scene
Reel name

A lot of clip metadata like resolution, reelname, or exposure is already added to your clips by the camera and is therefore not editable. Non-technical
metadata like scene/shot/take information however can be edited but is not stored within the original video files. Instead Silverstack saves this editable
information and links it to the corresponding clip file. You can add a lot of this supplementary metadata very easily in Silverstack.

You can edit metadata in the Silverstack Information panel, in the “General” (figure 1 #1) and “User” tab (figure 1 #2). Information edited in the
“General” tab can be applied to several selected clips. For doing so, click on the small pen symbol (figure 1 #3) right to the metadata field. Make your
desired changes and enter the information by clicking “Apply”.

 

figure 1: Information panel

 

Metadata like slate information, comments, ratings, flaggings etc. can be edited in the “User” partition (figure 2) and affect exclusively the currently
active clip.

Slate Info: Enter Scene/Shot/Take information, use the arrow keys to increase or decrease a value.
Flag: By flagging a clip (figure 2 #1) you brand it with a flag symbol which can be interpreted individually.
Rating: You can rate each clip (figure 2 #2) by assigning a range of zero to five stars to it.
Comment: Save important information regarding a clip by commenting (figure 2 #3) it.
Label: Each clip can be labelled (figure 2 #4) and thus be categorized. Each label in the drop-down menu can be edited in the application
preferences. You get there pretty fast by clicking on “Edit..” in the drop-down menu as you can see in figure 2 #5.

figure 2: Information panel – “User” section
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Cue Points: The cue points table (figure 3) shows all set markers for this clip (#1). For a better overview of your markers, within a clip you
can assign each marker to one of a set of predefined categories (#2) and also search for them (#4). You can add new markers, delete
existing and jump to the next by the buttons in the lower left corner (#3).

figure 3: Information panel – “User” section: Cue points

 

Using
the
Clip
Information
View

To inspect, edit, and add metadata you can use the information view shown in the right sidebar.

The Information view provides several subviews:

General Info –  Overview of the clip’s metadata
User Info – Additional metadata like slate information, ratings, comments, and cue-points
File Info – List of file resources, showing the different disk the clip was copied to
Header Info – Detailed information of all metadata extracted from the clip

Using
the
Table
View

Silverstack’s clip table view is a great way to get an overview of the various metadata of a set of clips. Some of the fields are editable and you can jump
from field to field by pressing the TAB key.

Custom table layouts can be saved and restored. You can re-arrange columns by dragging their table headers. Clicking the gear button reveals a user
interface with a list of all available columns. Via the checkbox, each column can be shown or hidden. The arrow button which appears only near
activated columns, allows to automatically scroll the main window to a position where the specific column is in the visible area.
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Manage the table layout

Using
the
Quick
Entry
panels

In the playback view the “Quick
Entry” panels allow you to easily set metadata for the current clip via keyboard shortcuts in a very fast way. Here is an
overview of the available commands:

1. Rating ⇧+⌘+A
2. Comment ⇧+⌘+S
3. Label ⇧+⌘+D
4. Scene/Shot/Take ⇧+⌘+T (figure 4)

You can also trigger the panels from the Silverstack menu: Edit
>
Clip
>
Quick
Entry

 

Quick Entry panel for Scene/Shot/Take information

 

Filter
By
Metadata

The more metadata you have added to your library the better you can use it to organize your clips using some metadata attributes.

Search

You can query all metadata fields by using the search field in the upper right of Silverstack . To search for cue points use the search field at the bottom
of the “User” tab within the information panel (figure 3 #4).

Smart
folders

Smart folders are folders that show all clips that match some criteria. Silverstack creates some smart folders by default like “Registered
today” a folder
that contains all clips that were added to the library today.

To create your own smart folders, just click on the “+” button in the lower left and choose “Add
Smart
Folder”.
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Adding a smart folder showing the flagged clips of the last week

You can now specify the criteria a clip has to fulfill in order to be added to the smart folder. If you are adding more than one filter option, you have to
choose if the clip has to fulfill only one or all of it. The example above show a simple smart folder showing all the clips that are flagged and that were
registered during the last week.

Export
Metadata

To really leverage your metadata you might want to export the information for usage in other tools of your digital cinema workflow, Silverstack provides
the following export options:

Reports – Create a report that contains an overview on all clips and save it as pdf/html.
CSV, XML – Create files that you can import in spreadsheet applications like Excel or Numbers. Or write your own scripts to process the data.
Transfer to Final Cut Pro – Get your clips and the metadata into Final Cut Pro 7 and X.
Transfer to AVID Media Composer – Get clips and metadata into AVID using ALE files

For further information about the Silverstack “Transfer” function go to the respective article Transfer.

Note: Not every transfer format can carry the same amount of information. That is why metadata workflows differ from format to format and thus from
tool to tool.

Import
Metadata

You can import certain metadata file formats from 3rd party applications to get additional clip metadata in the Silverstack library via the Import menu in
the toolbar. Additionally, you can take over metadata when syncing audio clips or when matching looks created in Livegrade.
Further information how to choose and validate imported metadata is provided in the article Preview Metadata Before Importing.

 

Tips
&
Tricks:
Quick
metadata
editing
The clip library is the core of Silverstack. With this guide we would like to give you some tips to speed up the metadata editing process. During offload
and backup all clips and files are registered in the library and metadata can be added while still copying the files.

Here are some features that might improve your metadata workflow in Silverstack:

 

1.
Batch
metadata
editing

Silverstack offers the possibility to add metadata to multiple clips at a time. Simply select the different clips in the table and list view and click the edit
button from the metadata field on the right panel (figure 1 #1). Make sure to check the «Apply to selection» check box (figure 1 #2) to modify all the
selected clips.

figure 1: Batch metadata entry and sequential suffix

 

2.
Sequential
suffix

Silverstack lets you add a sequential suffix to certain clip metadata fields:

Clip name
Scene
Shot
Take
Reel name
Lens
Look name
Filter
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To use this feature, simply write the fixed element of the name in the «New value» and the starting value of the sequence (integer number, letter) in the
«Sequential suffix» box (figure 1 #3). For example enter: New Value: “Reel” and Sequential Suffix: “1” and the result is “Reel1”, “Reel2”, “Reel3”, etc.

 

3.
Quick
Entry

In the Playback View the «Quick Entry» panels allow you to easily set metadata for the current clip via keyboard shortcuts in a very fast way. Here is an
overview of the available commands:

Rating ⇧+⌘+A
Comment ⇧+⌘+S
Label ⇧+⌘+D
Scene/Shot/Take ⇧+⌘+T

figure 2: Quick Entry panelsYou can also trigger the panels from the Silverstack menu: Edit > Clip > Quick Entry

 

4.
Keyboard
shortcuts

Silverstack’s metadata related keyboard shortcuts:

⇧⌘ =     Increase rating
⌘ –     Decrease rating
⌃ 0     Clear
⌃ 1     Set rating to 1
⌃ 2     Set rating to 2
⌃ 3     Set rating to 3
⌃ 4     Set rating to 4
⌃ 5     Set rating to 5
⌃A    Increase scene
⌃Z    Decrease scene
⌃S     Increase shot
⌃X    Decrease shot
⌃D    Increase take
⌃C    Decrease take
⌥⌘ +     Increase label
⌥⌘ –     Decrease label
⌥⌘ 0     No Label
⌥⌘ 1     Best Take
⌥⌘ 2     Average Take
⌥⌘ 3     Moderate Take
⌥⌘ 4     B Roll
⌥⌘ 5     Alternate Shots
⌥⌘ 6     Interviews
⌥⌘ 7     Pomfortionös
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Transfer
metadata
to
FCP
7,
FCP
X,
AVID
Media
Composer,
and
Adobe
Premiere

To process your clips in other Tools like Avid Media Composer, FinalCut or Adobe Premiere you can use transfer wizards.

Navigate to the level in your project tree that contains the clips you want to transfer and click “Export”
in the actions bar. Now choose the desired
program to transfer your clips and corresponding clip metadata.

Silverstack Export Options

 

After you have selected the proper program a corresponding “Export” wizard opens up.

 

Choose the clips and then specify the export options
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In the transfer process Silverstack transfers the edited information relating to the particular clip along with a link to its original clip’s storage location. It
never overwrites the original clip’s metadata.

If you want to transfer your clips to Final Cut Pro X, you find a short explanation of the menu items affecting the metadata in the “Export” dialog in the
article Transfer metadata to FCP X.
There is another article for transferring metadata into Avid Media Composer  and one for Adobe Premiere.

If you want to export only metadata of one or several clips as a pdf/ cvs/ xml/ html, Silverstack provides you the “Creating
Reports” function for that
case.

 

 

Transferring
Metadata
to
Final
Cut
Pro
X
Silverstack offers to export clips to Final Cut Pro X, including clip metadata and additional information.

Export
FCPXML

from
Silverstack

Select the desired bin or multiple bins or folders from the Silverstack Library to export to Final Cut Pro X. Choose “Export
to
>
Final
Cut
Pro
X”
via
right click or use the “Export” button in the title bar of Silverstack to select “Final
Cut
Pro
X”.

The will open a window where you can select or deselect clips from the bin that should be exported, followed by a dialog with export options:

Scene, shot, and take name can be added to the name of the clip in Final Cut Pro X
Camera, White Balance, Colorspace, Lookname, EI/ISO (ASA) as keywords
Single-frame cue points from Silverstack are mapped to markers in Final Cut Pro X
Multi-frame cue points from Silverstack are mapped to a clip range marked with a keyword in Final Cut Pro X
Clips with rating “★” (one star) in Silverstack are marked as rejected in Final Cut Pro X.
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The transfer via Final Cut Pro XML files (.fcpxml) always includes:

Clip metadata for reel, scene, shot and camera name (if set in Silverstack)
Clips marked as flagged in Silverstack are marked entirely as favorites in Final Cut Pro X
“Comments” of clips will be taken over as “Notes” in Final Cut Pro X

You can either immediately open the selected clips in Final Cut Pro X or save them first as Final Cut Pro XML files.

Import
FCPXML
into
Final
Cut
Pro
X

When importing the XML file in Final Cut Pro X, a new event is created with one project for each bin accompanied by the source video and audio clips.
Please note that audio clips are only exported via FCP XML if they were synced to video in Silverstack before.

 

Handling Metadata: View, Organize, Add and Filter Clips

Transfer

Search Code: ST-FC1

Transfer
Clips
to
DaVinci
Resolve
Including
Clip
and
Color
Metadata
Silverstack offers a solution to export clips to DaVinci Resolve including clip metadata as well as ASC-CDL color metadata. Additionally it is possible to
set up Resolve with the according LUTs to reflect the exact node based color processing done in Silverstack.
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How
to
Transfer
Clips
from
Silverstack
to
a
DaVinci
Resolve
Timeline

For transferring a bin from Silverstack to a Resolve timeline, including clip and color metadata, these steps are necessary:

1. Export FCPXML as well as additional clip and color metadata from Silverstack
2. Import FCPXML into DaVinci Resolve
3. Use the CSV import function in DaVinci Resolve to add clip metadata
4. Use the Colortrace function in Resolve to add ASC-CDL color data

 

Export
FCPXML
and
Additional
Clip
and
Color
Metadata
from
Silverstack

To export to Resolve select the desired bin from the Silverstack Library. Either perform a secondary (right) click on the bin and select “Export
to
>
Davinci
Resolve
Export”
or from the “Export” button in the title bar of Silverstack choose “DaVinci
Resolve
Export”.

You will be presented with a window where you can select or deselect clips from the bin that should be exported:

Figure 1: Choose clips and media files for Davinci Resolve export

After making your selection click “Continue”.

A further dialog window opens up:

Figure 2: Davinci Resolve export options
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It lets you choose from three export options :

Timeline
(.fcpxml): This export item is responsible for creating the timeline and populating the clips in Resolve.
Color
metadata/Looks
(.edl
and
.ccc):
These export items are responsible for adding the color metadata (ASC-CDL settings) to the clips in
Resolve (via Colortrace functionality).
Clip
metadata
(.csv):
 This export item is responsible for adding the clip metadata to the clips in Resolve. It includes the option to configure data
set in column “Reel Name” (Reel Name, Clip Name or Source File Name).

To result with a timeline,
clip
and
color
metadata activate all three checkboxes and click “Export…”. Select the desired destination for the files. The
FCPXML, EDL, CCC and CSV file will be put in the same directory automatically.

Import
FCPXML
into
DaVinci
Resolve

Open up DaVinci Resolve and create a new project.

From the Main Menu choose “File
>
Import
>
Timeline…”. Navigate to the path where you saved the FCPXML from Silverstack select it and click
open.

You will be presented with an option window for loading XMLs:

Figure 3: Preferences for loading an XML in DaVince Resolve

 

Check to have the checkbox “Automatically
set
project
settings” enabled which should be the case by default. That makes sure all settings will be
adapted to match the clips from the FCPXML.

Click “Ok”.
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Figure 4: The main window of Resolve with the imported timeline

You should be presented with the “Edit” tab in Resolve that shows the Media Pool on the left and a timeline containing all the clips from the Silverstack
bin you formerly exported.

How
to
Add
Clip
Metadata
to
the
Clips
in
the
Timeline

This process will only work in Resolve 12.5 or later.

Go to the “Edit” tab in Resolve. From the Main Menu choose “File
>
Import
metadata
to…
>
Media
Pool”:

Figure 5: Import metadata from the csv

In the following opening dialog choose the .csv file that you exported from Silverstack and click open.
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A metadata import window will follow:

Figure 6: Metadata import options

Choose a meaningful combination of Import Options and Merge Options for your use case. Hit “Ok”.

All matching clips in the bin should now have received the new metadata. Select a clip and check the metadata section on the right side of the Resolve
window for the results.

The FCPXML will already transfer a basic set of metadata. The additional metadata that can be transferred from Silverstack via the .csv file is in detail :

Camera ID [Camera #]
Scene [Scene]
Shot [Shot]
Take [Take]
Episode [Episode Name]
Label [Clip Color]
Flagged [Good Take]
Comment [Comments]
Caption [Description]
Custom 1 [Lens Notes]
Custom 2 [Audio Notes]
Custom 3 [VFX Notes]
Tags [Keywords]
Shot Descriptors [Shot Type]
Cue Points [Reviewers Notes]
Shutter [Shutter]
ASA/ISO [ISO]
White Balance [White Point (Kelvin)]
Tint [White Balance Tint]
LUT Nodes [LUT Used]
CDL SOP [CDL SOP]
CDL SAT [CDL SAT]
Director [Director]
Cinematographer [DOP]
Production [Production Name]
Producer [Producer]
Camera Assistant [Camera Assistant]
2nd Camera Assistant [2nd Asst]
Data Manager [Data Wrangler]
DIT [Digital Technician]
Script Supervisor [Script Supervisor]
Sound Mixer [Sound Mixer]
Location [Location]
Shooting Day [Shoot Day]
Lens Model [Lens Type]
Lens Serial [Lens Number]
T-Stop [Camera Aperture]
Focus Distance [Distance]
Filter [Filter]
ND Filter [ND Filter]
Color Space [Color Space Notes]
Camera Orientation [Angle]
Camera Model [Camera Type]
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Camera Manufacturer [Camera Manufacturer]
Camera Serial [Camera Serial #]
Camera Firmware Version [Camera Firmware]
External Audio Clips [Audio Media]
Soundroll [Sound Roll #]
TC Start (Ext Audio) [Audio Start TC]
TC End (Ext Audio) [Audio End TC]
External Audio Track Names (multiples in column “Audio Track Names”) [Track 1 to Track 8]

The labels in the brackets reflect the naming of the Resolve metadata fields the Silverstack metadata is mapped to.

Setting
the
Reel
Name

To attain a proper match of the CDL values per clip you have to make sure that the Reel Names of the clips and the Reel Names in the Silverstack EDL
match.

In the Project Settings  go to “General
Options” and inside of that to “Conform
Options”. Make sure to check “Assist
using
reel
names
from
the:”
checkbox:

Figure 7: Set the Project Settings Conform Options for the right reel name handling for Color Trace matching

Based on your clip types as well as path structure and clip file names the settings that match your workflow could differ.

Selecting
“Embedding
in
Source
clip
file” as an option should work for QT ProRes and ARRIRAW workflows.

Search the DaVinci Resolve manual for “extraction
pattern
operators”
to learn how to use extraction patterns to pull reel names from your media
paths.

Please be aware that the ColorTrace matching wizard will also give you the opportunity to “Ignore
Reel
Names”
(see also Fig. 9) .

How
to
Add
Color
Metadata
to
the
Clips
in
the
Timeline

Use
the
Colortrace
Function
to
add
ASC-CDL
color
metadata.

After creating the timeline you will be able to add the color information.

Select the timeline from the media pool. It should be marked with a little XML indicator on its lefthand side. Perform a secondary (right) click on it and
choose “Timelines
>
ColorTrace
>
ColorTrace
from
CDL” from the context menu:
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Figure 8: Select ColorTrace from CDL

You will be presented with an open dialog where you will first have to choose the exported EDL file. Right after that you will have to choose the
exported CCC file.

After opening both of them you will be presented with the ColorTrace option window:

Figure 9: The ColorTrace option window

If all the clips have green borders everything matches fine. Click “Copy
Grade
and
Exit” to copy the according grades to the clips. This is important as
you can also “Copy Grade and Exit” without applying any look if all of the clips are marked with a red border.

You can check the “Ignore Reel Names” box to make sure that the Reel Name is not taken into account. Please see the section about setting the Reel
Name above to be able to handle multiple reels in parallel with distinct Reel Names.

Switching to the Color tab presents you with the clips that now have the ASC-CDL color metadata from Silverstack added:
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Figure 10: Switch to the color tab to see the clips with added color metadata

 

 

Transfer
Color
Metadata
to
Assimilate
Scratch
You can export an .ale from Silverstack to transfer ASC-CDL color metadata to Assimilate Scratch. Assimilate Scratch matches the according CDL
values to the loaded clips and translates them into looks.

Exporting
an
ALE
from
Silverstack
Including
ASC-CDL
Color
Information

To export an .ale file from Silverstack go to the header bar and choose “Export” :

Fig.1: Choose Assimilate Scratch from the Export options.

Choose “Assimilate
Scratch
(ALE)” and a wizard window will open:
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Fig. 2: Choose the clip you want to export in the ale.

Select the clips you want to export and click “Continue”.

In the next window choose your configuration:

Fig. 3: Choose the ALE export options

Make sure the “CDL
Values
in
ASC-SOP
&
ASC-SAT
column”
checkbox is checked to transfer color data to Assimilate Scratch.

Click “Save
ALE…” to save the .ale file to the intended destination.

Importing
an
ALE
in
Assimilate
Scratch
and
Matching
Color
Metadata

To import .ale files that contain color information in Scratch you have to follow 4 consecutive steps:

1. Import the clips into Scratch that you want to apply color information to.
2. Import the .ale file.
3. Check settings for matching and import.
4. Go to the clip view and find the ASC-CDL values affect the clips accordingly.

Let’s break the steps down into detail:

Importing
the
Clips

Click the “Load Clips” button from the lower left side of the interface:
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Fig.4: Click the Load Clips button to add clips to Scratch.

Choose the clips you exported the ALE for to add them to the Scratch project:

Fig. 5: Clips have been added to the project

Importing
the
ALE
File


Go to the “Conform” section which you will find slightly below the “Load Clips” button you just used. Click the “Import” button to open the ALE:

Fig. 6 : Choose “Import” from the conform options

Navigate to the exported ALE and click “Open”.

Check
Settings
for
Matching
and
Import

You will see the matching user interface where now the ALE data will be matched to the clips:
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Fig. 7: The ale matching user interface.

At the top of the the columns from the .ale you can select the action that should be performed for each column. Make sure you have the “ASC-SOP”
and “ASC-SAT” columns set to “Import”. Matching on TC or File Name will be easiest so make sure to that at least one of those columns, or any other
you want to match based on, is set to “Match
on…”. You can make that selection from the drop down on top of every column.

Click “Start
Matching” to match the metadata (including the ASC-CDL data) to the clips according to your settings.

While then selecting the different rows in the ALE  you will see the clips the data will be matched to in the right bar of the wizard.

Fig. 8: The metadata has been connected to the clips.

Click “Execute” when you are happy with the match and want the metadata to be taken over to the clips.

Go
to
the
Clip
View
and
Find
the
ASC-CDL
Values
Affect
the
Clips
Accordingly

Double click a clip to reach the clip detail view:
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Fig. 9: The detailed view of the clip in Scratch

Select “Matrix” from the display options on the right side and “Numeric” from the panel on the left side. You will then see how the color settings have
been affected by the imported ASC-CDL data.

 If working in Assimilate Scratch on a PC monitor you have to set the right gamma to match the look of the clips to the perception inside Silverstack. Go
to the Assimilate Scratch global settings to change the gamma if needed. Please be aware of the ColorSync settings in Silverstack as well (read about
the setting in the article Using Silverstack’s Full Screen Mode).

 

Maintaining
Grades
and
Clip
Metadata
Throughout
Production

The use of Pomfort’s LiveGrade and Silverstack in combination with Assimilate Scratch allows for an integrated workflow that involves the preservation
of clip and grade metadata throughout the process.

Looks generated with LiveGrade can easily be matched to the clips inside Silverstack. This workflow is also described in the article Look Matching.

Silverstack can then export an ALE that contains information about the LUT in the grade for each clip. By using the LUT files along with the ASC-CDL
data and the automatic matching process inside Assimilate Scratch, unique grades can easily be transferred for each individual clip.

Transfer
Color
Metadata
to
AVID
Media
Composer
To learn about the basic process of transferring metadata to AVID please refer to the article Transferring Metadata to Avid Media Composer. The article
will help you through the process of matching metadata from an ALE file generated from Silverstack to master clips in Avid.


Adding
Color
Metadata
to
the
ALE
Export

When exporting your ALE file from Silverstack make sure you have the checkbox “CDL
Values
in
ASC-SOP
&
ASC-SAT
column” checked:

Figure 1: Include the CDL Values in the according columns of the ale file.
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After the values are included in the ALE file perform the same steps as pointed out in the article Transferring Metadata to Avid Media Composer. The
result will be clips that have the CDL values from Silverstack in the ASC_SAT and ASC_SOP metadata columns in AVID Media Composer.

Transforming
the
Color
Metadata
Information
into
Looks
in
AVID

We will now use the color metadata information from the ASC_SAT and ASC_SOP column to apply them to the clips.

Select all clips in the bin you merged the metadata with. Perform a right click on the film reel icon on the left of an arbitrary clip:

Figure 2: The bin with selected clips and the reel icons marked.

 

From the context menu choose “Source
Settings”.
You will see the following window:

Figure 3: The Source Settings with the Color Encosing tab selected.

 

Make sure to have the tab “Color
Encoding” selected at the top left of the window. Click the dropdown indicator in the menu where it says “Levels
scaling
(full
range
to
video
levels)”  below the “Color
transformations” list.

You will see a list of transformations to choose from:

Figure 4: Choose the CDL ASC_SOP and ASC_SAT values from the bottom of the dropdown list.
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Scroll down to the bottom of the list and select the  “CDL
ASC_SOP
ASC_SAT” entry. Click “Add” right below and it will appear in the “Color
transformations” list:

Figure 5 : The Source Settings with CDL values in the Color transformation list.

 

Now click “Apply
to
All” on the bottom of the window to apply the according CDL values to every clip. Click “OK” to leave the wizard. Every clip will
now receive the look that is generated from its associated values in the ASC_SAT and ASC_SOP columns.

Adding
a
3D
LUT
to
the
Color
Processing

To add a 3D LUT again select all the clips you want to apply a LUT to. Perform a right click on the film reel icon on the left of an arbitrary clip and from
the context menu choose “Source
Settings”.

Instead of choosing “CDL ASC_SOP ASC_SAT” from the dropdown select
the
desired
LUT and click “Add” to put it into the “Color transformations”
list above:

Figure 6: The source settings with CDL and LUT in the right order in the Color transformations list

Make sure that the CDL entry is on top of the LUT entry in the list. They will be applied in order from top to bottom as in the nodes in Silverstack.

Now click “Apply
to
All” to add the LUT to all the selected clips. Then click “OK” to leave the wizard. The clips will now all have and additional LUT
added to the CDL processing.

 

EDL
Export
Silverstack allows to export an EDL (“edit decision list”) file in the CMX 3600 standard. ASC-CDL information from the library can be included either
directly inside the file or via an additional .ccc (“color correction collection”) file that is referenced in the .edl file. The EDL file can be used for different
purposes in consecutive production steps.
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To export an EDL for specific clips, select a folder or bin in the library and click the “EDL Export…” entry shown in the Export menu of the toolbar:

After selecting the clips to be included in the file in the source selection step you have two options available for the EDL export:

Export EDL with Embedded Look Metadata (EDL File only)
This option exports a single EDL file (.edl) that included the associated CDL values from the library directly in the file.

Here’s an example screenshot of the file :

 

Export EDL with References to Look MEtadata in CCC File (EDL + CCC File)
This option exports an EDL file with references to CDL values exported into a separate but linked CCC (“color correction collection”) file.

Here’s an example screenshot of the files:

EDL:

CCC:

Exporting
Looks
from
Silverstack
There are two ways to export looks from a Silverstack project. It is possible to export AMFs, CDLs, and 3D LUTs from selected clips in the library or
from the Silverstack Look Library. To learn more about the Silverstack Look Library, please refer to the article The Silverstack Look Library.

Looks
from
Clips

The export option “Looks from Clips” can be accessed from the “Export” button in the toolbar or via File -> Export -> Looks from Clips. As soon as one
or multiple clips in the library are selected both options will point to a save dialog to choose from different formats for the export:
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The export window with the different export options.

You can choose between three categories to export your look:

Looks
LUTs for Software
LUTs for Devices

Looks include:

ACES Metadata File (.amf for Grading Mode “ACES CDL” )
ACES Metadata File + CLF [combo] (.amf + .clf for Grading Mode “ACES CDL Advanced”)
ASC-CDL (.cdl, for all grading modes where possible)
ASC-CDL + 3D LUT [combo] (.cdl + .cube file)
Pomfort Look Exchange Format (.pfl, for Look Exchange with LiveGrade Pro)
Alexa Look (.xml, for ARRI Alexa compatible look export)
Amira Look (.aml, for ARRI Amira compatible look export)

LUTs
for
Software include:

Pomfort LiveGrade (33x33x33, RGB order, .cube file)
Pomfort Silverstack (33x33x33, RGB order, .cube file)
Adobe Speedgrade (32x32x32 3D LUT, .cube file)
Assimilate Scratch (32x32x32 .3dl file)
Autodesk Lustre (33x33x33 .lut file)
Colorfront OSD (17x17x17 .3dmesh file)
Convergent Design Odyssey (17x17x17 .cdlut file)
DaVinci Resolve (33x33x33 3D LUT, .dat file)
DigitalVision Nucoda (17x17x17 .cms file)
Filmlight Baselight (32x32x32 .cube file)
REDCINE X PRO (33x33x33, rgb order .cube file)

LUTs
for
Devices include:

BlackmagicDesign HDLink Legal to Legal (17x17x17 .cube file)
BlackmagicDesign HDLink Extended to Extended (17x17x17 .cube file)
AJA Lut box (17x17x17 .cube file)
Panasonic Varicam (17x17x17, rgb order .vlt file)
Teranex Mini (. cube file)

 

Choose the
desired
look
format, a naming scheme, and the intended directory, and hit “Save.” You can then use the exported look in the intended
destination software or device.

NOTE: If you decide to export looks as AMFs (ACES Metadata File), you can create an ALE that references the clips to the exported AMFs.
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Looks
from
the
Look
Library

To export the desired information, choose one or more looks at in the Silverstack Look Library. Perform a secondary click (right-click) on one of the
selected looks, and from the context menu, choose “Export
selected
Looks”:

Select one or multiple looks for export and with a secondary click open the context menu.

The export window described in the section above (“Looks from Clips”) is opened to select the name, file type, and naming scheme for the exported
looks.

Exporting
Look
Archives
from
Silverstack

You can export complete folders with looks directly from the Silverstack Look Library into a Look
Archive
(.pfla). To do that select one or multiple
folders from the Silverstack Look Library. Then, perform a secondary click (right click) and select “Export
selected
Folders
as
Look
Archive”
 from
the context menu:

Figure 3: Exporting a Look Archive from a folder in the Silverstack Look Library.

In the following wizard, select the directory you want to save to and click “Save”. The .pfla file will then be available for further use from that directory.

To learn how to import a Look Archive please refer to the article Importing Looks (from LiveGrade).

Importing
Looks
(from
LiveGrade)
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Silverstack’s Look Library and grading controls enable you to receive looks
from
LiveGrade or ACES
Metadata
Files
(AMF) created with other
applications. More information about creating and managing looks in LiveGrade can be found in the articles Grading Modes in LiveGrade and Create
Clips, Stills and Looks.

Importing
a
Look
into
Silverstack

Choose the Button “Import” or fo to the Main Menu and select

“File>Import>Pomfort
Looks
(pfl)…” for looks exported from Livegrade
“File>Import>ACES
Metadata
File
(amf)…” for looks exported as ACES Metadata File (AMF) from other applications

Import Look File into Silverstack

An open dialog shows up. Navigate to the looks that should be import and select one or multiple files.

Make sure that Silverstack’s Look Library in the right info bar is shown (for example toggle the right bar from the toolbar). Learn how to use the Look
Library in Silverstack from the article The Silverstack Look Library. Go to the Look tab:
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Look Library showing details of the imported look

The imported looks will appear in the “Looks” section containing:

Thumbnail
Look name
Grading Mode
Additional Metadata

Looks imported
from
Pomfort
Looks
(pfl):
 The settings of the grading nodes reflect those of the look in LiveGrade. After applying the look to the
desired clip you will be able to modify it in Silverstack from the point where you left off in LiveGrade.

Looks imported
from
ACES
Metadata
File
(amf):
AMFs are XML-based format specified by ACES for interchanging the entire setup of an ACES
pipeline. Therefore the look created in the look library includes IDT, LMT  and ODT, ACES version information, ASC-CDL values and the working color
space for the ASC-CDL and the LMT. If the ACES Metadata File is referring to a CLF file (Common LUT Format), the CLF file is loaded into the LMT
node.

To learn more about the grade controls in Silverstack please refer to the article Grading Controls in Silverstack.

Importing
a
Look
Archive
from
Livegrade
into
Silverstack

Go to the looks tab in the Right Bar of Silverstack.  In the Look Library perform a secondary click (right click)

 

Importing a Look Archive as a folder.

Select the desired .pfla (Pomfort Look Archive) file and click. The Looks from the Archive will then be available in the newly created folders in the
Silverstack Look Library.

Import
metadata
via
MovieSlate
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Introduction

When importing metadata via MovieSlate XML you can use various methods to match the clips coming from MovieSlate with your offloaded Assets:

Timecode
File Name
Creation Date

Timecode
Mode

This mode is pretty straight forward, it will compare the timecode of your assets and look for the corresponding values in the imported MovieSlate file.
If the timecode of MovieSlate is synced with the camera each asset automatically matches with a clip from the MovieSlate XML. Matching by timecode
also offers the possibility to automatically set the in-point to the slate frame.

File
Name
Mode

The File Name mode works literally and compares the exact filenames of your offloaded assets with the clips from the imported MovieSlate XML. Even
the smallest disparity will force Silverstack not to match the Assets with the MovieSlate metadata.

Creation
Date

This mode matches the creation date of your assets with the creation date of your MovieSlate clip metadata. This mode is working with approximation.
You have a “Tolerance” slider which can help you to adjust the time difference between the camera and MovieSlate clock. You have a range from 1sec
up to two minutes. This method is fuzzy and a high tolerance can lead to misinterpretations.

Further
articles:

 Step-by-Step Tutorial: How to import via Filename Mode 

 Step-by-Step Tutorial: How to import via Timecode & Creation Date Mode 

 

Figure 1: “Movie Slate Import Wizard, showing 5 matched clips”

 

Import
and
Match
Metadata
from
Drylab
Set
Report
3
Drylab Set Report 3 app can export a .CSV file that can be imported into Silverstack to match to clips and add metadata captured in Set Report to the
Silverstack library.

Consult Drylab documentation for export of CSV from Set Report
Matching Options
Metadata Import Options & Mapping

Import
a
CSV
File
from
Drylab
Set
Report
3
into
Silverstack

First select the folder or bin in the library that you want to import metadata for.

Then, in the “Import” menu button in the toolbar select the option Drylab CSV:
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When the Finder dialog points you to select a file, choose the CSV file exported from Drylab SetReport and select “Open”.

Matching
Options

There are two options to match the events in the CSV to the clips in the library:

by Clip
Name
by Creation
Date


Matching
by
Clip
Name

Enabling the Clip Name option, looks for a match between the “filenameBase” column in the CSV and the Video Clip Name (Library Clip Name) in the
Silverstack library.

Options

The pop up menu on the right side of the checkbox offers the option to take only a certain amount of characters of the clip names into account for
matching.

Matching
by
Creation
Date
(Time
of
Day)

Enabling the Creation Date option, looks for a match between the “createdAt” column in the CSV and the Shooting/Recording Date (Library Clip Name)
in the Silverstack library.

Options

Date&Time
with
tolerance: You can adjust a slider to set the desired tolerance for the matching by Creation Date
Date
only: Matches the clips by the date only and neglects the time part of the timestamp

The matches are displayed in the table of clips with a blue checkbox. The left side shows the Silverstack library clip name event and the right side the
event from the Set Report csv.

As soon as you obtained a proper matching, click “Continue”.

Metadata
Import
Options
&
Mapping
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Import
Section: In this step you can select or unselect the metadata that should be imported from the CSV to the Silverstack library.

Insert/Update
Behavior: Choose if you only want to insert new metadata if a fields is empty or you want to force an overwrite.

The following import sections are available:

Slate Info
Reel
Camera Settings
Lens and Filter
Production
Comment and Caption
“circled” Tag (as Flagged)
Append Tags
Day Number + Day Date (as Custom 1)

Mapping

This is the list of importable metadata from the CSV and to which fields it maps in the Silverstack library (sorted by Silvertack metadata section):

Drylab
CSV Silverstack
Field Section Field
cameraLetter Slate Info Camera
episodes Slate Info Episode
scenes Slate Info Scene
shot Slate Info Shot
take Slate Info Take
reel Reel Reel / Tape
tStop Camera Settings T-Stop
distanceToObject Camera Settings Distance To Object
iso Camera Settings ISO
colorTemperature Camera Settings White Balance
pan Camera Settings Camera Orientation
tilt Camera Settings Tilt
latitude Camera Settings GPS Position
longitude Camera Settings GPS Position
cameraName Camera Settings Model
filters Lens and Filter Filter
lens Lens and Filter Model
ac Production Camera Assistant
ac2 Production Camera Assistant 2nd
dop Production Cinematographer
dataWrangler Production Data Manager
director Production Director
dit Production DIT
producer Production Producer
scriptSupervisor Production Script Supervisor
soundMixer Production Sound Mixer
shotNotes Comment and Caption Comment
cameraTakeNotesComment and Caption Comment
tags “circled” Tag (as Flagged) Flagged
tags Append Tags Tags
dayDate Day Number + Day Date (as Custom 1) Custom 1
dayNumber Day Number + Day Date (as Custom 1) Custom 1
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Import
Metadata
from
ZoeLog
For transferring metadata captured in ZoeLog to Silverstack, a CSV can be exported from the ZoeLog app, imported into Silverstack, and matched to
clips in the Silverstack library.

Import
a
CSV
File
from
ZoeLog
into
Silverstack

First, select the folder or bin in the library that you want to import metadata for. Then, select the option “ZoeLog CSV…” in the “Import” menu in the
toolbar:

A file selection dialogue appears. Select the CSV file exported from ZoeLog and click “Open”.

Matching
Options

These options can be combined to match the events from the CSV to the clips in the library:

by Timecode matches the “timecode” column from the CSV with the timecode of the clip in the Silverstack library. If there are multiple timecode
entries in the CSV, all entries are used for matching with the timecode of a clip.
by Camera
looks for a match between the “camera” column in the CSV and “camera” in the Silverstack library.
by Creation
Date
(Time
of
Day)
matches the “Origin Date” column in the CSV with the “Shooting/Recording Date” of the clips in the Silverstack
library refined by these options:

Date&Time
with
tolerance: You can adjust a slider to set the desired tolerance for the matching by Creation Date.
Timezone
offset
of
camera: You can set an offset up to 23hours to compensate time offsets between the CSV and the clip metadata for
the matching by Creation Date.
Date
only: Matches the clips by the date only and neglects the time part of the timestamp.
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The matches are displayed in the table of clips with a blue checkbox. The left side shows the Silverstack library clip name event and the right side the
event from the Set Report csv.

As soon as you obtained a proper matching, click “Continue”.

Metadata
Import
Options
&
Mapping

Import
Section: In this step you can select or unselect the metadata that should be imported from the CSV to the Silverstack library.

Insert/Update
Behavior: Choose if you only want to insert new metadata if a field is empty or you want to force an overwrite.

The following import sections are available:

Slate Info
Roll
Circled
Notes and Descriptions
Camera Settings
Lens and Filter
Custom Fields
Rename any custom field in the user preferences to “Description”, “Lens Height”, “Lens Type”, “LUT” and “Aspect Ratio” in the preferences in
order to map these fields with the corresponding values.

Mapping

This is the list of importable metadata from the CSV and to which fields it maps in the Silverstack library (sorted by Silvertack metadata section):

ZoeLog
CSV Silverstack

Field Section Field

Camera Slate Info Camera

Episode Slate Info Episode

Scene Slate Info Scene

Take Slate Info Take

Roll Reel Reel / Tape

Circled Circled Flagged

Notes Notes Comment

ISO Camera Settings EI/ISO

Color Temp Camera Settings White Balance

Shutter Camera Settings Shutter Angle

Tilt Camera Settings Camera Orientation

Lens Lens and Filter Lens Model

Stop Lens and Filter T-Stop

Filters Lens and Filter Filter

Focus Lens and Filter Focus Distance

Description Custom Fields Custom

Lens Height Custom Fields Custom

Lens Type Custom Fields Custom

LUT Custom Fields Custom
Aspect Ratio Custom Fields Custom
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Import
Metadata
From
LockitNetwork
Metadata captured with the Lockit Script App can be imported via the LockitNetwork cloud service.

Import
Metadata
from
LockitNetwork
into
Silverstack

First, select the folder or bin in the library that you want to import metadata for. Then, select the option “LockitNetwork Metadata…” in the “Import”
menu in the toolbar, and an import dialogue appears.

 

 

First
Use:
Setup
the
LockitNetwork
Account

On the first use, you will be asked to configure your LockitNetwork account. The “+” button will bring you to the LockitNetwork login page. Type in your
credentials and confirm twice.
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You can configure additional LockitNetwork accounts and manage accounts in the “Accounts” panel of the application’s preferences.

Select
LockitNetwork
Project
Details

If an account is already set up, you can choose the LockitNetwork project and shooting day to import metadata from. With this information, Silverstack
requests from the LockitNetwork API information for the selected clips – The API returns what clips were matched and what information is available for
them. The import wizard allows you to check the matched clips’ details and optionally deselect those for which information should not be imported.
The continue button brings you to the import options and preview.

Metadata
Import
Options
&
Preview

The next step allows you to configure and preview the import. It consists of three sections:

 

Import
Section: Select or unselect the metadata that should be imported from the CSV to the Silverstack library.
Silverstack’s
“Custom
1-6”
fields
can
be
filled
with
customizable
data
from
LockitNetwork.
Please
contact
support@lockitnetwork.com
to
setup
these
fields
individually.

Insert/Update
Behavior: Choose if you only want to insert new metadata if a field is empty or to force an overwrite.

Preview
of
changes: Review the changes that would be applied with the current settings. For more details about this view, please check the article
Preview Metadata Before Importing.
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Clicking the import button will take over the previewed changes in the library.

Preview
Metadata
Before
Importing
Silverstack supports importing metadata from other on-set applications, such as ZoeLog,
Movieslate, Drylab, QTake or Pomfort
Livegrade. These
import wizards are complemented by a preview
window, that allows you to check
the
impact of the imported metadata files and adapt the import
options – before
applying the
import
to
your
library.

Import
Preview
Window

Each import wizard consist of two steps:

First Step: Select the file to import and match with the clips in your library
Second Step: Select what metadata fields you want to take over. New:
Preview
Window
in
this
step

Import Options Step With Metadata Preview Window
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1. Show
Clips filter buttons: Filter the preview table
Unchanged
– show only clips that are not changed by the import
Conflicts
– show only clips with metadata that is overwritten by import
Changes
– show clips with metadata that is overwritten by import or that get additional metadata
All
– show all clips that were matched in the previous wizard step

2. Original button: Toggle display of values in table to show value after/before import
3. Clip state indicator:

Grey
– no changes to metadata of this clip
Red
–  metadata in this clip is overwritten
Blue
– new Metadata is added to this clip (but no metadata overwritten)

4. Preview of metadata fields after import
Grey
– value not changed
Red
– original value is overwritten
Blue
– value is added (no original value)
Hover values with cursor to see tooltip with additional information

Changes
to
the
Import
Options
and
the
Insert/Update
Behaviour
(on
the
left
side
of
this
wizard
step)
are
displayed
instantly
in
the
preview
window.

 

For
further
details
about
the
import
wizards,
please
check
the
KB
articles

Look Matching
Import Metadata from ZoeLog
Import Metadata via Movieslate
Import and Match Metadata From Drylab Set Report
Import Metadata from LockitNetwork
Import Metadata from QTake

Transferring
Clips
and
Metadata
to
Adobe
Premiere
Pro
Silverstack can create an .xml file compatible with Adobe Premiere Pro to transfer clips and clip metadata to the editing tool.

Exporting
an
Adobe
Premiere
Pro
XML
from
Silverstack

The export option can be accessed from the “Export” button in the toolbar:

Fig. 1: The export menu

After the source selection step you can define content and format options for the exported XML:
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Fig. 2: Content and format option for the XML export

Content:

General
Clip
Info: Contains the basic information needed to transfer clips (file paths, etc.)
Master
Info: Contains Scene Shot Take info as well as the Reel Name.

Scene in Silverstack maps to “Scene” column in Premiere Pro
Shot and Take in Silverstack map to the “Shot” column in Premiere Pro in the format “Shot – Take”

User/QC
Info: Contains flag/circled info as well as Comments (maps to “Description” column in Premiere Pro)
General
clip
settings
as
Master
Comment
1:
 Maps general clip settings (e.g. InformationSensorFps, ShutterAngle, WhiteBalance,
ExposureIndexAsa, ColorGamma) to the Master Comment 1 column in Premiere Pro
Tags
as
Master
Comment
2: Maps the tags in Silverstack to the master comments 2 in Premiere Pro.
Custom
1,
2
as
Master
Comment

3,4
:  Maps the custom comment fields 1 and 2 in Silverstack to the master comments 3 and 4 in
Premiere Pro
Labels
as
Clip
Colors: Maps the labels in Silverstack to clip colors in Premiere Pro
Audio
Info: Takes over the Source Audio Clip Names column and the # of Source Audio Tracks Info to Clip Comment A and Clip Comment
B in Premiere.
Cue
Points
as
Markers: Maps the cue points in Silverstack to the markers in Adobe Premiere Pro.

 

Format:
Sets the Reel Name to

Reel
Name: Sets the Reel Name of the XML as specified in the Silverstack “Reel Name” metadata field
Source
File
Name: Sets the Reel Name of the XML to the source file name of the clip in Silverstack (e.g.
A003C012_160205_R2VJ.mov)
Source
File
Name
Without
Extension: Sets the Reel Name of the XML to the source file name without extension (e.g.
A003C012_160205_R2VJ)
Video
Clip
Name: Sets the Reel Name of the XML as specified in the Silverstack “Name” metadata field (e.g.
A003C012_160205_R2VJ)

In Premiere Pro the Reel Name of the XML will be taken over to the Tape Name column.

After defining the settings click “Save
XML…” to export the Adobe Premiere Pro XML.

Creating
Synced
Sequences
in
Premiere
with
Audio
Sync
Information
from
Silverstack
XT
or
Silverstack
Lab

Overview
and
Use
Cases

Silverstack can provide information about external audio clips that have been synced to Adobe Premiere to create synced sequences with correctly
aligned video and audio tracks.

This feature helps e.g. to implement workflows where audio clips are not available before transcoding and are synced to the transcoded clips at the end
of the day. Right after automatic audio sync the xml with audio sync information can be exported and provides synced sequences without transcoding
again.

Another use case could be bringing camera native ProRes files into edit with synced audio from Silverstack.
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How
To

After syncing external audio clips with the video clips open the Premiere Export:

Fig. 3: The Audio option in the Adobe Premiere XML Export

Make sure to mark the checkbox “Include
audio
synced
sequences
and
referenced
audio clips”. This will equip
the XML with the necessary
information.

After opening the XML in Premiere Pro you will obtain the following folders:

One folder that contains all the video clips (e.g. A007R2VJ (Editorial), see fig. 4)
One folder that contains all the audio clips synced with the video clips (“Audio Clips” in fig. 4)
One folder that contains the “Synced
Clips
Sequences”

The “Synced
Clips
Sequences”
are Adobe Premiere Pro editing sequences that have the audio in sync position to the clips:
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They can now be used for editing.

To learn more about audio sync with external audio clips in Silverstack Lab and Silverstack XT please take a look at the articles How To Automatically
Sync Audio Based on Timecode in Silverstack Lab and How to Manually Sync Audio in Silverstack XT and Silverstack Lab.

Mention the “special setting” for editing ?

How
to
Open
an
XML
in
Premiere
Pro

After saving the XML from Silverstack you can go ahead and open the XML file in Premiere Pro.

Open Premiere Pro. Go to the “File” menu and choose “Open
Project…“. Choose the previously exported XML file and click “Open”.

The XML will import as a bin with all exported clips in Premiere:

Fig. 4: The imported XML folder in Premiere Pro

 

ZEISS
CP.3
XD
Lens
Correction:
Workflow
Overview
The CP.3 eXtended data (CP.3 XD) lenses by ZEISS provide extended metadata for digitally correcting images concerning optical shading and
distortion deviations. Pomfort’s applications LiveGrade Pro and Silverstack provide functionality to leverage this extended metadata for on-set
preview
(LiveGrade
Pro) and data
management
(Silverstack).

Use
of
eXtended
Data
in
LiveGrade
Pro
and
Silverstack
XT
/
Silverstack
Lab

The ZEISS eXtended data can be used for:

On-set
preview with LiveGrade
Pro
Extraction
of
recorded
lens
data and consolidation with clips in Silverstack
XT
and
Silverstack
Lab

The schematic overviews give you an idea of the on-set preview and lens data extraction use cases:

On-Set
Preview
of
Lens
Correction
with
LiveGrade
Pro

LiveGrade Pro is able to receive realtime lens correction information from a ZEISS CP.3 XD lens that is connected to an Ambient MasterLockit Plus.

Functionality

The live signal of the camera is connected to a hardware capture device that is connected via Thunderbolt to the Mac running LiveGrade Pro in order to
receive a live image in the application. Read the articles HD-SDI Setup for LiveGrade as well as SDI Recording and Framegrabs for more information
about live image capturing in LiveGrade.

LiveGrade Pro connects via Wifi or a tethered network connection to the MasterLockit Plus that receives live lens correction data from the ZEISS CP.3
XD lens. The live lens correction data can be applied to the captured live signal from the camera.

Learn more about the process in LiveGrade Pro in the article ZEISS CP.3 XD Lens Correction in LiveGrade Pro that offers a detailed description of the
features.
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Extraction
and
Display
of
Recorded
Lens
Data
in
Silverstack

Silverstack XT and Silverstack Lab allow to import, display and export lens correction data from ZEISS CP.3 XD lenses.

Functionality

The lens correction data is recorded in the MasterLockit Plus. Clips offloaded in Silverstack hold timecode information that matches the recorded lens
data from the CP.3 XD lens. Silverstack can connect to the MasterLockit Plus via Wifi or a tethered network connection to receive the recorded lens
data and to consolidate it with the clips in the Silverstack database. After that step, the lens correction can be reviewed in the Silverstack player.

Furthermore the correction data can be exported into ZLCFs (ZEISS Lens Correction Files) for consecutive production steps as e.g. the use in
the  “ZEISS
Lens
Correction” plugins ZEISS provides for third party applications.

Learn more about the process in Silverstack in the article ZEISS CP.3 XD Lens Correction in Silverstack that offers a detailed description of the
functionalities.

Hardware
Overview

ZEISS eXtended data can be recorded via an external LEMO compatible plug onto an Ambient MasterLockit Plus:
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Exemplary
Setup
Using
an
ARRI
Alexa
Mini
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1. Connect the ZEISS CP.3 XD lens via the metadata cable to the grey ACN port of the MasterLockit Plus
2. Connect the timecode cable from the TC port of the MasterLockit Plus to the TC port of the camera

Hardware
Components
for
LiveGrade
Pro
Workflow

The following hardware components are involved:

ZEISS CP.3 XD lens
Camera
Ambient MasterLockit Plus
Cables

Lens data cable
Power cables
Metadata cables
Timecode cables

Apple Mac / Macbook (Pro)
Blackmagic Design UltraStudio Mini Recorder or similar recording device

Thunderbolt cable
HDMI or SDI cable

Software
Pomfort LiveGrade Pro

Hardware
Components
for
Silverstack
Workflow

The following hardware components are involved:

ZEISS CP.3 XD lens
Camera
Ambient MasterLockit Plus
Cables

Lens data cable
Power cables
Metadata cables
Timecode cables

Apple Mac / Macbook (Pro)
Software

Pomfort Silverstack XT or Silverstack Lab

Additional
Information

What
is
eXtended
Data?

ZEISS eXtended Data is a newly developed lens data technology. It is based on the Cooke /i technology and extends the functionality with additional
information about the lens characteristics such as distortion and shading. The characteristics are calculated in real time for every focal point and
effective T-stop. The lens data are transferred either directly to camera through 4-pin Cooke /i interface (PL mount) and / or to any supported
equipment via external cable.

ZEISS
CP.3
XD
Lens
Correction
in
Silverstack
Silverstack XT and Silverstack Lab allow to import, display and export dynamic lens correction data from ZEISS CP.3 XD lenses. In particular this
involves shading and distortion correction of the recorded image.
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Overview

The following steps can be executed in Silverstack:

Import
lens
correction
data directly from Ambient Master Lockit Plus to consolidate it with the according clips in the library.
Display
and
review
shading
and
distortion
correction via the ZEISS lens correction panel in Silverstack.
Export
.ZLCF
lens
correction
files to transport lens correction data to consecutive applications

More info about ZLCF plugins and supported applications on the ZEISS Website.

To learn more about the general workflow please visit the article ZEISS CP.3 XD Lens Correction: Workflow Overview.

Prior to importing lens correction data, clips have been recorded in the camera with the MasterLockit Plus attached to camera and lens.

Import
Lens
Correction
Data
from
Ambient
Master
Lockit
Plus

The lens correction data saved in the MasterLockit Plus holds a timecode relation to the clips recorded in the camera. The lens correction data be
pulled via a network connection from the MasterLockit Plus and then be consolidated with the clips via timecode

1. Offload the clips that have been recorded with lens correction data into the Silverstack Library
2. Open the Import wizard through the “Import” button in the toolbar:

Fig. 1: Choose MasterLockit Plus (CP.3XD Lens Data) from the Import menu

3. The lens data import wizard opens. Enter the MasterLockit Plus IP Address to the “Master
Lockit
Address”
address field to connect to the
Master Lockit Plus. After a successful connection the lens data events have been connected to the clips:

Fig.2: The lens data import wizard

Be aware that only clips that do not hold lens correction data will be displayed in the import wizard. Learn how to remove lens correction data in
the sections below.
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4. Options:
Lens
data
queried
by
shooting
date:
The lens correction data saved in the MasterLockit Plus will be queried for a certain time range
around the shooting date of the clips. You can set a wider time frame for the query with this dropdown. By setting the time and date of the
camera correctly you can initially make sure that the shooting date and time of the clips matches the timestamp of the lens correction data.
Import
Options

Overwrite
“Lens”
information
of
clip: The lens info coming from the MasterLockit Plus can be taken over to the “Lens” metadata
field in Silverstack.
Sensor
width: The sensor width is required to be able to display the lens corrections. Silverstack can determine (look up) the sensor
width based on the following metadata of the clips (displayed as columns in the clips table):

Camera manufacturer
Camera model
Sensor model
Format description (only in cases where the above does not provide a unique sensor width)
ResolutionThere are cases
when
an
automatic
detection
is
not
possible (most probable caused by the lack of metadata of
the clips). In this case you have to specify the sensor width manually to be applied to all clips where an automatic
determination was not possible.
You can change the sensor width later in the General Info (right sidebar) under “ZEISS Lens Correction” (see details below).

5. To take over the lens correction data to the clips click the “Apply
Lens
Data” button.

Extract
Lens
Correction
Data
from
Clips

There are cameras that are capable of including the xD lens correction data directly in their recorded clips. Currently the following formats and cameras
support the integration of eXtended Data in the recorded clips:

REDRAW clips from RED DSMC2 cameras (firmware version 7.1 and above)
X-OCN from SONY Venice cameras (firmware version 4.0 and above)

To extract the eXtended Data from the video clips you have to use the generic dynamic metadata extraction functionality. Learn more about how to
extract dynamic metadata in Silverstack XT and Lab in the article Dynamic Metadata.

If eXtended Data is present in the clips, it will automatically be extracted along with the dynamic metadata. Please see the screenshot below for
indicators if distortion and shading metadata is present, marked with a yellow rectangle.

The indicators on the right show if shading and/or distortion data are available.

Display
and
Review
Shading
and
Distortion
Correction

The clips now hold lens correction data. The “ZEISS
Lens
Correction” entry in the General Info shows the enabled correction data:

Fig. 3: ZEISS Lens Correction entry in the General Info

Click the pen icon to open the ZEISS lens correction popover:

Fig.4: The ZEISS Lens Correction Popover in the General Info
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The ZEISS Lens Correction Popover in the General info allows for
two different “Actions”:

removal of lens data (for single and multiple clips)
import of ZLCF file (only if no lens correction data is available for the clip)

multi edit of shading and distortion correction activation
multi edit of sensor width

The ZEISS lens correction panel can be opened from the “Look” section of the main menu:

Fig.5: Open the ZEISS lens correction panel

Fig. 6: The ZEISS lens correction panel

The ZEISS Lens Correction panel allows for
separate activation and deactivation of shading and distortion correction for display in player
entry of distortion zoom factor
dynamic lens data review per clip

The lens correction data will be displayed in the Silverstack player:

To export the status of the lens correction data into a clips report please activate the
“ZEISS
Lens
Correction” column in the table view:
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Fig. 8: The ZEISS lens correction column in the clips table view

Export
ZEISS
Lens
Correction
Files

The acquired lens correction data can now be exported per clip for consecutive productions steps. To open the export wizard go to the “Export”
button menu in the toolbar and select the “ZEISS
Lens
Correction
Files
(ZLCF)” entry from the list:

Fig. 9: Open the ZLCF export wizard

This opens the ZLCF export wizard:

Fig. 10: The ZLCF export wizard

Please be aware that the wizard only shows clips that hold lens correction data. All others will not be shown and are reflected in the status line at the
bottom.

Per clip one .zlcf (ZEISS lens correction file) will be exported. After clicking
“Export…”
the wizard points you to select a folder for the zlcf files to be
placed.
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Camera Formats
Generic
file
formats
Offloading all kinds of assets is possible with Silverstack’s proven copy features, which offer secured backups with checksum verification. The Offload
wizard scans the source folder and automatically selects the «Generic Copy» mode when non-supported files are detected. Not all media files are
recognized as playable Clips by Silverstack, besides the supported advanced media formats that can be found in the article Assets in Silverstack.

Offloading wizard

 

You will get a yellow notification reading «Ingesting NO clips» in the offload wizard in case Silverstack didn’t recognize the scanned files as a supported
advanced camera format. However, you can go ahead and proceed to offload and check sum the files. Once the process is finished, the files will be
registered in the Library, where you can continue to work with them. Just make sure to enable «Show Clips and Documents» in the View menu:

View menu

 

ARRI
ALEXA
and
AMIRA
Looks
in
Silverstack
Silverstack can playback and transcode ProRes clips recorded with ARRI ALEXA and AMIRA cameras with the looks applied on set. This feature lets
DITs check the Log-C footage in real time with the final look and feel without the need of transcoding.
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figure 1: AMIRA look application on and off

 

In order to use this functionality, ALEXA Looks and AMIRA Looks have to be applied in the camera before recording. Then the camera will write color
metadata into the QuickTime ProRes clips. Once the clips have been added to the library, Silverstack will read this metadata from the file and apply the
color changes along with the standard Rec.709 conversion by default. After the clips have been checked for quality, Silverstack will let you transcode
them to a lighter codec with the same look applied.

This feature is active by default, but it can be disabled through Silverstack’s Preferences menu, by setting the «Look Sorce» to None:

 

figure 2: visual controls preferences menu

 

Even if the look application is disabled, the footage can be displayed with the standard Log-C to Rec.709 conversion if you select «Preset» and choose
one of the Alexa or Amira LUTs.
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ShotHub Integration
Connecting
Silverstack
to
ShotHub

Sync
the
local
Silverstack
clip
library
with
ShotHub

Make
sure
you
are
working
with
Silverstack
or
Silverstack Lab version 8.0 or higher with
the
Silverstack
Library
Sync
Feature.
Please
note:
You
can
use
the
Library
Sync
Feature
across
several
computers
with
Silverstack
OR
Silverstack
Lab,
that
means
there
is
no
need
to
have
Silverstack
Lab
installed
on
all
computers.

Follow the steps below to make your clip library available online and merge clip metadata and file information bi-directionallly with
connectedSilverstack desktop applications.

1. Click the cloud button in the toolbar to start the setup process:

2. In the first step, you sign
in
to
ShotHub with your Pomfort Account credentials to connect your project with ShotHub.
3. Optional: Select your Pomfort Account if you use more than one Pomfort Account (which can managed in the application preferences)
4. In the next step, select
a
ShotHub
team
and
choose
the
Silverstack
cloud
project that you want your current local Silverstack project to

appear in. You have two options:
Create a new
cloud
project and give it a custom name in the “Project Name:” text field (cloud project names are forced to be unique).
Merge  the Silverstack library with an existing Silverstack cloud project, which you can choose from the “Cloud Project:” pop-up button.

5. In the last step, you choose the sync options. Select if you want to upload
thumbnails with the metadata library.
6. Click “Start Sync” to start the sync process of your local library to a Silverstack cloud project in ShotHub.

Sync
the
clip
library
of
another
Silverstack
application
with
the
cloud
project

Generally, there are two ways to sync another library with an existing cloud project in ShotHub. You can either create
a
new
local
clip
library by
adding a synced library from ShotHub or you can
merge
the
local
clip
library
with the cloud project. More details of both ways can be found in this
article: Sync Clip Library

SHOTHUB
PROJECT
STATUS
AND
SYNC
OPTIONS

After the setup is completed successfully, you can monitor the ShotHub project status in the popover that shows from the cloud button in the toolbar
(see screenshot below).

The cloud button indicates the following sync status or ongoing sync processes:

…
new library data, changes, or thumbnails in the synced libraries are available to be synced
↺

sync is in progress, new library data, changes, or thumbnails are synced
✓ project is synced completely
x
project is disconnected from cloud project or temporarily taken offline
!
sync error (for example, if you are not connected to the internet or the cloud project was deleted)
⚙ ︎
 project is not connected to ShotHub (library is not uploaded or disconnected from ShotHub)

The elements displayed in the popover are the following:
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Gear
menu
button: Provides access to the following  functionalities:
Take
the
project
offline
temporarily. This temporarily prevents new library data from being uploaded to the cloud project.
Take
the
project
online.
Restarts uploading new library data to the cloud project if taken offline before.
Sync
Changes
Now.
Trigger the sync process manually.
Disconnect
the
project
from
ShotHub. This will disconnect the local project and the cloud project permanently. By default you can sync
your library again to the existing cloud project by setting up the sync process again.

Pomfort
Account: This shows the Pomfort Account that is used to sign into ShotHub for this project.
Cloud
Project: The name of the Silverstack cloud project that the local Silverstack project is connected with. You can click the link to the cloud
project to open it directly in your default web browser.
Include
Thumbnails: Shows YES if thumbnails are also synced and NO if they are not synced. You can change this setting by disconnecting the
project and setting it up again.
Last
Sync: Time and date of the previous complete sync.
Progress
bars: When changes are made to the library or the cloud project, there are two progress bars. One for the sync of library metadata and
one for respective thumbnails.

ACCOUNTS
TAB
IN
THE
PREFERENCES

Your Pomfort Account(s) can be managed in the Accounts tab of the application preferences. Configured accounts show up in the connection dialog
when starting the upload of a new project and can also be edited in the keychain.

 

Clip
Library
Sync
Share the clip library of Silverstack via ShotHub to keep clip metadata and file information synced across computers.

In order to use the clip library sync feature a Silverstack cloud project should be created first. You can either sync a project from Silverstack with
ShotHub or create a new project on the ShotHub web page.

Then, there are generally two ways to connect another Silverstack application to the synced cloud project. Create
a
new
Silverstack
project (1) by
syncing the clip library from a Silverstack cloud project or
merge
the
local
clip
library
(2)
with a Silverstack cloud project. For both ways, make sure
that you have added your Pomfort Account in the application preferences to be able to access the Silverstack cloud project.

(1)
Create
a new
local
Silverstack
project means that connecting the Silverstack desktop application with a ShotHub project creates a new local
project that is “synced”. Further changes in the clip library are bi-directionally synced with the cloud project and connected Silverstack applications.

1. Click the “Sync from ShotHub” button in the Project Chooser (next to the button “New Project”)
2. Choose your account or sign in to ShotHub with your Pomfort Account credentials (for first usage only)
3. Choose
the
Silverstack
cloud
project that you want to sync with to create a new Silverstack project
4. Click “Start Sync” to start the sync process of your local library with the selected ShotHub project.

Create new local Silverstack project from ShotHub
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(2)
Merge
local
clip
libraries
means that you can merge a local Silverstack library with one cloud project, which makes especially sense when you
started two Silverstack projects independently. That way, folders with the same name in both local libraries are merged (e.g. “Shooting Day 1”) into the
synced clip library, bins are never merged, even if they have the same name.

1. Click the cloud button in the toolbar
2. Choose your account or sign in to ShotHub with your Pomfort Account credentials (for first usage only)
3. Choose
the
Silverstack
cloud
project that you want your current local Silverstack project to appear in
4. Click “Start Sync” to start the sync process of your local library to a Silverstack cloud project in ShotHub.

Local Silverstack clip libraries merged into one Silverstack cloud project
NOTE: If you are not using the same Pomfort Account on the other device or want to authorize other persons to sync with your project, you should
invite them as project admins or project members to your ShotHub cloud project. Learn more about Managing Project Members here.

Clip
Library
Sync
Details

Syncing your Silverstack library via ShotHub to other instances of Silverstack includes:

Complete library with all folders and bins
All clips, sidecars and documents
General Info with metadata
User Info with slate and rating information
Note:
Sync
option
works
per
metadata
entry,
that
way
you
can
edit
slate
info
and
comments
on
two
computers
simultaneously
File Info with overview of file resources and link to clip in ShotHub
Summary showing statistics and details
Relation of source and transcoded clips
Look info and grading information
Note:
Sync
option
works
per
look
including
all
grading
nodes
Thumbnails (if enabled for initial cloud project)
Project Settings: Labels and Custom Field Labels
Cue points
Synced audio clips
Audio Panel adjustments

Metadata
created
in
synced
projects

ShotID and ShotID link: Clip Identifier to retrieve a clip in ShotHub or Silverstack
Added By: Metadata field to indicate the Pomfort account that was used to sync a clip with ShotHub. In Silverstack “Added By” is available as
column in the clips table, as filter or smart folder criteria and shown in the file tab. When accessing the cloud project in ShotHub “Added By” is
also available as column or search filter.

 

Related articles:
Exchange
Library
Metadata: Import and Export Silverstack Library Archives

Search Code: SH-CL1

ShotID
as
clip
identifier
The ShotID is a short code to reference clips across multiple work places and make their metadata easily accessible.

ShotID
to
Share
Clip
Metadata

The ShotID is an identifier, created for each clip individually when added to the Silverstack library. It consists of 9 characters in a unified format, that is
easy to read and pass along, e.g. A1C-D2F-G3H.

When the library is uploaded to ShotHub, typing-in the ShotID into ShotHub’s search field reveals a
detail
overview
page
with
all
available
clip
information. Wrapped as ShotID link (e.g. shotid.net/A1C-D2F-G3H) in emails or text messages, all of the clip’s information it is just one click away.

Precondition to access clip information via ShotID link is that you are a member of the ShotHub project. Learn more: Manage Members and Invitations

ShotID
in
Silverstack

Just like other metadata fields, the ShotID is displayed in Silverstack’s clips table and in the general info tab of the right sidebar. It can be included with
its link in PDF reports as well as in CSV- and ALE-exports. When the clip’s information is uploaded to ShotHub, a Remote
Resource shows up in the
file tab, that lists the name of the connected cloud project, the ShotID and offers buttons to copy or open the ShotID link.
In transcodes, the ShotID can be burned-in as text or QR-code link to reference it’s source clip information in the corresponding ShotHub cloud
project.
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Troubleshooting
Application
Preferences
Many general settings for Silverstack can be changed within the Application preferences and by doing so, working with Silverstack may become even
easier to fit your workflow.

You get to the preferences menu by selecting “Preferences…” in the “Silverstack
” menu. The window that opens up contains following sections which
will be described detailed in this article:

General
Projects
Media
Copy&Jobs
Playback
Formats
Ingest
Backups
External Video
Grading
ACES
Slating
Accounts
Updates

Silverstack’s preferences overview

General

Make decisions about appearance topics here.

General preferences

 

 

Projects
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Project preferences

This section contains settings that are applied to new projects or a specifically set for the active project. Switch the active project to see another
project’s settings.

Project preferences

You can set custom names for the color labels
You can set titles for the custom fields for the active project. This can also be used to extract special metadata from clips (see KB article: Using
Silverstack Custom Field Titles to Read Additional Metadata).
Also, you can choose to apply a custom configuration to all newly created projects (see KB article: Transfer of Project Settings)

 

Media

In the “Media” section you can set options for the creation of thumbnails and still frames as well as the use of dynamic metadata.

Media preferences
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You can choose the position in the clip from which the thumbnails are taken (see article Choosing Custom Thumbnail Images). In addition, you can
disable the thumbnail creation on Offload jobs to speed up the process and create them afterwards from the «Edit» menu. It’s also possible to export
still frames from clips either with the Original Color, as shown in player or the two images at once. The process is described in the article Still image
export.

 

Copy&Jobs

Here you can define all the settings related to the copy process and other jobs.

Copy & Jobs preferences

 

Playback

Here you can edit some settings for playback Besides setting the color in which black- and white-clipping regions of a video image are indicated, you
can also set the range color and clipping and range unit.

In addition, it’s possible to disable the automatic application of ALEXA and AMIRA Looks used while recording. This way the footage will be displayed
with the default Log-C to Rec.709 instead of the look.

In the “Playback” tab you can also select on which display the Playback Mode will be shown if you have more than one screen connected to your
computer.
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Playback preferences

 

Formats

Within this section you can change settings regarding different cameras you may use for importing video clips. You can set those attributes for
following cameras/recorders: AJA KiPro and Atomos, ARRI Alexa, Sony F5/F55/F65 XAVC, Canon C300, GoPro Hero and Nikon, R3D and Canon
DSLR.

The options that are available for defining the timecode are mostly the same for the different cameras. They are useful if you need a different timecode
source than the one you got from your camera. So instead of the camera’s timecode track you can use the Quicktime header create date or file create
date. Most times this option is only necessary for the Canon DSLR and GoPRO Hero, not so much for the ARRI Alexa and AJA KiPro.

 

AJA
KiPro
and
Atomos

You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.
Furthermore you can let Silverstack extract informations about scene and take from the filenames by selecting the according checkbox.
For the AJA KiPro Silverstack provides the opportunity to use the Alpha Append character of a clips name to assign the clip accordingly to a
camera.

figure 6: format options for AJA KiPro

 

ARRI
Alexa

You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.
Silverstack provides the option to generate the timecode with different modes.

figure 7: format options for ARRI Alexa
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Canon
c300

You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.

 

figure 8: format options for Canon C300

 

Canon
DSLR

You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.
The source timecode can be defined by the Thumbnail Image file, the Quicktime header create date and the file create date.
By selecting the according checkbox Silverstack will also copy any THM sidecar files from your Canon camera.

 

figure 9: format options for Canon DSLR

 

GoPro
Hero
and
Nikon

For any GoPro Hero and Nikon camera you can set only the option which defines the source timecode either to Quicktime header create
date or file create date.
You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color
Control in Silverstack.

figure 10: format options for GoPro Hero

 

R3D

You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.
The source timecode can be defined as absolute timecode, edge timecode, file create date or by user preference.
Reel name generation mode.
Use a Red Rocket card if available.
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figure 11: format preferences for R3D clips

 

RED Reel Name options

 

F5/F55/F65
XAVC


You can set the Look source which will be preselected for the ingested material. Learn more about this feature in the article Basic Color Control
in Silverstack.

figure 12: format preferences for Sony F5/F55/F65 XAVC clips

Generic
File
Sequence

Silverstack allows to import JPEG, TIFF and DPX image sequences as clips. You can Set the default playback speed in the Import Options
menu:

figure 12.1: Generic File Sequence preferences

 

Ingest

Silverstack scans the volumes from which you want to offload. In this tab you can select what kind of files or patterns should be ignored in the ingest
process. You can add or delete different file types and patterns.
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Ingest preferences

 

Backups

Here you can create and restore database backups of your current and past Silverstack states.

Library Backup preferences

 

External
Video

Here you can choose the settings for the external video output.
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External Video preferences

Silverstack comes with the option to output an HD-SDI signal via compliant hardware. Learn more about it in the article HD-SDI output in Silverstack.

You can use ScopeBox by Divergent Media for software-based waveform and video scopes for Silverstack’s player.

 

Grading

These are the settings for the grading functionalities in Silverstack.

Grading preferences

Silverstack comes with grading functionalities and an integrated look library. Learn more about it from the articles Grading Controls in Silverstack and
 The Silverstack Look Library.

ACES

These are the settings for the ACES grading mode functionalities in Silverstack:
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ACES grading mode preferences

Slating

Slating
System:
Choose a “Slating System” to show only relevant menu items within the “Edit Scene/Shot/Take” menu for your preferred slating
system:

“Standard” lets you work with continuous slating with scene / shot / take fields (e.g., Scene “56” / Shot “4” / Take “2”)
“American” lets you work with American slating with scene / take fields (e.g., Scene “56C” / Take “2”)
“All” lets you see all available menu items for full flexibility

Scene
Letter:
The “Scene Letter” checkbox allows you to enable/disable the behavior to append a letter on “Increase Scene” actions
automatically (e.g., increment “5” to “5A”). “Scene Letter “is enabled automatically when switching to the “American” slating system and disabled
when switching to the “Standard” slating system.

Note: Incrementing letters in the scene/shot/take fields use the overflow system (e.g., “Z” to “AA”, etc.)

Skipped
Characters: You can also define specific characters to be skipped when incrementing letters in the scene/shot/take fields.

Slating preferences

Accounts

You can manage the accounts to upload or share your library via ShotHub, for direct dailies upload via Webgate.io or Frame.io and for sending job
notifications to Slack here.
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Accounts preferences

Updates

These are the settings for automatic updates, usage statistics and crash reports.

Update preferences

Operating
Systems
and
Requirements
Our software Silverstack requires an Apple Mac machine with macOS 11 or higher operating system. Since we are using the latest of macOS
technologies, we are not planning to support earlier versions of macOS, neither will we port Silverstack to another operating system in the near future.

So to run Silverstack you need an Intel Mac with macOS
11 or higher (such as any current Mac available in the MacStore).

 

 

You can find a list of supported formats in the article Assets in Silverstack. All formats with no specific detection will be handled as generic files.
Please see the article Generic File Formats for more information.

For a realtime playback of your offloaded video files the usage of a fast hard drive as a SSD card is recommended.

If you have further question about supported hardware please let us know. If you would like to know more about data performance click here. You
might be interested in this article for improving your performance.
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Deprecated
Operating
Systems

Silverstack still works on the following macOS operating systems but a deprecation warning shows that support for those operating systems will likely
to be removed soon:

currently
no
deprecated
macOS
for
latest
Silverstack
version

Reset
Silverstack’s
Library
and
Preferences
In the unusual event of Silverstack not being able to launch, you might have to consider resetting the preferences and/or deleting Silverstack’s library.

Warning:
This
can’t
be
undone,
deleting
the
library
will
delete
all
custom
metadata,
clip
references
and
thumbnails.
The
actual
clips
won’t
be
deleted.

Deleting
Silverstack’s
preferences

Quit Silverstack
Create a copy/backup of the following file matching
your
Silverstack
version (optional):
Silverstack
8:
~/Library/Preferences/com.pomfort.Silverstack8.plist
Silverstack
Lab
8:
~/Library/Preferences/com.pomfort.SilverstackLab8.plist
Silverstack
7:
~/Library/Preferences/com.pomfort.Silverstack7.plist
Silverstack
Lab
7:
~/Library/Preferences/com.pomfort.SilverstackLab7.plist
Open up the Terminal application (type terminal in your spotlight or navigate within the Utilities folder of your application folder)
Type the following command in your terminal window matching
your
Silverstack
version:
Silverstack
8:
defaults	delete	com.pomfort.Silverstack8
Silverstack
Lab
8:
defaults	delete	com.pomfort.SilverstackLab8
Silverstack
7:
defaults	delete	com.pomfort.Silverstack7
Silverstack
Lab
7:
defaults	delete	com.pomfort.SilverstackLab7
Start Silverstack

Deleting
Silverstack’s
library

Quit Silverstack
Rename the folder matching
your
Silverstack
version
in your home directory:
Silverstack
8:
~/Library/Application	Support/Pomfort/Silverstack8
Silverstack
Lab
8:
~/Library/Application	Support/Pomfort/SilverstackLab8
Silverstack
7:
~/Library/Application	Support/Pomfort/Silverstack7
Silverstack
Lab
7:
~/Library/Application	Support/Pomfort/SilverstackLab7

The
Library
folder
is
hidden
by
default.
You
can
open
the
Library
folder
in
Finder
when
opening
the
“Go”
menu
and
holding
the
“alt”
key.
You
will
see
an
extra
entry
“Library”
in
the
“Go”
menu.
Choose
this
entry
and
a
Finder
window
will
open
with
the
Library
folder.

Start Silverstack again, it will automatically create a new library.

Now Silverstack should start as usual with a fresh library. If you still experience issues, please contact our support team.

How
do
I
migrate
a
license
from
one
computer
to
another?
You can move a license of a Pomfort product from one computer to another. This may be useful if you move from an older Mac to a new model.
Basically, there are two different modes available:

Standard
License
Activation
Mode
(default)

The standard license activation mode is the default mode for all types of licenses, including our temporary licenses.

There are two activities involved:

Unregistering the license from the old computer and
registering the license on the new computer.

Please
note,
that
you
need
an
internet
connection
for
the
following
steps.

1.
Unregistering
the
license
from
the
old
computer

You now have to perform the following steps:

Open the License Panel by choosing “Licenses…” from the application menu.
Click on ”Deactivate License”.

The Pomfort application will stop working on this machine and the license is free to use on another machine.

By logging into your Pomfort Account you can make sure that the deactivation of your license was successful. The license should now be shown as
“Inactive”.

2.
Registering
the
license
on
the
new
computer

Let’s assume you already have the application installed on your new computer.

You now have to perform the following steps:

Open the program, the License Panel will appear. If not, choose “Licenses…” from the application menu.
Click on “Add License…” and insert the license key you received after purchase.

In your Pomfort Account your license will now be shown as “Activated” with the name of the computer that your license is activated on.
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Daily
License
Activation
Mode

The optional “daily license activation mode” allows to use your license on different machines on different days. Hence, subscription-based licenses can
be added to multiple computers at once via the license manager in the software. However, as in standard mode, it can only be activated on one
machine at a time.

In this case, a license is then always active for 24 hours on a specific computer. After one day, it can be easily migrated back to another computer (on
which it was already added before). To do this, however, the corresponding computers must be briefly connected to the Internet once a day. If no
switch is attempted, the license is automatically renewed for another day on the current computer. 

As soon as you start the desktop application on the computer on which a license is to be activated, a notification appears automatically, which allows
you to activate it directly with one click. If this is successful, the license can be used on that computer for the next day. 

If an activation cannot be carried out successfully, an error message appears, which at the same time provides information about the currently active
computer. A new change can only be attempted the following day. 

If a change has to be made before the 24 hours have passed, the standard activation/deactivation procedure described above can also be used at any
time in daily mode.

Migrate
a
Silverstack
project
from
one
computer
to
another
Sometimes it’s necessary to migrate an entire project from one computer to another – maybe even during a project. It’s not that difficult – this article
shows how this can be accomplished.

There are two activities involved:
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Migrating the license
Migrating the Library

 

Migrating
the
License

Migrating the license is straight forward, it can be done in Silverstack . You need an internet connection and follow the steps described in the Tips &
Tricks document “Migrate a Silverstack license“.

 

Migrating
the
Library

Migrating the project with all it’s information is basically moving the Library’s database, the thumbnails and the application’s preferences to the new
computer.

If you want to migrate your Silverstack 7 projects to Silverstack 8 please learn how to do that from the article “How to Manually Migrate Silverstack 7
Projects to Silverstack or Silverstack Lab 8”

In
order
to
transfer
files
from
one
computer
to
another
please
have
an
external
hard
drive
or
a
large
USB
stick
at
hand
or
establish
a
network
connection
with
file
sharing
between
the
two
computers.

Silverstack
8

If
you
are
using
Silverstack
8, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack8 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack8.plist to the same destination on the new computer.

Silverstack
7

If
you
are
using
Silverstack
7, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack7 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack7.plist to the same destination on the new computer.

 

If
you
are
using
Silverstack
Lab
7, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder SilverstackLab7 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.SilverstackLab7.plist to the same destination on the new computer.

NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

You can also use the Library Metadata Exchange feature present in Silverstack XT.

Silverstack
6

If
you
are
using
Silverstack
6, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack6 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack6.plist to the same destination on the new computer.

 

If
you
are
using
Silverstack
Lab
6, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder SilverstackLab6 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.SilverstackLab6.plist to the same destination on the new computer.
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NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

You can also use the Library Metadata Exchange feature present in Silverstack XT.

Silverstack
5

If
you
are
using
Silverstack
5, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack5 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack5.plist to the same destination on the new computer.

NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

You can also use the Library Metadata Exchange feature present in Silverstack XT.

Silverstack
4

If
you
are
using
Silverstack
4, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack4 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack4.plist to the same destination on the new computer.

NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

You can also use the Library Metadata Exchange feature present in Silverstack XT.

Silverstack
3

If
you
are
using
Silverstack
3, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder Silverstack3 and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.Silverstack3.plist to the same destination on the new computer.

NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

Silverstack
2

If
you
are
using
Silverstack
2.2, you have to perform the following steps to migrate all thumbnails and the Library database:

In Finder on your old computer navigate to ~/Library/Application	Support/Pomfort in your home directory.
Copy the folder SilverstackMaster and all of its contents to the same destination on the new computer.

You have to perform the following steps to migrate the application’s preferences files:

In Finder on your old computer navigate to ~/Library/Preferences in your home directory.
Copy the file com.pomfort.SilverstackMaster.plist to the same destination on the new computer.

NOTE: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to open the
folder.

How
to
Manually
Migrate
Silverstack
6
Projects
to
Silverstack
7
or
Silverstack
7
Projects
to
Silverstack
8
If you are a user of Silverstack 6 you might want to migrate your projects to Silverstack 7 or Silverstack Lab 7. There is an easy process to perform this
migration.

The
instructions
in
this
article
can
also
be
used
for
manually
migrating
Silverstack
7
to
Silverstack
8
projects.
Just
replace
the
library
path
numbers
with
the
according
version
numbers.

Locating
the
Library
Folders

Silverstack 7, Silverstack Lab 7 and Silverstack 6, have different library folders that contain the projects. You will find them at the following paths on
your Mac:


~/Library/Application
Support/Pomfort/Silverstack7
~/Library/Application
Support/Pomfort/SilverstackLab7
~/Library/Application
Support/Pomfort/Silverstack6
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You can also navigate to the folders from the Main Menu of Silverstack 6 or 7 or Lab 7. Select “Silverstack>Show
Library
in
Finder” in the main
menu bar at the top of the screen. This will open the project folder an bring you to the Silverstack.psdb file of your currently opened project. From there
you can go two directories backwards to find yourself at the directory of the Silverstack library folders.

Migrating
the
Library

1. Close Silverstack 7 / Silverstack Lab 7
2. Rename the “Silverstack7” or “SilverstackLab7” folder in the directory 
/Users/[yourUser]/Library/Application
Support/Pomfort/ to
“Silverstack7_old”/“SilverstackLab7_old”
(you will need that folder to keep new projects)

3. Open Silverstack 7 / Silverstack Lab 7
4. Just like when you started Silverstack 7 / Silverstack Lab 7 from scratch the first time you will be asked if you want to migrate your libraries from

version 6 or want to start clean:

 

6. Choose “Copy
Existing
Projects” to migrate your Silverstack 6 libraries.

7. The library migration assistant will keep you updated on the process and tell you when the migration has finished:

Figure 2: The library migration assistant

 

8. You can now use Silverstack 7 / Silverstack Lab 7 with your projects from Silverstack 6.

 

Please note that for large libraries the process can take several minutes. During that time Silverstack will become unresponsive. Leave the system
running and the migration process will come to a solid finish.

 

Keeping
Projects
from
Before
the
Migration

If you want to keep projects you created in Silverstack 6 before the migration process you can do that by copying the project folders:

1. Close Silverstack.
2. Go to the previously renamed “Silverstack7_old”/“SilverstackLab7_old” folder.
3. Select the projects you want to take over to your migrated Silverstack 7 / Silverstack Lab 7 library (projects folder usually are named like “Project-

1F342874AF90”)
4. Copy them to the Silverstack7 / SilverstackLab7 folder that was automatically created during the migration.
5. Start Silverstack 7 / Silverstack Lab 7

You will then have all your migrated and the previously created projects in Silverstack 6 together at one place.

If you want you can then delete the“Silverstack7_old”/“SilverstackLab7_old” folder because now your current Silverstack 7 / Silverstack Lab 7
library contains all your projects from Silverstack 6 and 7 respectively Silverstack Lab 7.

How
to
Manually
Migrate
Silverstack
Projects
to
Silverstack
Lab
If you are a user of Silverstack you might want to migrate your projects to Silverstack Lab. There is an easy process to perform this migration.
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Locating
the
Library
Folders

Silverstack and Silverstack Lab have different library folders that contain the projects. You will find them at the following paths on your Mac:













~/Library/Application
Support/Pomfort/Silverstack7













~/Library/Application
Support/Pomfort/SilverstackLab7

You can also navigate to the folders from the Main Menu of Silverstack or Lab. Select “Silverstack>Show
Library
in
Finder” in the main menu bar at
the top of the screen. This will open the project folder an bring you to the Silverstack.psdb file of your currently opened project. From there you can go
two directories backwards to find yourself at the directory of the Silverstack library folders.

Migrating
the
Library

1. Close Silverstack
2. Rename the library folder (e.g. SilverstackLab7) in the directory 
~/Library/Application
Support/Pomfort/ to “SilverstackLab7_old”
(you will need

that folder to keep new projects)
3. Open Silverstack Lab
4. Just like when you started Silverstack Lab from scratch the first time you will be asked if you want to migrate your libraries from another version

or want to start clean:

Fig. 1: The migration panel

 

5. Choose “Copy
Existing
Projects” to migrate your Silverstack libraries.

6. The library migration assistant will keep you updated on the process and tell you when the migration has finished:

Figure 2: The library migration assistant

 

7. You can now use Silverstack Lab with your projects from Silverstack .

 

Please note that for large libraries the process can take several minutes. During that time Silverstack will become unresponsive. Leave the system
running and the migration process will come to a solid finish.

 

Keeping
Projects
from
Before
the
Migration

If you want to keep projects you created in Silverstack  before the migration process you can do that by copying the project folders:

1. Close Silverstack.
2. Go to the previously renamed “SilverstackLab7_old” folder.
3. Select the projects you want to take over to your migrated Silverstack Lab library (projects folder usually are named like “Project-

1F342864AF90”)
4. Copy them to the Silverstack Lab folder that was automatically created during the migration.
5. Start Silverstack Lab

You will then have all your migrated and the previously created projects in Silverstack Lab together at one place.
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If you want you can then delete the “SilverstackLab7_old” folder because now your current Silverstack Lab  library contains all your projects from
Silverstack and Silverstack Lab.

Incompatible
Silverstack
or
Silverstack
Lab
Library
Version
The Silverstack and Silverstack Lab library versions advance over time across software releases. This is a natural process when a software application
advances but inevitably leads to incompatible library version when opening projects with outdated versions of Silverstack/Silverstack Lab.

We always recommend to use the latest version of Silverstack/Silverstack Lab which can be downloaded on the Pomfort Downloads page. Like this
you avoid the situation this article takes care of.

Migration
and
Library
Version
States

The term “Library Version” basically refers to the state of the Silverstack database and which information it can currently store.

When updating Silverstack to a newer version the existing library is migrated to the latest version. That process establishes compatibility of the existing
library with the new library version.
You can learn more about the migration of libraries in the article “How to manually migrate Silverstack 5 projects to Silverstack 6 or Silverstack Lab 6”

After the migration your library is in a later/newer state and therefore not compatible anymore with older versions of Silverstack. If you are forced by
any circumstance to move back to an outdated library version of Silverstack, you can restore a backup that has automatically been created during the
migration process.

Restoring
a
Library
Backup

Fig. 1: The “Incompatibly Silverstack Lab Library Version” Alert, applies also to Silverstack

When you open a project that has been created with a later version of Silverstack in an older version the alert from Fig. 1 shows.

At this point you have three options that you can choose from with the buttons:

Restore
Backup:
Silverstack automatically offers the possibility to restore the last state for which a backup was created that is compatible with
the opened version of Silverstack. Backups are automatically created during migration. Automatic backups can be enabled in the Silverstack
preferences’ “Backups” tab as well as manually triggered.
Open
with
New
Project: To be able to access Silverstack even though the particular project can’t be opened, you can create a new project to
start with. You can again change to other projects from within the application then.
Quit:
You can quit the application to open the project again with a later version of Silverstack that is compatible with the library version.

In the very rare case that no backup is available you see the following alert that indicates that there is no compatible backup and therefore gives less
options:

Fig.2: The alert in case there is no available backup that can be restored

 

Why
does
Silverstack
tell
me
my
license
is
already
activated?
Each Silverstack license key can be activated on one computer at a time. If an error message appears when you try to activate your license on a new
computer please check if the license has been properly deactivated from the original computer.

You can do this check by logging into your Pomfort Account. The license status needs to be shown as “Inactive” for you to activate the license on
another computer. If this is not the case, please deactivate your license from the computer that it’s shown as “in use on”.
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Find more information about the Pomfort Account here.

How
do
I
install
a
license
for
all
users
of
a
Mac?
You can register Offload Manager, Silverstack and Livegrade once on one machine and afterwards make the license available to all users.

After the activation just move the files in

~/Library/Application	Support/Pomfort/Licenses

to /Library/Application	Support/Pomfort/Licenses

(You will have to create the folders Pomfort/Licenses).

Please
Note: Since OS X Lion the Library folder in your home directory is hidden. In Finder use Command-Shift-G (⌘⇧G) and enter ~/Library to
open the folder.

When restarting the application it will load the licenses from the system disk and every user should be able to use it. With that solution multiple users of
this machine can use the Pomfort product license.

Sample
Project
and
Sample
Footage
Silverstack, Silverstack XT, and Silverstack Lab enable you to easily download a sample project and sample footage via the main menu. The sample
project and according sample footage are a simple way of receiving a fully working sample project easily and quickly to evaluate Silverstack.

From the “Help” menu of the Silverstack main menu you can select:

Download Sample Project: This will directly download a sample project that can give you an impression of how a project library could look in
Silverstack.
Download Sample Footage: This will download sample footage in a .dmg that can be mounted and then directly used for first experiences with
clips in Silverstack.
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